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Concordance

Concordance® is an electronic discovery, document management, and litigation

support tool. Concordance makes it easy to identify, organize, and analyze case-

critical information to aid in collaboration across your firm or around the world.

Concordance gives you the most effective, cost-efficient way to manage large

volumes of documents - scanned paper, email, and other e-documents - generated

during litigation.

Here are some of the key benefits and features that Concordance offers:

· Holds documents of all types 

· Contains a fast and efficient search engine 

· Categorizes records with folders, tags, and issues 

· Secures confidential data at various administrative levels 

· Integrates with other litigation technology 

· Offers remote access while traveling or in the court room

Concordance Administration

Supporting Reviewers

As an administrator, your job is to support the document review team by providing

the best database structure and maintaining that structure for easy review.  The

more you can learn and understand the reviewer’s perspective, the easier your job

becomes in providing proper support.

Searching
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Administrators should understand basic search concepts used in Concordance,

including how to differentiate between full-text and relational clauses, and how to

use search operators and wildcards. Understanding these concepts helps you

troubleshoot questions or problems reviewers may have when learning to use

Concordance.

Searching Overview:

· Full-text searching uses the .dct and .ivt files

· Full-text searching is very fast, highlights hits in red, searches multiple fields

· Relational searching searches the entire database each time

· Relational searching uses different operators, searches one field, runs slower,

and does not provide keyword highlights

Tips to Increase Search Processing Speed:

· Reviewers can speed up relational searching by placing a full-text search

clause before the relational clause to cull down the amount of data

Concordance must relationally search

· Check the Key box on fields to improve relational search processing speed 

· Locate empty or not empty paragraph fields (empty: fieldname = “”, not

empty: fieldname = *)

· Search for punctuation with relational searching (OCR co %) or globally

replace punctuation with a%a, then reindex and run a full-text search

Tips for Assisting Reviewers:

· Verify that users are not running relational searches on paragraph fields

· Verify that reviewers are placing a full-text search clause before the relational

clause to cut down search processing time

· Verify that search syntax is correct

· Verify the search terms are included in the dictionary
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· Verify that the field is indexed for full-text searching

· Reindex the database to ensure all updates are available to reviewers

Saving Queries

Reviewers can save their search history by saving a query file from a current

Concordance session. By doing so, they can later restore those same searches to

create new complex searches and/or capture query results on database updates.

Saved query files can also be executed on different databases if the field names

used in the searches match. Please note that restored query files will update

internal search number references in the Review view.

As an administrator you may need to help reviewers save or modify query files,

and clear their search history from the database. Searches are saved in a .qry file

and are editable text files containing only the search string.

Search Query Options:

· Use the Save all Queries command on the Search menu to save all searches in

the current query session to a .qry query file.

· Use the Execute Saved Queries command on the Search menu to relaunch a

previous query saved to a .qry file, and capture any new and/or edited data

since the initial search was run.

· Use the Clear Search History command on the Search menu to delete the

search history when you index, reindex, or pack the database.

Modifying Query Files

Query files are text files that contain only the search string. These files can be

opened and edited in any text editor program. Reviewers may want to modify a

saved query file to write new complex search queries and then run the edited query

file on a database. However, as an administrator, you will typically review these files

in order to delete unnecessary queries that you do not need to store or rerun later.
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Saving Search Results

In the Review View, you can print your search results or save them to an ASCII text

file by selecting a search, right-clicking, and choosing Save.  The resulting text file

contains the data that is displayed in the Review View.  This can be a helpful report

in case a reviewer needs to prove what search criteria was used during e-discovery.

Clearing Searches

Clearing reviewers’ search history allows you to erase all searches from a current

Concordance session without reopening a database, and it allows users to start the

new search session without looking at the results of previous searches.

To clear search history, on the Search menu select Clear Search History. The

search results in the Review View will be cleared except for the All query used to

locate all records in the database.  It is recommended to save the searches to a .qry

file before clearing them since there is no Undo function after clearing your search

history.

Sorting Records

The results of any search are sorted in the order in which documents are added to

the database, and typical sorting only affects current search results.  Administrators,

however, have the means to permanently apply a sort order to a database.

Reviewers may want to have documents permanently sorted in a database

chronologically, or by author, type, or other field, to help speed up their review. We

recommend that you only accommodate this request under special circumstances

due to the time involved in managing these extra files and databases.

Sorting Overview:

· The default sort order of all queries is the record creation or load order of the

documents when they were added to the database (accession number)

· Sorting can be done on up to 16 fields at one time with a maximum character

limit of 1,000
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· Sorting of paragraph fields is done on the first 60 characters only and uses the

longest value in the field up to 60

· Sort order is temporary and only applies to the current query 

· Speed up sorting by selecting the Key check box for database fields in the

Modify dialog box.

To Permanently Sort a Database:

1. Back up the original database. 

2. In Concordance, open the database you want to permanently sort.

3. Sort the database.

4. Either:

· Export the database by going to Documents>Export>As a Concordance

database and using the Export Wizard.

· Replicate the database by going to Tools>Replication>Create a replica.

5. Use the exported or replicated database.

Exporting a database does not export the database's security

settings. Replicating a database preserves the database's security

settings.

Indexing Databases

A Concordance database must be indexed prior to searching. When you index your

database for the first time, you are actually creating and populating the

Concordance dictionary and index files. How your database records are indexed

ultimately affects how reviewers search for information:

· Full-text searching works only on indexed fields

· Relational searching is for non-indexed fields or keyed fields
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· Paragraph fields are indexed by default

You can index just about anything in your database depending on how you create

the database structure. When you are building your database, you want to plan

which fields to include in the dictionary and index. The smaller the dictionary and

index, the faster your searching and indexing speeds will be.

Indexing and reindexing databases is important for keeping your database updated

with current review information, free of unnecessary and obsolete files, and

efficient for processing full-text searches. Indexing large datasets is time

consuming, but is a standard process and part of database maintenance.

When Concordance databases are built, the index and dictionary are generated

from the document contents. The dictionary contains a list of every word or string

of characters in the database's record collection. The index contains directions to

every word or string of characters in the database.

Please consider the following before you index a database and create the

dictionary:

· Avoid indexing serial and Bates numbers (these are unique value fields)

· Punctuation needs to be set only once and only pertains to indexed fields

· Punctuation is indexed only if embedded between alphanumeric characters. All

leading and trailing punctuation is trimmed.

· Update the database's stopwords list to exclude additional words that you

want ignored during indexing and searching

· A well-defined stopwords list keeps your dictionary and index lean

If indexing or reindexing speeds seem slow, you may want to

increase your computer's RAM and check your cache settings on

the Indexing tab in Preferences.

Index Files
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Indexing scans the database and notes where each word occurs. These occurrences

are stored in two files created during the indexing process, the dictionary file (.dct)

and the inverted text file (.ivt).  When you perform a search, Concordance looks in

these two files for your words, not in the actual text of the database.  Due to the

structure of these files, the search is performed very rapidly, much faster than

searching each document one-by-one for every word.

The dictionary file is stored in the database directory folder and contains all

dictionary words and their hit and document counts.  The inverted text file file

contains a path to all words, along with the applicable number for each record,

field, line, and word for each word in the .dct file.  Both the dictionary file and

inverted text file contain a B-tree data structure, and the size of each file is

important. When full-text searches are performed, the search only uses these two

files.

Building the initial index for these records can take many hours. 

Reindexing a day’s worth of new documents could take a few

hours, so it is better to reindex after entering a few records in order

to have new content searchable in a timely manner.

Indexing Process

Concordance follows several rules when indexing the database. Words must begin

with an alphabetic or numeric character. Once the beginning of a word is found,

Concordance scans until it finds the first non-alphanumeric character. This

character is compared against the list of embedded punctuation characters.  If the

character is found in the punctuation list and the following character is

alphanumeric, then that punctuation is included in the word. Otherwise, the first

non-alphanumeric character will mark the end of the word.

Embedded Punctuation

User definable embedded punctuation is provided so that hyphenated words,

dates, decimal numbers, and contractions are not split into two or more words. By

default Concordance uses ‘ . , / characters for embedded punctuation. Note that the

hyphen is not included in the default set. You may want to include them, but it is
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recommended that you leave them out. Proper names, such as Mary Smith-Jones,

would only be searchable under the Smith prefix if hyphens were used as

embedded punctuation. Use the Punctuation field in the Modify dialog to change

the default characters.

Case Sensitivity

Concordance is not case sensitive. All words are converted to upper case letters

when placed into the dictionary. All searches are likewise converted to upper case

before being processed. This upper case conversion does not affect the original text

that exists in your documents.

Word Length

A word can be any length of characters, but only the first 64 are considered

significant. Longer words are truncated to 64 characters when they are stored in

the dictionary. When you search for a word longer than 64 characters, your search

word is truncated before being looked up in the dictionary. The source text is not

affected.

Stopwords

Words that occur frequently, such as the, and, and or, have little search value. Such

words are commonly referred to as noise words. Concordance stores these types

words in a stopword list. Words that occur in the stopword list are not stored in the

dictionary. Excluding them from the dictionary saves time in the indexing process

and significant disk space on your computer without impairing the database's

ability to retrieve data. The list of stopwords is user defined and can be printed or

changed. If you have not specified any stopwords for your database, Concordance

uses the default list in the concordance_<version>.stp stopwords file.

The stopword dictionary is used during the indexing process. Adding or deleting

words from the stopword dictionary does not affect the existing database

dictionary. Editing the stopword dictionary requires a complete index of the

database for the changes to take effect.
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Indexing and Reindexing

Actively used databases need frequent updating to keep the index and dictionary

entries current. In Concordance, we refer to creating the database index as a full

index, and refer to an index update as a reindex, which simply updates the database

dictionary and its corresponding index. 

Indexing versus Reindexing:

· Indexing is performed when the initial database is built, and needs to be

performed after every database modification, including changes in fields,

punctuation or the stopwords list.  Indexing is an exclusive process.

· Reindexing is performed when new records are added to the database or

when there are new annotations and modifications to record content. 

Reindexing appends new information to both the index and dictionary files.

Reviewers are typically not given indexing or reindexing privileges because of the

sensitivity involved in running these processes. Concordance administrators must

ensure that all data is reviewed and proper back-ups are made before indexing or

reindexing the database.

  

Indexing Databases
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There will be times when you need to perform full index updates to include

modifications to the dictionary, stopwords list, and punctuation settings. This is an

exclusive process and only the administrator can access the database at this time. 

When performing a full index, please consider the following:

· Perform a full index when all reviewers are logged out of Concordance,

processing can take hours and impacts access to the system and work activity

· When possible, plan to perform full indexes when it doesn’t impact regular

work hours

· Alert all reviewers of when indexing will occur and the timeframe for when the

system may be available again

· Verify that all reviewers are logged out of the system before you run this

process

· Consider performing full indexes for individual databases on separate

machines

To index a database, select Index on the File menu.

Reindexing Databases

You can determine whether a database needs reindexing on the File menu and the

Databases task pane. A database needs reindexing whenever the database

dictionary is not current with the additions or changes that have been made to the

database since the database was last indexed or reindexed. On the File menu,

Concordance adds a check mark next to the Reindex command.  In the Databases

Panel of the Navigation panel, Needs Reindexing is displayed for the Current

Database.

When performing a reindex, please consider the following:

· Run a query on edited records or those marked for deletion. To do this, on the

Search menu, click Search for edited documents.

· Select the Allow exclusive indexing check box on the Indexing tab in the

Preferences dialog box to prevent reviewers from searching during a reindex.
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To reindex a database, select Reindex on the File menu.

Database Indexing Time

Knowing the indexing time for databases can help you plan your indexing

schedules.  Concordance logs the time it takes to index in the

Concordance_<version>.log file located in C:

\ProgramData\CloudNine\Concordance 10.

This example log file shows indexing in seconds, but realistically, your database is

probably going to index in hours, not seconds.

Stopwords

Stopwords are common words in the English language (and, the, but, etc.). 

Stopwords are not words that are usually search for by reviewers.  Eliminating

stopwords from the index ensures that searches run much faster and efficiently.

Stopwords are stored in the Concordance_<version>.stp file.  Concordance

automatically creates a list of 141 stopwords in the stopwords file.

You may receive requests from reviewers to add a specific word that is common to

the case review documentation and needs to be avoided during searches.

Administrators can modify the Stopwords list for your review team when

necessary.

The Stopword list is only used during the indexing process. Adding or deleting

words from the Stopword list does not affect the existing database dictionary until

the database is indexed.



Concordance 19

© 2022 CloudNine™. All rights reserved.

Editing the Stopword list requires a full index of the database for

the changes to take effect.

Updating the Stopwords List

1. On the File menu, select Dictionaries, and then click Stopword list.  The

Stopwords dialog displays.

2. To add a word to the Stopword list, type the word you want to add in the field

below the stopword list, and click Add.  Wildcards can be used with stopwords

to eliminate large groups of words. For example, adding 9* to the stopwords

list eliminates every word or number beginning with the character 9 from the

database dictionary.

3. To search for a stopword, type all or part of the word in the field below the

Stopword list.  As you type, the list scrolls to the word closest to the word you

are typing. 

4. To delete a word from the stopword list, select the word in the list, and click

Delete.

5. To print the Stopword list, click Print.

6. Click OK to save your changes.

7. Index the database to make sure your stopword edits are effective.
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For searching purposes, it is recommended that only Latin based

characters are used in the Stopword list.

Punctuation

For full-text searching, punctuation is not indexed. Concordance treats punctuation

as spaces. All punctuation is ignored, such as periods or quotations, as well as

currency and percentage symbols.

There are two exceptions to this rule, and both exceptions must be true:

· Punctuation is defined in the database properties (accessed via

File>Properties)

· Punctuation is embedded in a string of characters

 By default, Concordance includes the apostrophe, period, comma, and forward

slash. You may want to add symbols like the ampersand and the at sign for e-mail

databases.
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Embedded Punctuation Examples

· Apple.com – Allows you to search on these terms because the entries relate to

websites.

· D’Arcangelo – The apostrophe is embedded because of the surname spelling.

People mentioned in case records may have possessive apostrophes

embedded in their names and may be added to the list because the name is

searched often.

· john.smith@organization.com – The period and at sign are both examples of

embedded punctuation within an e-mail address.

Adjusting Punctuation Settings

1. On the File menu, click Modify.  The Modify dialog displays.



Concordance Classic22

© 2022 CloudNine™. All rights reserved.

2. In the Punctuation field, add or delete the applicable punctuation.

3. Click OK to save your changes.

4. Run a full index to update the database dictionary with the punctuation

changes.

Dictionary

In Concordance, a word is any string of characters. A word can be a series of

numbers or a combination of letters, numbers and even punctuation or symbols.

Familiarize yourself with your database dictionary by reviewing or printing the

entries.

The maximum length of a dictionary word is 64 characters. When a

word exceeds 64 characters, only the first 64 characters of the

word are included in the dictionary. Since the full word is not listed

in the dictionary, the word may not be found in the database. 
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You can review dictionary entries from two different dialogs:

· From File>Properties - this dialog displays the number of words included in

your dictionary and the punctuation that is indexed.

· From File>Dictionaries>Database Dictionary (or alternately by selecting

Display the database dictionary in the Search Panel of the Navigation

pane) - this dialog provides a complete listing of all the words included in the

dictionary, the number of documents each word appears in, and how many

word hits there are for each word in the dictionary.
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You can print your dictionary words to a printer or file from the Dictionary dialog

by selecting Print.

Importing Files

Once you have created a database, you can start importing load files to populate

the database with records. Your initial database files can be PST files, electronic

documents, or delimited text files prepared by a vendor (or other party) so that you

can import them directly into Concordance. Concordance provides the Import

Wizard to help you import your documents.

Most files are imported into Concordance using Import on the Documents menu. 



Concordance 25

© 2022 CloudNine™. All rights reserved.

After importing your files, it is best practice to check for

inconsistencies between the database imagekeys and entries in the

Concordance Image .dir file and for duplicates and gaps in the

database.

When importing new or additional data, consider the following:

· Run a test load by importing new data into an exported database structure.

· Note the last record number on the status bar prior to importing the new data.

· Reindex the database prior to loading the new data. After the data is loaded,

on the Search menu, click Search for Edited Documents, to query only the

records that you just loaded for verification of the number of records that

needed to be loaded or to isolate the records that need to be deleted if loaded

improperly.

· Decide whether to load data into a secondary database structure and then

concatenate it with the primary database.
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Concordance integrates with many e-discovery products so you can import and

export data to and from other prominent industry software applications.

· CloudNine™ LAW extracts text content and metadata from electronic files in

native file format, and scans and exports data directly into databases.

· EnCase® by Guidance Software is an enterprise forensic data collection

application used to gather data from LANs and individual, custodian hard

drives, and can export collected data directly into databases.

· IPRO Image by IPRO Tech, Inc. can create Concordance Image load files.

Concordance Database

The Import Wizard for Concordance databases guides you through the process of

importing records from one Concordance database to another database. You can

import and append the records, or import and update existing records. You can

select which fields are imported, and indicate whether attachments should be

copied.

Import a Concordance Database

1. In Concordance, open the database you want to add another database to.

2. On the Documents menu, select Import, and click Concordance database.

The Import Wizard - Database dialog displays.
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3. Click the Browse button to open the Select database to merge dialog.

4. Navigate to and open the .dcb or .fyi file for the database you want to add to

the current database.  During the import, every record in the selected database

is imported into the current database.  If you only want to import some of the

database records into the database, then you need to open the database you

are importing, run a search to locate the records you want to add to the

current database, and export the records to the current database. 

When importing records into a concatenated database, records are

updated when the fields of an imported record match an existing

record. When the fields do not match, the imported record is

appended to the main database, which is the first database in the

concatenated set.

5. Click Next. The Import Wizard - Fields dialog displays.
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6. Select the fields you want to include in the import.  Data from the fields you

select are only imported if the selected fields exist in both databases.

7. Click Next.  The Append/Replace dialog displays.

8. To have the import append all records, select the Append all records option. 

When you select this option, the import adds all imported records as new

records after the last record in the current database.
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9. To have the import replace all matching records and append all new records,

select the Replace matching records and append new records option. 

· The Delete and replace existing annotations and tags check box

determines how annotations are copied when an existing record is

updated.  If selected, any annotations from the matching imported record

are added to the record.  By default, the check box is not selected.

· In the Locate matching records by comparing list, select the field to

compare to determine whether records match.  Only key fields are listed in

this list.  You can select multiple fields.  Full-text paragraph fields are

considered a match if the first sixty characters, or the first line, whichever is

less, match, regardless of the remaining contents of the field.

10. Select Copy attachments with notes if you want a record's attachments with

notes copied during the import.

11. Click Next.  The Import Wizard - Import dialog displays.

12. Click the Import button to start the import. 

13. When the import finishes, the following message displays. 
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14. Click Yes to run a Zero Query in the newly combined database so that you can

view all the database records.  

Delimited Text

Load files or delimited text files typically have extensions ending in .dat, .csv, or .txt.

 Each file contains record metadata, but some may also include body text.  We

recommend having your OCR separated into individual text files and imported

separately using a CPL script.

As an administrator, you should always make a practice of opening and reviewing

your delimited text files when you receive them, as the files are not always

prepared perfectly and may need to be modified.  See Reviewing Load Files for

more information.

When importing records into a concatenated database, records are

updated when the fields of an imported record match an existing

record. When importing a delimited text file using the Load option,

records with mismatched fields are appended as new documents

to the main database, which is the first database in the

concatenated set. However, when using the Overlay option,

importing records with mismatched fields can cause a loss of data.

Updating the Current Database with Delimited

Text
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1. On the Documents menu, select Import, and then click Delimited text.  The

Import dialog displays.  Select Update current database.

2. Click OK.  The Import Wizard dialog displays.

3. Do one of the following:
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· To append all imported records to the end of the existing database records,

select Load.

· To replace existing records in the database with the imported records, select

Overlay.  Overlay allows you to specify a range of records for overlaying.  All

of the data in the delimited text file is loaded into the documents in the current

query. Documents can be overlayed in sorted order too.  Just sort the query

before importing.  If you want to replace specific records by matching field

values, then you should import a Concordance database instead.  If you select

Overlay, and the delimited text file contains more records than the query, the

additional records are appended to the database as new documents.

o In the First field, type the first document number in the query to overlay.

o In the Last field, type the last document number in the query to overlay.

4. Click Next.   The Import Wizard - Format dialog displays.
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5. Specify the Format for the delimiters in the data you are loading:

· Concordance default - use this option if you are importing/exporting

documents within Concordance.

· Comma delimited (CSV) - use this option if the data you are loading is a

standard comma delimited file.

· Tab delimited - use this option if the fields in your data are separated by

tabs.

· Custom - use this option to specify each delimiter value.

6. Modify the individual Comma, Quote, and Newline characters after selecting

a Format only if you are using these characters in the text of your delimited

file.

7. Click Next.  The Import Wizard - Date format dialog displays.
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8. Select the date format that matches the data in your delimited text file.  Click

Next.  The Import Wizard - Fields dialog displays.

9. By default, all the database fields are added to the Selected fields list.  Adjust

the fields to import based on your needs by moving fields in or out of the

Selected fields list using the buttons in the center.  You should also make

sure the order of the fields matches the delimited text file you are loading.  If

the Selected fields does not match the field structure of your delimited text

file, the data will not import properly.

10. The Skip first line check box tells Concordance that the first row of your

delimited text file contains field names rather than field data.

11.  Once you have the fields configured to match your delimited text file, click

Next.  The Import Wizard - Open dialog displays.
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12. Click the Browse button, navigate to and open the delimited text file you want

to import into the database.

13. Click Next to open the Import Wizard – Finish dialog.
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14. Click Finish to load or overlay the delimited text file.

15. If any data overflow issues occur they will display in the Data overflow list. 

The Documents number updates to show the number of successfully loaded

documents.  

16. Close the wizard using the X in the upper right corner.

Using Import Dialog with Delimited Text

1. On the Documents menu, select Import, and then click Delimited text.  The

Import dialog displays.  Select Import dialog box.
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2. Click OK.  The Import Delimited Text dialog displays.

3. By default, all the database fields are added to the Selected fields list.  Adjust

the fields to import based on your needs by moving fields in or out of the

Selected fields list using the buttons below the Available fields and

Selected fields.  You should also make sure the order of the fields matches

the delimited text file you are loading.  If the Selected fields does not match

the field structure of your delimited text file, the data will not import properly.
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4. The Ignore first line check box tells Concordance that the first row of your

delimited text file contains field names rather than field data.

5. Modify the individual Comma, Quote, and Newline characters only if you are

using these characters in the text inside your delimited text file.

6. Select the Date format that matches the data in your delimited text file. 

7. Click the Go button to display the Load delimited file dialog. Browse to and

select the delimited text file you want to import.  Click Open.

8. If any data overflow issues occur they will display in the Status list.  The

Documents loaded number updates to show the number of successfully

loaded documents.  

8. Click Done to close the Import Delimited Text dialog box.

Using Overlay Dialog with Delimited Text

1. On the Documents menu, select Import, and then click Delimited text.  The

Import dialog displays.  Select Overlay dialog box. 

2. Click OK.  The Overlay Database dialog displays. 
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You can go directly to the Overlay Database dialog by selecting

Import>Overlay on the Documents menu.

3. By default, all the database fields are added to the Selected fields list.  Adjust

the fields to import based on your needs by moving fields in or out of the

Selected fields list using the buttons below the Available fields and

Selected fields.  You should also make sure the order of the fields matches

the delimited text file you are loading.  If the Selected fields does not match

the field structure of your delimited text file, the data will not import properly.

4. In the First field, type the first document number in the query to overlay.  In

the Last field, type the last document number in the query to overlay. By

default, all documents in the current query are overlayed.
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5. Modify the individual Comma, Quote, and Newline characters only if you are

using these characters in the text inside your delimited text file.

6. Select the Date format that matches the data in your delimited text file. 

7. Click the OK button to display the Overlay delimited file dialog. Browse to

and select the delimited text file you want to import.  Click Open.

Verify the Metadata

After importing a delimited text file, verify your imported delimited text files in

Concordance. If you are importing a delimited text file into a new database, you will

also need to index the database. If you are importing or overlaying a delimited text

file into an existing database, you will also need to reindex the database.

To verify your imported delimited text files:

1. On the Toolbar, click Table to open the Table view.

2. Verify the imported records are in the record listing.  If you imported records

into an existing database, the new records are added after the last existing

record in the database.

3. On the Toolbar, click  Browse  to open the Browse view.

4. On the Tools menu, click Empties.  The Empties command determines

whether empty fields are displayed in the Browse view. By default,

Concordance does not display or print empty fields.  With Empties enabled

you can verify the field data you imported or overlayed is populated with the

correct data.

5. If you imported or overlayed the delimited text file into an existing database,

reindex the database.  If you imported or overlayed the delimited text file into

a new database, index the database.
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The following columns represent available delimiter characters. For each delimiter,

the displayed symbol is on the left and the decimal equivalent is in parenthesis on

the right. If the source program you are importing from uses a different font, it can

change the symbolic representation of the delimiters. If this happens, match the

delimiter characters with the decimal equivalents instead of relying on the

displayed symbol. Using the decimal equivalents will always result in a correct

delimiter match.
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E-Documents

Adding documents to an existing  E-Documents database is made easy using a

simple file drag-and-drop operation.  Concordance automatically processing the

documents, assigning document IDs, reading document metadata, extracting text,

and appending the records to the database. 
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Any file or electronic document format not supported will be added to the database

as an excluded file, and the contents will not be imported.  You’ll need to adhere to

any forensic data processes as outlined by your organization or recommended for

e-discovery processing.

The E-Documents import wizard is not available for a Concordance

Workstation installation.

Adding Documents to an Existing E-Documents

Database

1. In Concordance, open the database you want to add additional records.

2. Using File Explorer, open the folder that contains the documents you want to

add and select and drag the file(s) to the Concordance workspace.

3. When prompted to confirm adding the documents, click Yes.

4. Concordance imports the document(s).  In the Browse view, verify that the E-

documents you added are now in the database.

5. If you have already indexed the database, reindex the database. Otherwise, run

a full index.

Supported File Types

Concordance supports the following E-Document file types for import to an E-

Documents database:
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File

Type

Description

*.tif,

*.tiff

Tagged Image File

*.jpg,

*.jpeg

Joint Photographic Experts

Group

*.gif Graphic Image File

*.bmp Bitmap

*.asc ASCII text

*.pcx PC Paintbrush bitmap

*.csv Comma-Separated Values

*.cal,

*.cals

Facsimile

*.pdf Adobe Portable Document

Format
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File

Type

Description

*.doc,

*.dot,

*.docx

Microsoft Word 

*.ppt,

*.pps,

*.pptx,

*.pptm

Microsoft PowerPoint®

*.xls,

*.xlsx,

*.xlw,

*.xlt

Microsoft Excel®

*.msg Microsoft Outlook 2010

Message File

Attachmen

ts

associated

with a

.msg file

will not be

extracted

when the

.msg is

imported.
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File

Type

Description

*.txt ASCII Text

*.rtf Rich Text Format

*.html,

*.htm

Web/HTML — Only

supported in E-Document

databases.

*.pab Microsoft Outlook

Personal Address Book

*.wps Microsoft Works

Transcripts

Transcripts are the easiest files to load into a Concordance database, but you must

load the files into a database created from the Transcript database template.  The

template is hard-coded with a CPL script that enables line numbering and does the

work for you.  You can import plain text transcripts, depositions, and West LiveNote

portable transcript and portable case format files.  The maximum size for an

imported transcript file is 11 MB.

Create a Transcript Database

1. On the File menu, click Template.  The Create database from template

dialog displays.

2. Select the Legal tab.
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3. Click Transcripts, then OK.

4. Browse to the folder for the new transcript database, enter a File name for the

database, and click Open.

5. Your newly created empty transcript database is displayed in Concordance. 

You now need to import the transcript documents.

Import Transcript Files

1. On the Documents menu, select Import, and click Transcripts.  The Load

transcripts dialog displays.

The Transcripts menu command is only enabled when the current

database was created using the Transcripts template.

2. Browse to and select one or more .txt and/or .ptf transcript files to import. 

Click Open.  The Load transcripts dialog displays.
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3. The dialog highlights the first file to load in the list at the upper left.  The

associated Properties for this file are displayed on the right.  If needed, edit

the displayed properties then click Save to move to the next file.

4. If you do not want to review the extracted transcript properties for each file,

select Save all with default settings and click Save.

5. After each file has been saved, the Load transcripts dialog updates to display a

Load button.  To import additional transcript files, click Load.

6. Once all your files have been loaded, click Done.

7. In the Browse view, verify your transcript files have been imported.

8. If you have already indexed the database, reindex the database. Otherwise, run

a full index.
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Since .pcf transcript files contain multiple transcripts, you will not

be prompted to edit and save individual transcripts.  

Email and Attachments

When importing emails and attachments into Concordance, it’s best to create an

Email database for these files because they contain unique coding for the author

and recipients, include a parent and child structure that needs to be preserved, and

attachments that need to be retained.  All of these components are critical metadata

that can easily be altered, spoliating original records and damaging critical

information regarding who knew what and when.  Once damaged, this information

is nearly impossible to restore and is irretrievable after the import process.

Concordance is able to import .pst formatted files that are associated with a

Microsoft Outlook profile on your machine. You need to have Outlook installed

with a mail profile set up for each custodian, so you can associate each .pst file to

an Outlook profile. This should be done before using the Import e-mail wizard in

Concordance.

Concordance provides an Email database creation wizard, which includes typical

metadata fields from Outlook and takes care of the field mapping for you. The

wizard also allows you to create and modify fields as needed.  See Creating an

Email and Attachments Database for more information.

You may also want to consider how you are using Concordance in terms of

production so that the content can be reviewed and redacted.  If your organization

is using:

· Concordance Native Viewer - the View e-mails in Concordance Native

Viewer option must be selected in the Import e-mail - Attachments dialog box

to ensure the Concordance Imagebase (CIB) file is created (for new records

only).

· Concordance Image - e-mails need to be processed into images with a

corresponding .dat and image load file.

Import E-mail and Attachments
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Email is imported into Concordance using the Import email wizard. The Import e-

mail wizard automatically establishes parent-child relationships with the e-mail

messages and their attachments. This provides efficient and comprehensive

searching and saves time in document loading.

When importing emails into a concatenated database, e-mails are

updated when the fields of an imported e-mail match an existing

email. When the fields do not match, the imported email is

appended to the main database, which is the first database in the

concatenated set.

1. In Concordance, open the Email database you want to import additional

documents.  

2. On the Documents menu, select Import, and click E-mail and Attachments.

 The Choose Profile dialog displays.

3. From the Profile Name list, select the name of the e-mail profile you want to

use (Outlook is the local machine's default e-mail).  Click OK.  The Import e-

mail - Folder dialog displays.
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4. Select the folder or subfolder containing email messages that you want to

import. 

5. To include subdirectories underneath the selected folder, make sure that the

Import subdirectories check box is selected.

6. Click Next.  The Import e-mail - Attachments dialog displays.
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7. To extract attachments, make sure that Extract messages and attachments

is selected, then Browse to the directory where you want to store the extracted

email files and attachments.  The Attachment directory defaults to the email

database's directory.  

8. It is best practice to store attachments in subdirectories by selecting Create

subdirectories for attachments, especially when you are managing large

numbers of attachments.  When selected, specify a Subdirectory prefix and

the Max files allowed in each subdirectory. Subdirectories are named using

the prefix you specify followed by a number.

9. Select View emails in the viewer associated to this database if you will be

using the viewer for review.  Selecting this option creates the Concordance

Imagebase (CIB) file that is needed to link email files with the corresponding

record in Concordance.  The database must have a unique image key field.

10. Click Next.  The Import e-mail - Date range dialog displays.
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11. Select Import all e-mails to import everything in the previously selected

folder, or select Import e-mails from a specific date range to limit the

import to emails dated between Begin date and End date.

12. Click Next.  The Import e-mail - Fields dialog displays.
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13. The left column displays email message fields, and the right column displays

the database fields.  Verify that the fields are mapped correctly, and make any

adjustments needed by selecting the correct database field using the drop

down arrow on the right.

10. Click Next.  The Import e-mail - Options dialog displays.
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11. Select the Auto-number documents with a DOCID (documentID) to auto

number the imported email messages, and then specify the Prefix and

Starting number (zero-filled) to use.  This option must be selected if you are

using Concordance Native Viewer.

12. Select Display full path of attachments to display the full path to

attachments.

13. Select Do not allow duplicate e-mails if you do not want to import

duplicate emails. Most emails have a unique message identifier called the

message-id, which is stored in the MESSAGEID field.  Before importing a

message, the import wizard checks to see if any previously imported emails

have the same message-id.  If the wizard finds another record with this

message-id, it does not import the message.

14. Select the option you want under Import HTML formatted e-mail text as.

15. Select Create log file for attachment import errors if you want the import

to create an import error log.



Concordance Classic56

© 2022 CloudNine™. All rights reserved.

12. Click Next.  The Import e-mail - Finish dialog displays.

13. Click Import.  The import runs and the Status messages field updates to

provide information about the import.

14. Click Done to exit the wizard.

15. In the Browse view, verify your email messages have been imported.

16. If you have already indexed the database, reindex the database. Otherwise, run

a full index.

OCR Files

It is best practice to store the body text of your records, also called OCR, in a

separate text file from your field metadata.  When your OCR is placed into

individual document-level text files, you can import the text into each

corresponding record. The text file name must match the image key field (the

BEGNO field or its equivalent). 
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If the body text contains more than 12 million characters (the capacity of a

paragraph field),  Concordance automatically overflows the text into the next

available field.  If you import your OCR from a delimited text file and there are

more than 12 million characters in a record, then you need to separate the text in

the delimited text file into multiple fields to avoid truncation during import.

After your metadata is imported into your Concordance database, it’s time to

import your record content into the body text fields.  If you have already created

your database, you can use a CPL script (ReadOCR<version>.cpl) to quicky import

OCR text files into your database field structure by linking them with the image key

field and ensuring that the correct file path is designated. Your record content from

OCR files usually populates the OCR1 and OCR2 fields or their equivalents. The

OCR fields are where the bulk of full-text searching is done in Concordance.

If your OCR files aren’t importing properly when using the CPL, check the

following:

· Verify file names and extensions - OCR text file names should match the

associated image key, and have a .txt file extension

· Check your .LOG file to verify whether each OCR file successfully loaded

Your OCR text files can reside in the same directory as the image

files. They do not need to be separated. You will need to import

your OCR for each volume where it resides.

Using ReadOCR.CPL

1. In Concordance, on the File menu, click Begin Program.

2. In the Open box, navigate to your CPL folder, select the

ReadOCR<version>.cpl file, then click Open.  By default, CPLs are installed in

C:\ProgramData\CloudNine\Concordance 10\CPL.

3. A dialog displays confirming you are running the Read OCR Utility.  Click OK.
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4.  In Concordance, the Workspace pane background is now blue, an indication

that you are running a CPL script.  The OCR IMPORT MENU and Status

details display.  The Current CPL displays in the Navigation pane.

5. CPLs work off of current queries in Concordance.  The number of documents

in your current query is displayed in the Status Bar at the bottom.

6. On the OCR IMPORT MENU, click [I]mage field select.  

7. An additional window displays a list of fields and their associated types.  Select

BEGNO or its equivalent.  The Status window updates to show BEGNO as the

Image field.
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8. On the OCR IMPORT MENU, select O[C]R field select.

9. An additional window displays a list of fields and their associated types.  Select

OCR1 or whatever field you want to use as the first OCR field.  The Status

window updates to show OCR1 as the First OCR field.  

10. On the OCR IMPORT MENU, click [D]irectory of OCR text.

11. A browse dialog is displayed.  Navigate to the folder containing your OCR files,

select the first OCR file, and click Open.  The Status window updates to show

the Path to your OCR files to import.

12. In the OCR IMPORT MENU, select [G]o!.

13. A browse dialog is displayed.  Navigate to a location for the OCR import log

file, enter a File name for the log and click Open.

14. The OCR import runs.  Review the log file to see if the import ran successfully.

15. On the OCR IMPORT MENU, click [Q]uit to exit the CPL script.

Verify the Imported OCR Text

Once you have imported your OCR files, it is best practice to verify the imported

text.  After verifying, you will need to reindex or index the database.

1. In Concordance, open the Browse view.

2. Verify that the data you just imported populated the OCR field correctly in

your database records.

3. Scroll to the bottom of a record to verify the administrative fields.

· Notice that the CREATEDATE field displays the import load date of the

document. The EDITTRAIL field is populated with the record modification

date, session and accession numbers, and the user ID of the person who

last updated the file. The ACCESSID field displays the load order number of

the document.
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· If you have corresponding OCR for every record and need to verify

whether all text was loaded into the OCR1 fields, then use a relational

search to ensure that every field was populated.

4. Run an empty OCR field search.  To do this, type OCR1 = “”. The search

provides query results on all OCR1 empty fields. You should receive the, “No

documents found in current query” message if all documents loaded properly.

5. Run a populated OCR field search.  To locate specific paragraph fields that are

populated, you can also run the relational search of [fieldname] = *. You

should receive query results for all documents that have this field populated

with any value.

Managing Databases

Ongoing maintenance of your Concordance database is standard practice as an

administrator. Some database management tasks require that all other users are

logged out of the database when they are performed. The administrator is the only

user allowed in the database when the following processes are occurring:

· Index

· Pack

· Zap

· Security

· Modify

· Replication/Synchronization

· Converting or upgrading to a current version

· To see users currently logged in, on the Help menu, click

About Concordance.

· To disconnect users:  contact them directly, or reboot the

database home drive.
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Database Properties

For a summary of general database settings and information select Properties

from the File menu.  In this dialog you can:

· Review concatenated databases and directory paths.

· Enter or review database descriptions.

· Review dictionary and punctuation information for full-text searching.

· Change the database home directory (defaults to the location of the .dcb file),

which is helpful when saving reports, queries, snapshots, etc.

· View users currently logged in to the database.
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Backup and Archive

See Concordance Database Files for more details about the various files used by

Concordance.

Database Backup

There are a couple of options for backing up your Concordance databases. Before

backing up your Concordance database, you need to determine how long the

backup process may take, given the size of the database files. The backup process

could take many hours, so having a solid estimate helps you plan backup

maintenance schedules.

Research the network’s automatic server backups and how it may impact

Concordance database files. Database files automatically backed up in this manner

often take longer to restore, therefore, they are probably not a practical method to

rely on as your sole source for database copies. 

Do not perform live backups if you are using backup software that

locks files, even briefly. This has been known to cause read/write

functions to the database files to fail, and can cause file

synchronization or corruption issues. Check with your IT group

and/or backup solution provider to verify that no file locking

occurs before scheduling any backups on Concordance,

Concordance Image, and FYI files that are in use.

Be aware that anti-virus, firewall, and backup software can often

interfere with network traffic and the locking of files, and in effect,

could cause Concordance, Concordance viewers, and FYI Server

software to crash.

Verify that you are not backing up your databases while they are in use. Any

locking of files while users are updating those same files can produce erroneous

results. Using snapshots on your data storage devices can reduce these effects

because they do not lock the files.
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To create a backup of a Concordance database, use the Export Wizard provided in

Concordance. Exported databases do not include security or tag history. To retain

security in your back up, you can also replicate the database. 

When backing up databases, you should also consider the following:

· Replication of your database files within Concordance has a longer processing

time, but this method retains security settings.

· If security is applied, back up the .sec files.

· Back up tags using the TagSaver<version>.cpl and

TagHistoryandStoreIt<version>.cpl.

· Do not forget to copy over your list files, queries, exported security, and .gat

files, etc.

· Verify that your antivirus does not scan any of the following file

types: .trk, .key, .dct, .dir, .fzy, .layout, .sec 

Backing up tags may take days for some databases, and loss of

tagging information can jeopardize a case review. Please make

time to research and test this process so you understand how to

best schedule this task regularly.

Database Archive

Archiving of databases is standard practice for corporate environments, and you

will want to adhere to those guidelines with Concordance databases. You may want

to make additional archives for maintenance reasons too, ensuring that you have

adequate archive files for case history and research. Reviewers are known to come

back, even years later, and want to research a case history if they are working on a

similar one. Many vendors offer vault storage and web repository environments for

data retrieval in the event of a disaster, or merely to restore data from an archive

library.
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You can create a database archive using Concordance. Because the storage capacity

for records is vast, an archive library may work well for your organization in

researching old records and case history data.

Archiving Guidelines:

· Run the Tag To Field command in the Tag and Issue Management dialog box,

and the TagHistoryandStoreIt<version>.cpl to track and manage tags in a

field.

· There are three minimum files needed to archive a database: .dcb, .ndx, .tex.

· Remember to turn off security so the file is accessible by others.

· Export to a delimited text file because it is a universal archive format that is

retrievable in years to come.

· Ask yourself whether you really need to archive images; these files are huge

and require adequate media storage.

· Move files to a long-term, archive-quality media.

· Schedule data destruction per corporate policies; determine how long do you

need to keep the copies.

· Keep an updated list of archive files for you or another administrator to

reference.

Modifying Databases

When you make a modification to a database, it usually means that you are

modifying fields in the database. When you modify a database, you need to be

careful. Concordance has no restrictions for database modifications, but we do

offer recommendations on what you should and should not do so you are less

likely to corrupt your database.

Always back up a database's files before you make any changes to the database.

Some modifications are more dangerous than others.  Database modifications

always require a full index update immediately after the modifications.  Most

modify functions rebuild the database and erase the dictionary, requiring you to

index the database from scratch.  We recommend that you plan ahead to allocate
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time for database modification since it requires exclusive access to the database

and time to run a full index.

Changes that do not require a database rebuild:

· Changing a date field’s display type

· Changing only one field’s name

· Adding or deleting key fields

When making changes, follow the 3 Change Rule.  We recommend that you not

make more than three changes to a database before indexing.  After making three

changes using the Modify dialog, save your changes, and then index the database. 

If you have applied security, you must also give users access to any new or

renamed fields before they are visible in the database.  New and renamed fields are

not visible in the Table view until they are added to the layout structure.

Modifications made to a database is a common reason for

corruption. Please use caution when making changes and always

back up your database files before doing so.  Also it is a good

practice to close other databases while making database

modifications.

If you are modifying the database structure and using an active

sorting layout or table layout, you must delete .sortinglayout and

.layout files.  The files will be rebuilt to accommodate the new

database structure the next time you open the database.

If Concordance security is enabled, the Modify dialog can only be

accessed by a user that has full read/write access to all fields.
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Adding/removing punctuation

Changing a field’s length

Changing field properties (index or key)

Changing data types (text to paragraph)

Adding a new field at the end of the list

Inserting a new field in the middle of the list
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Renaming a field – A common cause of database

corruption!

Delete or insert a field elsewhere – common cause

of database corruption.
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Making more than one change to the same field, at

the same time

If you need to change a field name, make a new field first and run

the AppendOneFieldToAnother_<version>.cpl, then hide the other

field from users in the Security dialog box. Do not delete it!
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Modify a Database

1. Make a back-up copy of the database you are modifying.  See Backup and

Archive  for more information.  Do not proceed to step 2 until you have

completed this procedure.

2. Once your database backup copy is secure, open the database you want to

modify and close all other databases.

3. On the File menu, click Modify.  The Modify dialog displays.

4. Make the necessary changes.

5. Click OK to save your changes and close the Modify dialog.

6. Run a full index.

Whenever you add or rename a field in the database, it is added to

the database without field access rights. In the Security dialog box,

the No rights check box is automatically selected for the field. You

62
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will need to set the field privileges for the new or renamed field for

users already entered in the Security dialog box.

For more information about field access rights, see Setting Up

Security . 

Replicating Databases

With Concordance, you can create a copy of your database records and images so

reviewers can work offline, and then synchronize any edits and changes back into

the primary database to update to the document collection. The synchronization

process helps merge the most recent updates with other user updates, and

provides a listing of any collisions so you can resolve any field and/or note

discrepancies between the original and replicated databases. 

Replication versus Synchronization:

· Replication is creating an exact copy of your database while tracking the

replicated copy.

· Synchronizing databases is merging the replica database to the primary

database, and reconciling any updates or edits.

When replicating and synchronizing databases, we recommend that you follow the

directions in all dialog boxes and use all fields, if possible. For concatenated

databases, you must replicate each database individually.

When replicating a database, be aware that the .dir, .vol and .cib

files are not replicated and the replicated database will not be able

access Concordance Viewer, Concordance Native Viewer or

Concordance Image.

Enable Replication

324
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The first step in replicating a database is to enable replication. You can replicate a

database without enabling replication, but you will not be able to synchronize back

to the publishing database. If replication is enabled, you can replicate both ways.

1. Back up the database you want to replicate.  It is essential that you create a

backup copy of your database before enabling replication. You can cancel the

process before it is half-way complete. After the half-way mark, the Cancel

button is disabled and the process must complete.  If you want to cancel the

process after the half-way mark, you will have to restore your database from

backup.

2. In Concordance, open the database you want to replicate.

3. On the Tools menu, select Replication, and click Enable replication.  The

Enable Replication dialog displays.

4. Synchronization field is a read-only.  When you enable replication in a

database, Concordance creates the REPLICATION field in the database. The

REPLICATION field is system field that tracks your replicated database and is

administered by Concordance. If you need to change the REPLICATION field

name, you can modify the field in the Modify dialog box.

5. Enable field level replication enables field-level replication. Concordance

can track changes on a field-by-field basis. If two people edit the same record

and then synchronize, Concordance will detect if the edits were to different

fields and merge the edits without signaling a collision. Without field-level

replication, Concordance cannot arbitrate the edits and it will flag a collision. 

Enabling this feature adds entries to the database tracking file, called [database

name].trk, for each edit. The tracking file adds overhead to the system in terms

of file storage space and the computer time needed to manage it. The

overhead is generally low and you should enable this feature. You can disable

it later if you find that it is unnecessary.
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6. Click OK to enable replication and close the Enable Replication dialog.

Replicate the Database

When you replicate a database, the replica database contains all security settings

from the original database. You can create a replica database that only contains the

records in the current query, in sorted order, or all the records in database.

Concatenated databases cannot be replicated.

When replicating redlines databases, it is important to save the

replica in the same directory folder as the main database replica

and also name it the same to keep track of your files.

If you want your database permanently sorted, you should sort the

database and then create a replica by using the [#] Records in

Query option. The replica database will be permanently sorted.

1. Make sure that the database you want to replicate is backed up.

2. Run a search query to locate the records you want to include in the replica

database.

3. On the Tools menu, select Replication, and click Create a replica.  The

Create Replica Database dialog displays.
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4. Publisher displays the name and path of the current database.  Click Replica.

5. Browse to the location for the replica database, provide a replica .dcb File

name, and click Open.

6. For Create Using select the Entire database to replicate all database records

or <#> Records in Query to replicate the records from the current query.

7. When a database is replicated, the database's notes database is replicated

along with the main database. Concordance can copy any external files

attached to those notes to the replica database's destination directory. This is

useful for laptops that will not be connected to the network, but still need to

access the attachments.  Select Copy attachments to replica database

directory to copy the note attachments.

8. Click OK.  The Progress section updates to show information while the replica

is being created.

9. When the replication process is complete, click the Done button.

The new replica database will not be indexed.

Synchronize the Databases and Resolve Collisions
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After edits are made to the original and/or replica database, you need to

synchronize the databases to update them.

Synchronization copies any changes between the databases. The synchronization

options allow you to fine tune the replication process. You can set your database to

publish data but not receive any updates, a read-only publishing scenario. You can

set the options so that you are receiving changes, but not delivering them, or you

can enable full replication with complete synchronization between the two

databases.

The Replication dialog box is used to define the synchronization options and run

the synchronization.The default options in the Replication dialog box are set for full

symmetric, bi-directional synchronization.

1. In Concordance, open the original or replica database.

2. On the Tools menu, select Replication, and then Synchronize databases. 

The Replication dialog box displays.

3. Publisher displays the database name and path for the database you opened.
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4. Click Subscriber.  Navigate to and select the database you want to

synchronize with the Publisher database.  Click Open.

5. If you want to use a Tag to tag records that have collisions between the

Publisher and Subscriber databases, type that tag name in Tag for

Collisions.

6. Based on which database is most current, in the Synchronization section

select one of the following:

· Synchronize Databases  - fully synchronizes both databases. All changes

from the Subscriber database are copied to the Publisher database, and all

changes from the Publisher database are copied to the Subscriber

database.  

· Subscriber Overwrites Publisher - during the synchronization, only the

changes in the Subscriber database are added to the Publisher database.

Data in the Subscriber database overwrites the data in the Publisher

database. 

· Publisher Overwrites Subscriber - during the synchronization, only the

changes in the Publisher database are added to the Subscriber database.

Data in the Publisher database overwrites the data in the Subscriber

database.

7. Select Copy attachments with notes to copy the attachments associated

with the records from one database to another.

8. In the Fields section, select one of the following:

· Use All Publisher Fields - select this option if you want Concordance to run

a full bi-directional synchronization. 

· Use Selected Publisher Fields - select this option if you only want to

update specific fields during the synchronization.  If you select this option,

the Select Fields dialog will display allowing you to specify the fields to

synchronize.

If you select the Use Selected Publisher Fields, records will

not be marked as synchronized during the synchronization. The
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database records remain out-of-synch until a full

synchronization takes place and ALL fields are synchronized via

the Use All Publisher Fields option.

9. In the New Records section:

· If you are running a full synchronization between the two databases, select

both Append records to Publisher and Append records to Subscriber.

· To add new records from the Publisher database to the Subscriber

database, select Append records to Publisher and clear Append

records to Subscriber.

· To add new records from the Subscriber database to the Publisher

database, clear Append records to Publisher and select Append

records to Subscriber.

If you created a replica database from a query and you want to

keep only the records from the query in the replica database,

clear both Append records to Publisher and Append

records to Subscriber, otherwise the full database will be

appended.

10. In the Deletions section:

· If you are running a full synchronization between the two databases and

you want Concordance to mark deleted records from one database for

deletion in the other database, select Mark for Deletion.   Remember,

marking a record for deletion does not delete the record from the

database.  A record marked for deletion is not deleted from a database

until the database is packed. 

· To tag records that have been marked for deletion, select Tag Deleted

Records and type the tag name you want to use in the corresponding

field.

· Select Append/Restore Deleted Records to have Concordance copy a

deleted record back to the database it was deleted from, effectively
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restoring the record.  This can only take place if it was not marked for

deletion and packed from both databases. The record must still exist in one

of the databases to restore it. 

When you synchronize databases with Append/Restore

Deleted Records selected, the deleted records are restored,

but the restored records are not displayed in the database until

the database is reindexed.

11. Click Advanced to update Replication Lockout parameters:

· Replication lockout is the time that replication holds the <database>.key file

open for exclusive use.  No other network user can access the file when it is in

exclusive use.  The Seconds to lock files for exclusive use value defaults to

0.10 seconds, which balances performance with file sharing. However, some

wide area network (WAN) connections perform file and record locking very

slowly. The default lockout parameter may be too small for reasonable

synchronization performance.

· To set a specific date for synchronization, select the Only synchronize

changes on or after drop down and pick the date you want to use.

12. You can click Save Settings to save all the options you have selected as the

default settings each time you display the Replication dialog.
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13. Click Synchronize to start synchronizing the databases.  If any collisions are

found a message will be displayed asking if you want to resolve them.  

New notes added after replication to either the original or replica

databases will not cause a collision during synchronization. Only

notes created in the replication process, that are then edited, will

cause a collision when synchronizing.

Collisions do not need to be resolved during the synchronization

process. You can resolve collisions later or choose to enter

additional text in the primary database field to note the differing

entries, and notify reviewers of the discrepancy to verify whose

annotations are correct.  To resolve collisions after

synchronization, see the Resolve Collisions after Synchronizing

the Databases  section below.

14. Click Yes to resolve the collisions during the process:

· If Concordance finds field collisions, the first record containing a collision

in both databases will be opened in Edit view. The fields containing data

collisions are displayed in red text. The Status bar at the bottom of the

screen displays the number of records containing field collisions found

during the synchronization.  Select either:

o Resolve all collisions with publisher

o Resolve all collisions with subscriber

· If Concordance finds only note collisions, clicking Yes opens the Resolve

note collisions dialog. The number of note collisions found during the

synchronization is displayed at the bottom of the screen. Do one of the

following:

o If you want the data in the publisher database's record to overwrite the

data in the subscriber database's record, click Publisher overwrites.

78
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o If you want the data in the subscriber database's record to overwrites

the data in the publisher database's record, click Subscriber

overwrites.

· If Concordance finds both field and note collisions during synchronization,

Concordance displays all field collisions first and then displays the note

collisions.

If you exit the field collisions view by clicking on another view,

closing the database, or exiting Concordance before all field

collisions are resolved, the Resolve note collisions dialog will

not appear.

15. When you are finished resolving all collisions you will see a message stating

All collisions have been resolved.

16. Click OK.

17. If changes were applied to either databases during the synchronization they

will need to be reindexed.

Resolve Collisions after Synchronizing the

Databases (Optional)

During the database synchronization process, if Concordance finds collisions

between the records in the publisher database and the subscriber database, you

have the option of resolving the collisions during or after the synchronization

process. 

Collisions do not need to be resolved during the synchronization process. You can

resolve collisions later or choose to enter additional text in the primary database

field to note the differing entries, and notify reviewers of the discrepancy to verify

whose annotations are correct.

You have two options for resolving collisions after synchronizing the databases:
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1. Rerun the synchronization.  If you need to work with your associates to

resolve the collisions found during the synchronization, once you have the

information you need to resolve the collisions, you can rerun the

synchronization and resolve the collisions during the synchronization process.

Before rerunning the synchronization, reindex the databases. If you do not

reindex the databases, you will not be prompted to resolve collisions when

you rerun the synchronization.

1. Query the collision tag in both databases.  If you need to work with your

associates to resolve the collisions found during the synchronization, once you

have the information you need to resolve the collisions, you can query both

databases for the collision tag you created during the synchronization process

and manually resolve the collisions between the two databases.

Resolving Collisions Using the Collision Tag:

1. In Concordance, open the original database and the replica database.

2. Run a query for the collision tag in both databases.  The collision tag is created

in the Tag for Collisions field in the Replication dialog box and applied during

the synchronization process. When Concordance finds a collision during the

synchronization process, Concordance applies the collision tag to the record in

both databases. 

3. Compare the records tagged with the collision tag, and locate the field data

and/or note collisions between the same record in each database.

4. For field collisions, in the Edit view, make the necessary edits to resolve the

collisions, and click the Edit view button or move to another record to save

your changes.

5. For note collisions, click the note in the Browse view or right-click the note in

the Notes task pane to open the Notes dialog box, make the necessary edits

to resolve the collisions, and click OK to save your changes.

6. After resolving the database collisions, reindex the modified databases.
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Purge Old Events

Replication makes use of a database tracking file, <database>.trk, to log edits,

deletions, and other modifications for each database in a replication set. Many of

the entries in the file are no longer needed when all replica databases have been

synchronized. Unfortunately, Concordance has no way of knowing if all replica

databases have been synchronized or even how many replica databases exist, so it

cannot automatically purge old entries from the tracking file.

It is best practice for Concordance database administrators to purge old events

from time to time as the databases are synchronized. 

1. On the Tools menu, select Replication, and click Purge Events.  The Purge

Logging Information dialog displays.

2. For Delete events older than, select the starting timeframe to purge events

from the file.  You can select from one month ago up to a year ago.

Concordance purges data older than the timeframe selected. After making

your selection, the Purge Logging Information dialog box displays the specific

date Concordance uses to delete events from the file.  

3. Click OK to purge the events.

4. After the events are purged from the .trk file, the Purge Logging

Information dialog box displays the number of events that were deleted.

5. Click Cancel to close the Purge Logging Information dialog box.

Replicating Databases for Working Offline
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You can make a copy of your images and existing redlines for a user to work

offline. In order to create a copy of your images and existing redlines for working

offline, you need to create:

· A replica of the <database>.dcb database file

· A copy of your images

· A replica of your <database>-redlines.dcb

To create a copy of the images, you need to create a production. When you create a

production, an imagebase is created. You will want to name the imagebase's .dir

file the same as your replicated database name and save it in the same directory

folder. 

When you replicate a redlines database, you will have a copy of the existing marks

on the images and can create new ones.

Concatenated Databases

When large databases are split into multiple databases and concatenated for ease

of maintenance, all databases can be created with the same structure (see Sample 1

below).  As the administrator, this database design serves both you and the

reviewer. The generic naming of the primary database prevents confusion for the

reviewers because they can simply launch the primary database without having to

be concerned about multiple databases. The design also benefits you because

databases are similarly named and the structure allows for ease of maintenance

when indexing or reindexing is needed. 

This database structure allows you to index individual databases without having to

take the all databases offline. Reviewers can continue working in other databases

while you perform the maintenance. Simply notify the review team when records

with Bates numbers x through y will be offline.

Concatenated Databases Sample 1
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Data

base

File

Description

Columb

ia.dcb

Primary database with no

records to associate with a

.cat file.

Columb

ia1.dcb

Import first set of load files

and link any images. Index

and place database on

network to begin review

by concatenating to the

primary database,

Columbia.dcb.

Columb

ia2.dcb

Create a copy of the

Columbia1 structure and

load additional documents

that were received. Index

and concatenate to the

primary database.

Columb

ia3.dcb

Repeat

Alternate concatenated database designs can be used.  As an example, Transcripts

must be organized in a separate database because of the template structure

required to import these files.  If your database includes Transcripts, you may want

to design a concatenated database based on document type (see Sample 2 below)
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Concatenated Databases Sample 2

Data

base

File

Description

Hunter.

dcb

Primary database with no

records to associate with a

.cat file.

Hunter

Edoc.dc

b

Database containing

electronic documents.

Hunter

Email.d

cb

Database containing

emails and attachments.

Hunter

Transcri

pts.dcb

Database containing

transcripts.

Hunter.

cat

.cat file linking individual

databases with the empty

database, allowing viewers

to launch them individually

or as a concatenated set.

When various database types are concatenated and saved in a .cat file, all databases

in the set automatically launch when the primary database is accessed in
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Concordance – as long as the .cat file has the same name as the primary database

and is saved in the same directory folder as the primary database.  This concept is

useful when separating documents by source or custodian as well.  Users can then

choose to only view certain documents by custodian or document type by

launching the individual database or review all records together by launching the

primary database that has the associated .cat file.

The concatenated text file (.cat) is used to keep track of concatenated databases. The

file contains the list of database names and their file paths for the databases in the

concatenated database set. If you open a database and Concordance finds a

database .cat file by the same name in the same directory as the .dcb file, the

databases in the list are automatically opened and concatenated.  Since the Reindex

function updates all actively concatenated databases, you can search, edit, and use

the group as if they were one.

When managing concatenated databases, be aware of the following:

· Index databases individually

· Reindexing is done on all the databases in the concatenated set in turn

· Pack databases individually

· Data imports only append to primary database

· Exports only use a selected database’s field structure from a concatenated set

· Security is applied to databases individually

· Only run productions on individual databases

· Only replicate individual databases

You can export from a concatenated set of databases as long as the

field names are the same; however, the field type is inherited from

only one selected database.  Data may be truncated if the field size

and data size of one of the concatenated databases exceeds the

field size of the selected database structure.

Concatenated databases have the following limitations:
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· You can join databases with differing structures and they can be edited, sorted,

and printed. However, the structures must be identical to use certain options

such as Overlay and Export.

· You cannot replicate or create a production from a concatenated database.

· When using the Ditto feature, only documents in the primary database can be

used for copying data.

· When exporting concatenated databases, only the data in fields that are

identically named and formatted in the concatenated set will be exported.

· When importing records into a concatenated database, records are updated

when the fields of an imported record match an existing record. When the

fields do not match, the imported record is appended to the main database,

which is the first database in the concatenated set. However, when using the

Overlay option, importing records with mismatched fields can cause a loss of

data.

· Records cannot be packed from the concatenated database. They can only be

packed from the original, unconcatenated database.

· Concordance displays an appropriate error message if you try to use one of

the restricted options. Some options, such as Modify, operate only on the

primary database in the concatenated list.

Only files with the same file type can be concatenated together. 

DCB files can be concatenated with DCB files, but not FYI files.

Security for concatenated databases includes the following guidelines:

· Security settings need to be set up in each database. Setting security in a

concatenated database set only affects the primary database.

· The user name and password must be the same for all databases in the

concatenated set when security is enabled.

· When the user name and password in the primary database does not exist in a

secondary database, and security is enabled, the concatenated database will
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not open. The user receives a message that they do not have access rights to

the specific database.

· When a secondary database has security enabled and the primary database

does not have security enabled, the user is prompted for the user name and

password when using the secondary database. The user name and password

entered becomes the user name and password for the concatenated database

set.

Reviewing Concatenated Databases

When reviewing concatenated databases, it can sometimes be difficult to

distinguish data from each individual database.  When you are searching data on

multiple databases, the query results from a same name field intermingle in the

Table view.  You can use one or more of these methods to help:

· Reference the Concordance title bar for an individual record’s database and

document name

· Reference field names for each database displayed in the Table view

· Change the font color and size for each database in the Table View using table

layouts

You can also adjust your Table Layouts if field names are similar to sort across the

joined databases. Copy the .LAYOUT file from one database to other concatenated

databases to use the same table layouts in Table View.  Each concatenated database

will be listed in the Table Layout dialog with public/private layouts that have been

created.  If necessary, you will need to manually rearrange fields to have them

display in the same columns for sorting purposes.

Applying tags to concatenated databases is as simple as applying tags to individual

databases. You can even add tags from one database to another database in a

concatenated set.  When databases are concatenated, all tags from both databases

are displayed in the Tags Panel. If a reviewer applies a tag from one database to a

document residing in another database, the tag is then added to the database

where it never existed before.
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Searching Concatenated Databases

When searching concatenated databases, Concordance searches across all

concatenated databases - searching each dictionary file one by one.

Saving queries executed on concatenated databases is the same process as saving

them when reviewing one database at a time.  All searches from all databases in

the concatenated set are saved.  Query files are stored in a .qry file, and can be

restored on a concatenated set as you would a single database.  You just need the

databases to be joined when you save the query and when you re-run the query. 

Re-running the queries on a concatenated database set searches any updates made

since the last time any database was reindexed.

Bulk Field Format Reset

If rich text formatting has been applied to field data, you may need to change the

rich text formatting in a field to plain text to save space or remove certain text

formatting that affects the precision of hit highlighting when searching in

Concordance.

If you need to remove rich text formatting from a field in multiple records in the

database, administrators can use the Bulk Field Format Reset feature.   Using this

feature removes all rich text formatting in the selected field and changes the text in

the field to plain text in all records in the database.

If you only need to remove rich text formatting from a field in individual records,

you can use the Reset Field Formatting function in the Edit view. For more

information about removing rich text formatting in the Edit view, see Formatting

Field Text.  

Make sure no other users are in the database before using the Bulk

Field Format Reset.

Reset Rich Text to Plain Text for Multiple Records
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1. On the File menu, select Administration, and click Bulk Field Format Reset.

 If prompted, enter your Administrator user name and password.  The Bulk

Field Reset Format dialog displays.

2. Select one of the two options:

· Check for RTF Data (Recommended) - to reset field data only if Rich Text

Format data exists.

· Reset Field Format - resets field data regardless of whether Rich Text

Format data exists.

3. Click OK.  The Bulk Reset Format dialog displays.
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4. In the displayed list, select the specific field that needs to be reset from Rich

Text to Plain Text.  Click Next.

5. A confirmation dialog displays.  Click OK to proceed.

After running Bulk Field Format Reset, the changes are immediately viewable in

Concordance.  You need to index/reindex your database to see the search hit

highlighting again.

Deleting Records

You may need to delete records if there are duplicate records or opposing counsel

unintentionally produced privileged documents.  Reviewers can flag records for

deletion, but they are not permanently removed from the database until the

database is packed.

Once records are flagged for deletion, you can run a query to review those flagged

documents and create a back-up of those records. This is your only fail-proof

means of restoring a record after it is removed from the database. If you find that

you later need to restore the deleted records, the only way to restore a record

permanently deleted from a database is to import the deleted records back into the

database.

Packing a database permanently deletes the records from the database, and there

is no undo function for this process, therefore it should only be available to

administrators.

Deleting Records Overview:

· Mark records for deletion

· Review the records marked for deletion

· Back-up records marked for deletion by exporting them to another

Concordance database

· Remove tags from the records marked for deletion

· Pack the database
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You can also permanently delete all records in the current database using the Zap

menu command on the Administration menu. When you zap a database, all

documents and search files are erased and free space is returned to Concordance.  

Mark Records for Deletion

See Deleting Records for more information about marking records for deletion.

Search for Deleted Records

1. On the Search menu, click Search for documents marked for deletion.

2. A query is run for the records currently marked for deletion in the database.

3. Using the Browse or Table view, review the records in the query results to

confirm whether they should be permanently removed from the database. 

4. See instructions in Deleting Records if you need to unmark a document for

deletion.

Back-Up Records Marked for Deletion

After reviewing the records marked for deletion, make sure your query is updated

to reflect the final list of records to delete.  You can now export the records to

another database.  See Exporting Database Records  for more details.

Always export your deleted records before you pack the database,

just in case you need to retrieve them later. Once you pack a

database, any records marked for deletion are permanently

removed. There is no undo function for this process.

Pack the Database

See Packing  for details on how to Pack a Database.
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Zap a Database

Zapping a database permanently deletes every record in the active database. All

documents and search files are erased and free space is returned to Concordance. If

databases are concatenated, only the documents and search files in the primary

database are erased when you zap a database in a set of concatenated databases.

Zap is permanent and cannot be undone.  It is recommended that

Zap should only be available to administrators

1. On the File menu, select Administration, and click Zap.   If prompted, enter

your Administrator user name and password.  

2. A confirmation dialog displays.  Click Yes to confirm you want to Zap the

database.

3. After the Zap process completes, No documents in query is displayed on the

Status Bar.

Packing

Pack the Database

Packing the database regularly can increase database processing and search speed.

 It should be part of your normal database maintenance.

Packing is an exclusive process.  There is no undo function for this

process. Records are immediately and permanently removed from

the database.  You should export a copy of your deleted records

prior to packing.

When packing concatenated databases, you must pack each

database individually.
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1. On the File menu, select Administration, then Pack, and click Database.  

2. Depending on security, you may be prompted to enter an administrator id and

password.

3. The pack process runs and a dialog displays showing progress.

4. Upon completion you can verify the records were deleted by opening the

Table view and validate the deleted records are gone.  It is best to also pack the

dictionary after packing the database.

If you have an ACCESSID field in your database, you will notice that

the accession number does not re-adjust for deleted records. This

allows you to view gaps in your database records and verify

removal.

Pack the Dictionary

In addition to packing the Database, you should pack the Dictionary to get rid of

unnecessary entries.  Good routine maintenance includes packing the dictionary

after you pack the database.

1. On the File menu, select Administration, then Pack, and click Dictionary.  

5. Depending on security, you may be prompted to enter an administrator id and

password.

6. The pack process runs and a dialog displays showing progress.  When the

dictionary has been packed, the dialog closes.

Authority Lists

Authority word lists are lists of words and phrases that open in Edit View when you

place your cursor in a field associated with a word list. Typing text automatically

scrolls the list to the word or phrase nearest in spelling.  Most words and phrases
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are retrieved with just a few keystrokes.  Authority list entries are always inserted at

the current cursor location in Edit View. 

An authority list can contain anything, including zip codes, author's names, and

complex chemical names. Any data entry task that is repetitive and prone to errors

is a good candidate for an authority list. Selecting entries from the list lowers the

number of errors introduced through data entry, and the number of keystrokes —

thus saving labor and expense while improving accuracy. 

Authority lists are created in the List File Management dialog. Once an authority list

is created, the list is assigned to a field or fields using the Data Entry Attributes

dialog.  Authority lists are saved in files with a .lst file extension.

You can create authority list values in three ways:

· Manually create list values

· Import existing values from a database field 

· Import values from an ASCII file

After creating the authority list you need to associate it with a field in the database,

and then verify that it works.

Create an Authority List

1. On the Tools menu, select Manage List Files.  The List File Management

dialog displays.
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2. On the Lists tab, click New.  A message displays asking if you want to allow

duplicates in the list file.  Select Yes or No.

3. A message displays asking if you want to create a case sensitive list file.  Select

Yes or No.

4. The Save As dialog displays.  Navigate to the location for the new .lst file and

enter a File name.  Click Save.

5. The new list file is now open in the List File Management dialog.  Select the

Edit tab.

6. In the Key field, type an item to add to the authority list.  The Key field is case

sensitive and allows up to 240 alpha-numeric characters.

7. For authority list files, the Data value is not used.  Leave this 0.

8. Click the Add button to add the new item to the list.

9. Repeat steps 6 through 8 for each new authority list item you want to add.

10. Click Done when you are finished. 
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Create Authority List From Field Data

1. On the Tools menu, select Manage List Files.  The List File Management

dialog displays.

2. On the Lists tab, click New.  A message displays asking if you want to allow

duplicates in the list file.  Select Yes or No.

3. A message displays asking if you want to create a case sensitive list file.  Select

Yes or No.

4. The Save As dialog displays.  Navigate to the location for the new .lst file and

enter a File name.  Click Save.

5. The new list file is now open in the List File Management dialog.  Select the

Authority List tab.

6. In the Field list, click the fields containing the values you want to use for your

authority list. To select multiple fields, use CTRL+click.
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7. In the Delimiter section, select the delimiter you want to use to separate items

in the authority list file.  The default is Comma.

8. In the Case conversion section, select whether you want all items to be

converted to uppercase, lowercase, or to not be converted.

9. In the Documents section, select the Current query or Entire database

option to determine which field values will be pulled into the authority list.

10. Click the Load button to add the field values to the authority list. 

11. You can go to the Edit tab and modify any of the authority list items.

12. Click Done when you are finished.

Create Authority List From a File

If you have an ASCII file with listed or delimited data you can save time by

importing it into an authority word list.

1. On the Tools menu, select Manage List Files.  The List File Management

dialog displays.

2. On the Lists tab, click New.  A message displays asking if you want to allow

duplicates in the list file.  Select Yes or No.

3. A message displays asking if you want to create a case sensitive list file.  Select

Yes or No.

4. The Save As dialog displays.  Navigate to the location for the new .lst file and

enter a File name.  Click Save.

5. The new list file is now open in the List File Management dialog.  Select the

Import/Export tab.
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6. Select Import.

7. Data values are not used by the authority list, so it does not matter whether

Include data values is selected.  If it is selected, the import populates the

Data value field on the Edit tab in the List File Management dialog box with

any data values from the file. 

8. In the Data value delimiter section, select the delimiter used in the file you

will load.  The default is Comma.

9. Click Import.  Navigate to and open the ASCII .txt file you want to load into

this authority list.

10. You can go to the Edit tab and modify any of the authority list items.

11. Click Done when you are finished.

Associate an Authority List with a Field

Once you have created an authority list in Concordance, you need to associate the

list to a field so it can be used for data entry in the Edit View.



Concordance Classic98

© 2022 CloudNine™. All rights reserved.

1. On the Edit menu, click Validation.  The Data Entry Attributes dialog displays.

2. In the Field Name list, click the field you want to associate with the authority

list.

3. In the Authority lists section, click the File button.  Navigate to and open the

authority list file (.lst). 

4. Select the options that apply to the authority list:

· Required for data entry - When the user's cursor is placed in the empty

field, the authority list automatically opens. If the field is already populated,

the authority list opens when a user clicks the right mouse button or

attempts to type in the field. When Required for data entry is selected,

users can only choose a field value from the list or cut, copy or paste the text

in the field.

· Single entry field - The field only allows one field value from the list to

populate the field. If a user clicks another field value from the list, the

original value is replaced by the newly selected value. You can select both

Single entry field and the Required for data entry to ensure users only

populates the field with one field value from the authority list.
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· List updateable by user - Users can add and delete field values from the

authority list assigned to the field. If you do not want users to modify the

authority list, be sure List updateable by user is not selected. When List

updateable by user is selected, the Insert and Delete buttons are displayed

at the bottom of the authority list dialog.

· Upper case conversion - Concordance automatically converts all text to

upper case before text is copied to the field or the text is added to the

authority list. Do not select Upper case conversion if you are using an

existing authority list containing lower case field values. If Upper case

conversion is selected in this scenario, when a user selects a lower case

field value from the list, the value will not be added to the field.

5. The Delimiter field defaults to the comma character. To change the field

delimiter, type a different character in the Delimiter field. The character in the

Delimiter field is used to separate field values that were added to the field

from an authority list.

6. Click OK to save your changes.

The Data validation and Authority lists sections in the Data

Entry Attributes dialog box are independent sections. For

example, assigning an authority list with words to a field selected

as Numeric only does not cause an error. The data from the

authority list overwrites the Numeric only setting.

Test an Authority List

After associating an authority list with a field, you can test to make sure that the

authority list opens for the field in Edit View.

1. In  Browse or Table View, select a record.

2. On the Standard toolbar, click the Edit button to open the record in the Edit

view in edit mode.

3. Click the field you associated with the authority list.
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· If Required for data entry was selected for the authority list in the Data

Entry Attributes dialog, the authority list automatically opens when you

click in the field if the field is empty. If the field is already populated, the

authority list opens when a user clicks the right mouse button or attempts

to type in the field. 

· If Required for data entry was selected for the authority list, users can

only choose a field value from the list or cut, copy or paste the text in the

field.

· If Required for data entry was not selected for the authority list, users

can right-click in the field to open the shortcut menu, and click the

authority list file name to open the authority list associated with the field.

Field Groups

You or reviewers may want to search across multiple data fields at the same time

without having to construct a long search query.

Writing field groups directly to an .ini file allows you to use an alias name to search

across multiple fields at the same time without having to construct a long search

query.

Example: ALLDATES = DATE, DOCDATE

By creating an alias field named ALLDATES and associating it with all various date

fields from a concatenated database set, users can search all date fields without

having to modify date field names in each database. You can also create a field

group for data fields in a non-concatenated database.

The CREATEDATE and CREATIONDATE fields, or their equivalents,

cannot be included in a field group because of the validation

settings applied to them.

Field groups written directly into an .ini file will also save into a

Concordance database template.
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Add a Field Group to the .ini File

1. Open the database .ini file using any text editor program.  The .ini file is stored

in the same directory as the database's .dcb file. 

2. Look for a [FieldGroups] section in the file.  If it doesn't exist, scroll to the

bottom of the file and add [FieldGroups] as the last line of the file.

3. Underneath the [FieldGroups] section, enter your new fieldgroup on a

separate line (i.e. FieldGroup = fieldname1, fieldname2, fieldname3).  You can

add as many fields as you want to the field group.

4. Save the file.

To test the field group, in Concordance, run a search using the field group alias (ex.

AllDate = ??/??/1980).  Your search results will include documents that match your

search criteria in any of the fields associated with the field group.

To use a field group for concatenated databases, add the same field group to the

other databases in the concatenated database set.
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Managing Data

In addition to managing the overall Concordance database, the Administrator

performs functions that help manage the data within the database.  As with all other

administrative maintenance, be sure you know who is actively using the database

whenever you are altering the data.

You may want to query the database for any documents that have been recently

edited.  On the Search menu, select Search for edited documents.  All documents

that have been edited since the last database index/reindex are displayed in Browse

or Table View.

Splitting and Joining Records

It may be necessary to split or join records that were not unitized properly at scan

time. For example, you might have a record containing one document that should

have actually been represented as two records. Conversely, you might have a

document split over two records that should have been one document contained in

one record.

Correcting document boundaries in Concordance is a manual process requiring

several steps. It is important to proceed carefully to ensure that all of the data is

corrected appropriately, so there is no data loss. It is recommended that you back

up the database and imagebase prior to splitting or joining documents.

We recommend working with single-page TIFF files to simplify

adjusting document breaks.  If your images are multi-page TIFF

files, they will need to be reprocessed in order to have the proper

document breaks.

Split Documents in Concordance

1. In the Browse or Table view, open the record that you want to split into

multiple records.

2. Click the Edit button on the Toolbar to open the record in Edit View.

3. On the Edit menu, click Ditto (Edit View).  The Duplicate dialog displays.
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4. Select the fields containing the data you want to duplicate into the split

document.  You can select multiple fields by pressing the SHIFT or CTRL key

while selecting the fields.

5. Select Append new and click OK.

6. A new record is created containing the fields you selected and that record is

opened in Edit View while the Browse or Table view continues to display the

original document.

7. Make the necessary edits to the new record.  For example, the BEGNO, PAGES,

and OCR fields or their equivalents may need to be modified to reflect the

document split.

8. Click Edit to save the changes to the new record.

9. Navigate to the original document, and click Edit to open the original

document in Edit View.

10. Make the necessary edits to the data in the original record to reflect the

document split. 

11. Click Edit to save the changes to the original record.

Checking for Duplicate Records

After importing records, you may want to check for duplicates in Concordance.

Duplicates are identified by comparing the content in selected fields. When

Concordance finds duplicate records, Concordance tags each of the duplicate
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records. Give some forethought to what fields you want to use to check for

duplicates. Before checking for duplicate records, make sure that there are not any

records that were tagged in a previous duplicate check before you start the process

again.

When Concordance checks for duplicate records, Concordance only checks the

records in the current query. If you want Concordance to check for duplicates in the

entire database, be sure to run the Zero Query before checking for duplicates.

The duplication detection categorizes documents in three ways:

· When a record is unique, no tag is assigned to the record

· The first time a duplicate record appears, the Original tag, or its equivalent, is

assigned to the record

· The subsequent times the duplicate record appears, the Duplicate tag, or its

equivalent, is assigned to the records

It is best practice to remove access to Check for Duplicates on the Tools menu

from most users, except your advanced users. 

Check for Duplicate Records

1. Run a search query to locate the records you want to search for duplicate

records.  When Concordance checks for duplicate records, Concordance only

checks the records in the current query. If you want Concordance to check for

duplicates in the entire database, be sure to run the Zero Query before

checking for duplicates.

2. On the Tools menu, click Check for duplicates.  The Duplicate Detection

dialog displays.
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3. In the field list, select fields you want Concordance to identify duplicate

records in the database's current query.  To select multiple fields, use

SHIFT+click or CTRL+click.  You can select as many fields as you want, but

there is a limit of 245 characters that can be compared.  Paragraph fields count

as 60 characters.

4. Enter a tag to apply to the Original (first) record encountered in a duplicate

set, and another tag to apply to the Duplicate (second) record in a duplicate

set.  Make sure the tags you use have not already been applied to records

from a previous duplicate check.

5. If you selected a paragraph field in the field list, it is best practice to select

Only use the first line of each field.

6. Click OK to run the duplicate check.  The Duplicate count updates to show

the number of duplicates found and those records will be tagged with the tags

you specified.

7. Click Done to exit the Duplicate Detection dialog.

8. You can now query the database for the duplicate tags you specified.

Tallying Duplicates

You can also use the Tally feature to help identify duplicate records in the database.

The Tally feature creates an itemized list of data values within a field, including the
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number of occurrences of each data value in the field.  See Searching by Tally for

more information.

Attachments

The Find Attachments command can be used to identify parent and attachment

documents in a database.  For more information, see Options available in the

Search Panel.

Below are a few examples of Parent and Attachment document relationships in

Concordance.  There are many field naming conventions and other possible styles

for Parent and Attachment fields in a Concordance database.

Example 1 - Parent Document with Two Attachments

1st Record

(Parent

Document)

BEGDOC: 

DSC0000001

ENDDOC: 

DSC0000001

BEGATTACH: 

DSC0000001

ENDATTACH: 

DSC0000010
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1st Record

(Parent

Document)

2nd Record

(First

Attachment)

BEGDOC: 

DSC0000002

ENDDOC: 

DSC0000004

BEGATTACH: 

DSC0000001

ENDATTACH: 

DSC0000010

3rd Record

(Second

Attachment)

BEGDOC: 

DSC0000005

ENDDOC: 

DSC00000010



Concordance Classic108

© 2022 CloudNine™. All rights reserved.

1st Record

(Parent

Document)

BEGATTACH: 

DSC0000001

ENDATTACH: 

DSC0000010

Notice that for each record above, the BEGDOC and ENDDOC fields reflect the

Bates number range of the parent document and each attachment document. The

BEGATTACH and ENDATTACH fields reflect the Bates range of the entire document

(parent and all attachments).

Example 2 - Parent Document with One Attachment Using

Attachment Range Field

1st Record

(Parent

Document)

BEGDOC: 

DSC0000001

ENDDOC: 

DSC0000002
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1st Record

(Parent

Document)

ATTACHRANGE: 

DSC0000001-

DSC0000010

2nd Record

(First

Attachment)

BEGDOC: 

DSC0000003

ENDDOC: 

DSC00000010

ATTACHRANGE: 

DSC0000001-

DSC0000010

Example 3 - Doc IDs With a Parent Document and One

Attachment
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1st Record

(Parent

Document)

DOCID: 

DSC00000001

PARENTDOCID: 

DSC0000001

2nd Record

(First

Attachment)

DOCID: 

DSC0000002

PARENTDOCID: 

DSC0000001

In this scenario, the PARENTDOCID field establishes the parent to attachment

relationship for this document. 

Global Replacements

The Global Replace command allows you to search and replace words, phrases,

dates, or carriage returns in specific fields throughout your entire record database.

You can search and replace populated or empty fields, with or without case

sensitivity. Global replacements only work on the current query.
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Global edits are immediately saved and committed to a database.

There is no undo option. We recommend that you always back up

the database before making any global replacements.

Global Replace

1. Back up your database before running the global replacement. 

2. Run a search to located the records that need a global edit.

3. On the Edit menu, click Global Replace.  The Global Replace dialog

displays.
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4. In the Field list, select the fields containing the text you want to replace.  To

select multiple fields, use SHIFT+click or CTRL+click.  Concordance will only

search the fields selected in this list.

5. In Target, type the text you want to replace.

· You can replace empty fields by leaving Target blank.

6. In Replacement, type the text you want to replace the Target text with.

· You can empty a field by leaving Replacement blank.

· Use \n in Target or Replacement to represent a hard carriage return.  If

you actually want to search for the characters \n, type \\n instead.

· To replace dates, the format of the dates entered in Target and

Replacement must match the date format of the selected date field.  Dates

should be zero filled (i.e. for a date with format MMDDYYYY, enter single

digit days or months with leading zeros like 07171960).

7. Enter a Document range (First and Last) if you want to limit the replacement

to specific document numbers from the current query.

8. Under Document range, enter the Last document number from the current

query to search for the Target text.

9. Select Ignore case if you want to replace text without matching upper and

lower case in Target.

10. Select Confirm before replace to be prompted for confirmation for each

replacement.

11. Click OK to proceed with the global replacements.

12. If you selected Confirm before replace, a Text Found dialog displays for

each matching Target.  Select Yes to confirm the replacement.

13. Click Done to close the Global Replace dialog.

Changes are immediately viewable.  In order to run full-text searches on the edited

record, the database must be reindexed. 
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Updating Hyperlinks

Hyperlinks often require updating or replacement if you move database files to

another network directory. Hyperlinks are stored in <database name>-Notes.dcb

for each database.

If you move your native documents or attachments from one drive to another, you

need to globally replace the drive letter in the NOTEATTACHED field of the

<database name>-Notes.dcb. If your attachment includes the full directory file path

in the main database, you also need to replace the drive letter in the FILEPATH field.

Exporting Data

Concordance offers a variety of options for exporting data in order to back up

databases or save data into a format that can be imported into another database.

Data exports are often required when there is a need to share data with third

parties or for document production.

In Concordance you can export:

· As a Concordance database

· To an OPT file for use with Concordance Native Viewer

· To a delimited text file

· To a database structure for creating a database template

· Database transcripts into .PCF or delimited text files

Exporting Database Structures

You can export a copy of the database structure to create a duplicate database or to

create a new database template based off a current database. The structure is

stored in a .dcb file and contains the original field names and their types. Data
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exported from a database can be loaded into another database that has been

exported.

Before exporting a database structure, you can save the structure to a .txt file that

you can print for your reference. The text file contains a list of all the database's

fields and field types. 

 Keep the following in mind when exporting concatenated databases:

· Concordance exports data from all databases within a concatenated set only

when the concatenated databases have identical database structures.

· When exporting from a concatenated set with different database structures,

the contents from the secondary database gets exported only for the fields

that match the primary database. The remaining field contents will not be

exported.

Save a Database Structure to a .txt File

1. In Concordance, open the database with the database structure you want to

save.

2. On the File menu, click Modify.  The Modify dialog displays.

3. Click Save to File.   Navigate to and specify a File name in the Save Field

Definitions dialog.  Click Save.

Export a Database Structure

1. In Concordance, open the database with the database structure you want to

export.

2. On the Documents menu, select Export, and click Structure.  

3. Navigate to and specify a File name in the Copy Structure dialog.  Click

Save.
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Exporting Database Records

When you export a Concordance database, you have the option to export to an

existing database or to create a new database. The export includes every record in

the current query, in the sort order they are listed. By default, all fields, data, and

tags, are also exported, but you also have the option to select only specific fields for

export. 

Security and tag history are not included in the export when you export a database.

You can export a database's security settings from the Security dialog box. 

Before exporting a database, you can store the database's tag history in one of the

database's fields using the TagHistoryAndStoreIt_<version>.cpl.  See Tag CPLs

for more information.

When exporting to an existing database, fields are only copied if

they exist in both databases.

To Export a Concordance Database

1. Run a search query to locate the records you want to include in the export. 

When Concordance exports a database, Concordance can export just the

records in the current query or can export all the records in the database.  If

you want to export all the records, you can run the Zero Query.

2. On the Documents menu, select Export, and click As a Concordance

database.  The Export Wizard - Database dialog displays.

202
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3. Click Browse.  If you are exporting to an existing database, navigate to and

select the .dcb or .fyi file for the database you are exporting to.  If you are

exporting to a new database, navigate to where you want to store the

database, type the new database File name.  Click Open.

4. Click Next.  the Export Wizard - Fields dialog displays.
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5. The database list defaults to the currently open database and all the database's

fields are displayed in the list.  If the database is a concatenated database, you

can select a different database from the concatenated set.

When exporting to an existing database, fields are only exported if

the fields match the fields in the existing database you are

exporting to. 

When exporting concatenated databases, only the data in fields

that are identically named and formatted in the concatenated set

will be exported.

6. Select the fields you want to export from the list.  To select multiple fields, use

SHIFT+click or CTRL+click.

7. Click Next.  The Append/Replace dialog displays.

8. Choose one of the following options:

· Append all records - If you are exporting to a new database, selecting this

option adds all records in the query to the new database.  If you are
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exporting to an existing database, selecting this option appends all records in

the query after the last record in the existing database. 

· Replace matching records and append new records - If you select this

option, the export searches for a matching record.  If a match is found, the

export replaces that record.  If the export does not find a match, the export

appends the record.  

9. Delete and replace existing annotations and tags is only available when

you select the Replace matching records and append new records option.

 To have the export remove all existing tags and annotations for a record in the

existing database when the export finds a matching record, select Delete and

replace existing annotations and tags.  Otherwise if Delete and replace

existing annotations and tags is not selected, the export will ignore existing

tags and annotations. 

10. The Locate matching records by comparing field is used to determine

exact record matches between the two databases. Only key fields are listed. 

This is available if you select Replace matching records and append new

records.  Select the fields you want the export to use to determine record

matches.  To select multiple fields, use SHIFT+click or CTRL+click.  Full-text

paragraph fields are considered a match if the first sixty characters or the first

line, whichever is less, match, regardless of the remaining contents of the

field. 

11. Select Copy attachments with notes to copy a record's attachments with

notes during the export.  If selected, the export automatically creates

sequentially numbered attachment folders in the same directory as the

Concordance database, and copies attachments into the subfolders. Folders

are named in the format ATTACH-000000 and increment by one if the initial

folder exceeds maximum capacity.

12. Click Next.  The Export Wizard - Export dialog displays.
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13. The First and Last fields default to the first and last record in the current

query.  Modify these fields to define the range of documents you want to

export.

14. Click Export.  If you are exporting to a new database, you will get a

confirmation dialog.  Click Yes to create the new database.

15. The Export Wizard automatically closes when the export is complete.

Exporting Delimited Text Files

In Concordance you can export data directly to another Concordance database or

save the records as delimited text files.

The benefit of exporting to delimited text files is that this format is universal and

works in other database management systems. Some forethought in planning the

export of these files includes understanding that there are certain features in

Concordance that have no parallel in other database managers such as Microsoft

SQL Server and Microsoft Access. These features include record tags, issue coding,

annotations, attachments, and hypertext links. Exporting in Concordance delimited

text files does not preserve record mark-ups.

When you export database records to a delimited text file, the export includes every

record in the current query, in the sort order they are listed. If you want to export

the entire database, run the Zero Query.
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When exporting concatenated databases, only the data in fields

that are identically named and formatted in the concatenated set

will be exported.

Export to a Delimited Text File - Wizard

1. Run a search query to locate the records you want to include in the export.  If

you want to export all the records, you can run the Zero Query.

2. On the Documents menu, select Export, and click To a delimited text file. 

The Export dialog displays.

3. Select Export Wizard and click OK.  The Export Wizard - Documents dialog

displays.
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4. Enter the number for the First and Last records that you want to export from

the current query.

5. Click Next.  The Export Wizard - Format dialog displays.
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6. Define the characters you want to specify as the Comma, Quote, and

Newline delimiters in the delimited text file.  If you are exporting within

Concordance, you will not need to change the default values.  Change these

characters only if the characters are used within the text of your documents.

7. Click Next.  The Export Wizard - Date format dialog displays.
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8. Select the date format you want to use in the delimited text file. 

9. Click Next.  The Export Wizard - Fields dialog displays.
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10. By default, all of the database fields are added to the Selected fields list for

the export. To only select some of the fields for the export, click the double

arrow (<<) button to move all the fields to the Available fields list, then

select the individual fields you want to export and use the right arrow (>) to

move them to the Selected fields list.

11. To change the order of the fields in the export, in the Selected fields list, click

the field you want to move and use Up or Down to move the field.  The order

in the Selected fields list will be the order of the fields in the delimited text

file.

12. To display hidden system fields select Show system fields.  System fields are

fields used by Concordance to administer database functions, such as

replication. They are generally not visible, but you can display and export them

if desired.
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13. To include field names in the export, select Export field names.  If selected,

field names are exported as the first record, with each field name taking the

place of its field's data for that record. Exporting field names can help manage

data if the data is imported into another program.

14. Select Export rich text to export Concordance data with rich text.  Full text

paragraph fields in Concordance can contain rich text. Rich text contains font

changes, bullet lists, and other word processor commands that other database

programs cannot handle. You can export with rich text if the data is destined

for another Concordance database. Do not export rich text if the data is

destined for another program. 

15. Click Next.  The Export Wizard - Save dialog displays.

16. Click Browse to navigate to the export file location and provide an export File

name.  Click Save.
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17. Select Export in ANSI format to export the data in ANSI (American National

Standards Institute) format.  You will want to select the Export ANSI check box

if you will be importing the delimited text file into an application that does not

support the Unicode Standard.

When exporting to ANSI or ASCII format, characters that cannot be

represented as a single-byte character will be lost in the export.

18. Click Next.  The Export Wizard - Finish dialog displays.

19. Click Finish.  The Export Wizard automatically closes when the export is

complete.
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Export to a Delimited Text File - Dialog

1. Run a search query to locate the records you want to include in the export.  If

you want to export all the records, you can run the Zero Query.

2. On the Documents menu, select Export, and click To a delimited text file. 

The Export dialog displays.

4. Select Export dialog box and click OK.  The Export Delimited ASCII dialog

displays.
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5. By default, all of the database fields are added to the Selected fields list for

the export. To select specific fields for the export, click Remove all button to

move all the fields to the Available fields list.  In the Available fields list

select the fields you want, and click Select.  The field order in the Selected

fields list will be the field order in the delimited text file. 

6. Select Export field names as first record to include field names in the

export.  Field names are exported as the first record, with each field name

taking the place of its field's data for that record. Exporting field names can

help manage data if the data is imported into another program.

7. To export Concordance data with rich text, select Export rich text.  Full text

paragraph fields in Concordance can contain rich text. Rich text contains font

changes, bullet lists, and other word processor commands that other database

programs cannot handle. You can export with rich text if the data is destined

for another Concordance database. Do not export rich text if the data is

destined for another program. 
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8. To export the data in ANSI (American National Standards Institute) format,

select Export ANSI.  You will want to select the Export ANSI check box if you

will be importing the delimited text file into an application that does not

support the Unicode Standard.

When exporting to ANSI or ASCII format, characters that cannot be

represented as a single-byte character will be lost in the export.

9. Enter the number for the First and Last records that you want to export from

the current query.  

10. Define the characters you want to specify as the Comma, Quote, and

Newline delimiters in the delimited text file.  If you are exporting within

Concordance, you will not need to change the default values.  Change these

characters only if the characters are used within the text of your documents.

11. Select the Date format you want to use in the delimited text file.

12. Click OK.  Navigate to the export file location and provide an export File

name.  Click Open.

13. The Export Delimited ASCII dialog closes automatically when the export

completes.

Exporting Transcripts

Administrators are not typically involved in the general printing of transcripts, but

may be asked to export transcript files from Concordance into another application

such as West LiveNote.

Transcripts can be exported to the West LiveNote standard Portable Case Format

(.pcf) file structure or to a delimited text file. This allows you to export several

transcripts to a single file, keeping annotations, quick marks, notes, and issue codes

intact. Hyperlinks are also transferred, but any external files they link to are not

transferred and must be copied manually.

Transcripts can also be exported to delimited text files. See Exporting Delimited Text

Files .119
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When exporting concatenated databases, only the data in fields

that are identically named and formatted in the concatenated set

will be exported.

Export Transcripts to a .pcf File

1. In Concordance, open the database containing the transcripts you want to

export.

2. Run a search query to locate the transcripts you want to include in the export. 

If you want to export all the records, you can run the Zero Query.

3. On the Documents menu, select Export, and then Database transcripts. 

The Export Transcripts dialog displays.

4. To export only the current transcript, select Export current transcript.

5. To export multiple transcripts, select Export transcripts, then enter the First

transcript and Last transcript numbers to specify the range of transcripts

from the current query to export.

6. Select Export in ANSI format to export the data in ANSI (American National

Standards Institute) format.  You will want to select the Export ANSI check box

if you will be importing the delimited text file into an application that does not

support the Unicode Standard.
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When exporting to ANSI or ASCII format, characters that cannot be

represented as a single-byte character will be lost in the export.

7. Click Export.  Navigate to where you want to save the transcript .pcf file,

provide a File name, and click Save.

8. The Export Transcripts dialog automatically closes when the Export is

complete.

Managing Image Data

Concordance image data is dependent on the viewer that is associated with the

database.  

Both Concordance Viewer and Concordance Native Viewer store information on all

native documents and image files within the Concordance Image Base (.cib) file. 

This is a SQLite database that stores information such as folder path location,

markup history, and preferences settings for Concordance Viewer and

Concordance Native Viewer.

Concordance Image stores image information in two files: the .dir file that stores

image keys, and the .vol file that stores image volume data. 

All image data files, regardless of the viewer used, are stored in the associated

database folder.

As an administrator, several features are available to help manage image data.  Be

sure you know which viewer is configured for the database so you can properly

manage the associated image data.

Image Load File Formatting

For Concordance Viewer, Concordance Native Viewer, and Concordance Image, an

image load file (.opt, .log, .txt) is a delimited ASCII file containing all information

necessary to link database documents with their associated images.  The load file

can be used to load image information after the database is created.  Each line in

the load file consists of seven fields delimited with commas:.
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Fi

el

d

Description

IM

A

GE

KE

Y

or

AL

IA

S

Should match a media (image)

key in the Concordance

database (field with the Image

attribute selected).  This is a

unique key.  Concordance stores

this key in order to reference the

image.  Media keys are case-

sensitive.

V

O

LU

M

E

Name of the volume where the

documents and image reside.

PA

TH

Full path and file name of the

image.

D

O

C

BR

EA

K

Enter a Y if this image marks the

beginning of a document.
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Fi

el

d

Description

F

O

LD

ER

BR

EA

K

Enter a Y if this image marks the

beginning of a folder break.

B

O

X

BR

EA

K

Enter a Y if this image marks the

beginning of a box break.

PA

GE

C

O

U

N

T

Number of pages associated

with the document or image.

Example:  00010067,NROTEK001,C:

\MY_DATABASES\NROTEK001\001\00010067.doc,Y,,,3
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A load file does not necessarily need the volume name, but still

needs the field for volume name to be represented.  Every line in

the load file should have 6 commas.  Example:   0000001,,D:

\VOLO001\001\0000001.tif,Y,,,1

A document or image media key and file path cannot contain a

comma (,) since the comma as a delimiter in the load file.

Media keys should not contain more than 1000 characters.

Image Base Management

For Concordance Viewer and Concordance Native Viewer, Image Base

Management tools are provided to allow you to:

· Rename/delete media paths and folders

· Rename/delete media keys (aliases)

· Load additional OPT files into an existing Concordance imagebase

· Export the imagebase database to an OPT file

· Calculate document page count

If Image Base Management is not available from the

File>Administration menu, then you have not been given access

privileges.  If you need access, please contact your Concordance

Administrator.

As a best practice, make sure that all users are logged out of the

database prior to using the Image Base Management tools.
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Please see Concordance Image  for corresponding information about managing

image data for Concordance Image.

Recreating a CIB

In some circumstances you may need to delete and recreate an existing

Concordance Image Base (.cib).  For example, if you need to reimport all of your

image information.  This requires that you delete the existing .cib file prior to

reimporting the image information. 

147
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When you delete a Concordance Image Base (.cib), all markup

history is lost.  Make sure that you create a backup of your CIB file

before deleting it.  

After registering your media, if you receive an error message stating that

Concordance Viewer or Concordance Native Viewer is unable to open the

corresponding document, you need to edit your folder paths. The folder path listed

in the message box is the path stored in the Concordance imagebase pointing to

where your files are located so the viewer can open and display the document. You

need to change the path to the directory location where your documents actually

reside.

Use caution when resetting folder paths as there is no undo

function and changes are permanent.  You should backup up the

.cib file before performing this process or other imagebase

management tasks.

Rename Media Paths and Folders

1. On the File menu, select Administration, and then click Image Base

Management.  The Image Base Management dialog displays.

2. Click Rename Media Paths and Folders.  The Rename Media Paths and

Folders dialog displays.
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3. The current file paths display in the Root Paths list.  To update one of the

current file paths:

· Select the path to update in the Root Paths list.  The path now displays in

the Target field.

· Click Select Folder, then browse to the new folder location and click OK. 

The newly selected folder displays in the Replace with field.

· Click Replace.  A Confirmation dialog displays.  If the new path does not

exist, it will display in red text.  Click Confirm to finalize the path update.

4. Click OK to close the Rename Media Paths and Folders dialog.

Your load file alias should match the media (image) key information in the

corresponding Concordance database.  Concordance stores this key in order to

reference the image for viewing with Concordance Viewer or Concordance Native

Viewer.

You can use the Image Base Management feature to make changes to the media

(image) aliases as needed.
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Make sure that when you rename or delete any media keys, you

rename or delete the media key in the Concordance database.

Unicode characters are not supported for media (image) key field

names.

To Edit Media Keys

1. On the File menu, select Administration, and then click Image Base

Management.  The Image Base Management dialog displays.

2. Click Rename or Delete Media Keys.  The Rename or Delete Media Keys

dialog displays.

3. The current list of media keys displays on the left.  To update one of the media

keys:

· Select the media key from the list.  The Old alias and New alias update

with that media key information.

· Enter the updated media key in the New alias field.
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· Click Save Alias.

4. Click OK to close the Rename or Delete Media Keys dialog.

Delete Media Keys

1. On the File menu, select Administration, and then click Image Base

Management.  The Image Base Management dialog displays.

2. Click Rename or Delete Media Keys.  The Rename or Delete Media Keys

dialog displays.

3. The current list of media keys displays on the left.  To delete one of the media

keys:

· Select the media key from the list.  The Old alias and New alias update

with that media key information.

· Click Delete.  A confirmation message displays.  Select Yes to confirm

deleting the media key.

4. Click OK to close the Rename or Delete Media Keys dialog.

The Concordance Image Base (.cib) file for Concordance Viewer and Concordance

Native Viewer links native documents and images with their corresponding records

in Concordance.   An .opt file is used to import the document and image

information into the .cib file. Once a .cib file is created for a Concordance database,

you can view the referenced documents and images in Concordance Viewer or

Concordance Native Viewer.  

If you have an existing .cib file and receive additional files for the database, you can

use the Image Base Management tools in Concordance to load the new files and

.opt file to the .cib without affecting the current records or any markup that have

been applied.

The .opt file can contain both documents and images that are either single-page or

multiple-page files and each file must contain a unique ID (media key).  Before

loading an .opt file, make sure to review the file to verify that it provides an image
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alias (media key), volume, file name and path, and page break.  If your document

and image files and image load file was provided by a vendor on removable media,

the path information will likely need to be changed.

If a vendor provides documents and images, but not the corresponding load file

(.opt, .log, .txt), you can still load your document and images into Concordance and

then use Documents>Export>Concordance Native Viewer command to create an

OPT file to use with Concordance Native Viewer.  This option is not available for

Concordance Viewer.

When importing a multi-page image file, make sure that the file is

formatted as a .tif file (.tif formatted files are the only image type

file that recognizes document breaks).  All other image formatted

files (.jpg, .bmp, .gif, etc.) can only be imported as a single-page

single image file.  

The viewer can only associate one image file with a record, so you

cannot use multiple single-page image files to represent a multi-

page image.

Load Additional .opt Files

1. On the File menu, select Administration, and then click Image Base

Management.  The Image Base Management dialog displays.

2. Make sure the .cib you want to load to is displayed in the Path field, otherwise

Browse to the correct .cib file and select it.  

3. Click Load/Update OPT to CIB.

4. Navigate to the location of the load file (.opt, .log, or .txt) and select it.  Click

Open.

5. A progress dialog displays.  If no errors occur, the dialog closes automatically.

6. Click OK to close the Image Base Management dialog.
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Successfully loaded OPT files are renamed to

filename.Imported_opt in the directory folder where the .opt file

was loaded.

We recommend that you take some time to experiment with

loading an image file and practice edits or repairs to it so you

become adept at identifying and fixing any corruption yourself. 

Most technical support calls for this phase of administration are

due to an incorrect file path.

Use caution when overlaying images paths as there is no undo

function and changes are permanent.  We recommend backing up

the database files before performing this process or other

imagebase management tasks.

File paths, folders and imagekeys are case-sensitive.  Make sure the

new image path and filename case match to ensure that the paths

are replaced.

The imagekey values in your load file must match the values in the

imagekey field in the database.

Overlay an .opt File (Concordance Viewer)

There may be circumstances where you need to replace existing images with new

images.  For example, if you originally loaded placeholder images when the

database was created.  

1. On the File menu, select Administration, and then click Image Base

Management.  The Image Base Management dialog displays.
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2. Make sure the .cib you want to load to is displayed in the Path field, otherwise

Browse to the correct .cib file and select it.  

3. Click Overlay OPT to CIB.

4. Navigate to the location of the load file (.opt, .log, or .txt) and select it.  Click

Open.

5. A progress dialog displays.  If no errors occur, the dialog closes automatically.

6. Click OK to close the Image Base Management dialog.

Overlay an .opt File (Concordance Native Viewer)

There may be circumstances where you need to replace existing images with new

images.  For example, if you originally loaded placeholder images when the

database was created.  

1. On the File menu, select Administration, and then click Image Base

Management.  The Image Base Management dialog displays.

2. Make sure the .cib you want to load to is displayed in the Path field, otherwise

Browse to the correct .cib file and select it.  

3. Click Overlay OPT to CIB.

4. A dialog displays to confirm overlay.  All existing markups, including

redactions, will not be transferred to replacement images.  Click Yes to

continue.

5. If any errors occur, a log file will be saved in the Logs folder in the location

where the database is saved.

To make a backup of your Concordance Image Base you can export the database's

.cib file to an .opt formatted file.  The .opt file is a text file that contains the contents

of the imagebase at the time of the export.  
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If you plan to export the imagebase database more than once,

make sure that you delete or rename the existing .opt file(s) prior

to exporting since existing files will not be overwritten.  The

exported .opt file does not include markup history. 

Exported OPT files associated with a Concordance Native Viewer

imagebase do not contain page count information.  Therefore, if

you are loading an exported OPT file into Concordance Image, you

must reset the document breaks in Concordance Image for the

images to load properly.

Export .cib to .opt

1. On the File menu, select Administration, and then click Image Base

Management.  The Image Base Management dialog displays.

2. Click Export CIB to OPT Format.  The Export CIB to OPT Format dialog

displays.
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3. Click Add.  Navigate to and select the .cib file you want to export.  Click Open.

 The selected .cib file displays in the CIB Files to Export list.

4. Click Browse next to Output Folder.  Locate the folder where you want the

exported .opt file and click OK.

5. Click Export.  The data is exported.

6. Click OK to close the Export CIB to OPT Format dialog.

7. Click OK to close the Image Base Management dialog.

You can export multiple .cib files at once by adding them to the CIB Files to Export

list before selecting Export.  All exported files will be written to the Output Folder.

The Create Page Count command can be executed to establish an accurate page

count for viewing and printing documents and images.  This command calculates

the total number of pages for each record and the total number of pages within the

entire image base.  

Anytime additional documents or images are added to the image base, the Update

Page Count command should be run to ensure the page count is kept current for

reviewers.  

Create Page Count

1. On the File menu, select Administration, and then click Image Base

Management.  The Image Base Management dialog displays.

2. Make sure the .cib you want to use is displayed in the Path field, otherwise

Browse to the correct .cib file and select it.  

3. Click Create Page Count.

4. A confirmation dialog displays.  Click Yes to continue.

5. A progress dialog displays.  Once the page count is complete, click Close.
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6. Click OK to close the Image Base Management dialog.

Update Page Count

1. On the File menu, select Administration, and then click Image Base

Management.  The Image Base Management dialog displays.

2. Make sure the .cib you want to use is displayed in the Path field, otherwise

Browse to the correct .cib file and select it.  

3. Click  Update Page Count.

4. A progress dialog displays.  Once the page count is updated, click Close.

5. Click OK to close the Image Base Management dialog.

Concordance Viewer

Imported eDocs and eMails are automatically converted to near-native PDF files for

viewing with Concordance Viewer. For load file imports, the extensions in the OPT

file are scanned. Filetypes in the OPT that are not supported in Concordance 

Viewer will be converted to PDF and stored with the database files in the

NearNatives folder for display in the viewer. If there are filetypes in the OPT that

are not supported by the viewer and cannot be converted to PDF, the user will see

an image placeholder in the viewer with the text "Image key not found".

Concordance Native Viewer

For the discovery process, it is common practice to pre-process documents, by

converting them to image files for review.  However, it is often more desirable to

review certain documents in their native format.  Concordance Native Viewer

provides access to both native files and images within one application, thus

speeding up the review process.  
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Concordance Native Viewer opens a near native view of the document including

images, layout and more.  The near native view can be reviewed, redacted, and

marked-up for production.

When importing native documents into Concordance for viewing in Concordance

Native Viewer, it’s best to create a new database.  The database must contain a

valid media (image) key and file path field.  The media (image) key field is used to

link the Concordance database with Concordance Native Viewer.  The filepath field

stores the path to the native document. 

1. In Concordance, create the database you want to use with Concordance Native

Viewer. For more information see Creating a Database.

2. Import the data into the database. 

3. Verify that each record has a unique identifier in the field that you marked as

the media (image) key field and the filepath field displays the path to the

native document.

4. From the Documents menu, click Export, and then click Concordance

Native Viewer.

5. In the Export to Concordance Native Viewer, select the database field

where the file path is stored.  Note the output file path.  This is where the .opt

file will be exported for importing in Concordance Native Viewer.

Each time you perform an export, a unique OPT filename is

generated with the date and time the file is created

(<database>_YYYYMMDD_hhmmssfff) .

6. When finished, click the Camera button to view the documents and images in

Concordance Native Viewer.
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Concordance Image

Image files are the original record scanned into a file format that is viewable in

Concordance Image. Typically, the vendor who processed your documents supplies

you with a corresponding image load file along with your images. If you do not

receive this file, you can still load your images. However, having the image load file

is recommended.

Image files can be paper documents that are scanned, or e-mail or native

documents that are also processed. Your images can be single-page or multiple-

page files and are usually named with your image alias. We recommend using

single-page TIF files because the images load faster for review and are easier to

work with if you need to adjust document breaks.

Your corresponding image load file provides an image alias or key, volume, path

with file name, document break, folder break, box break, and page count. These

files are usually in .opt, .log, or .txt file formats.  The volume, folder break and box

breaks are optional and may be blank, but the .opt file itself must consist of seven

comma-delimited fields.  Document break, folder break, and box breaks are

indicated by the letter "Y".

Since your image files and image load file are typically provided by a vendor on

removable media, the path information listed could be written in the D:\ drive and

will need to be changed. You can provide the vendor with a specified directory path

in advance if you already have a designated location for your images. If not, you

can change the directory information yourself.

How to Change a Directory File Path for Images

· Directly within the image load file (recommended)

· In Concordance Image after loading the file information

Both directory file path changes are made with a simple search and replace. Once

you have moved your images from the CD or DVD to the server, this directory is

what you want to place in the image load file or in Concordance Image. You can

edit the file path before or after the import process.
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What a Concordance Image Record Profile

Includes

· Up to 16,770,266 images per document

· Up to 536,870,912 volumes

· Can open .tif, .jpeg, .bmp, .gif, etc.  Concordance Image cannot open PDF files.

· Image key: Value in the image field, if it matches the file name

· Image alias: Value in image field, when different than image file name

· Combined length of the image key, plus the file name and path must not

exceed 1001 characters

Concordance Image Guidelines

· TIF and OCR text files can be stored in the same folder

· All TIF files from the same document do not have to be in same volume

· If you do not have a Concordance database with document breaks, you will

need to use a load file with document breaks, or set them manually in

Concordance Image

Imagebase Component Files

Fi

le

Description

.di

r

Imagebase that stores image

keys (aliases)
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Fi

le

Description

.v

ol

Tracks volumes, must be in

same directory location and

saved with the same name as

the .dcb file

Da

ta

ba

se

-

Re

dli

ne

s.d

cb

Stores all marks made on

images including type, location,

color, and user

.lo

g

Exported image load file from

existing imagebase

1. From the Windows Start menu, open Concordance Image. 

We recommend launching Concordance Image from the Start

menu only when you are first registering images. During normal

image record review from Concordance, simply click the View

image (camera) button on the Dynamic toolbar in Concordance.
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2. In Concordance Image, on the Tools menu, click Imagebase Management.

3. Browse to and select the database .dir file you want to load, then click  Open. 

The Imagebase Management dialog displays.

Make sure that you select the correct .dir file located in the

same directory as your database.  If not, you will be modifying

the imagebase for a different database.

4. Select the Register - Load tab.

5. Click Browse.  Navigate to and Open the .opt file you want to load.

6. Click the Load button.

9. In the Status field, verify that the image files transferred into the database, and

then click OK.

10. In Concordance, open a record to view your image files.
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If imagebase .dir and .vol files are accidentally deleted, you need to

reload the imagebase in Concordance and relink it to its

corresponding database.

We recommend that you take some time to experiment with

loading an image file and practice edits or repairs to it so you

become adept at identifying and fixing any corruption yourself.

Most technical support calls for this phase of administration are

due to an incorrect file path.

Tips and Tricks for Loading Image Files

If your image files aren’t importing properly, check the following:

· Locate and replace volume paths on the Directory tab.

· Customize the path prefixes on the Path tab.

· Verify the file name and path information in the image load file.

· Edit the .vol file in List File Management dialog box to remove unwanted

entries. Or, export a .log file and edit in text format.

· Use UNC paths when on a network for inconsistent drive mappings.

· Verify that all documents in the current query link to an image, and verify that

every image exists. Records with missing links in the imagebase are tagged

and tracked in a .log file.

· Have the image re-processed if the TIF file is corrupt or is an incompatible

format.

· Rotate images using Adobe Photoshop®, Microsoft Office Document Imaging,

or Irfanview.
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A common Concordance Technical Support call is due to the file

path in the image load files being incorrect. Be certain to verify this

information. You can search and replace the path to the correct

directory where your image resides.

Before loading a data volume, verify that the Bates Number for the

first record to be loaded does not overlap with the last bates

number used in the existing collection. If it does, you should

request a correction from the source prior to loading.

If you do not have a corresponding image load file, you may want to register an

imagebase by scanning images from a disk or directory source. Once the images

are registered, you want to make sure that you create aliases and set the document

breaks prior to document review.

Use the Register - Scan tab in the Imagebase Management dialog in

Concordance Image to scan directories and register applicable image files in the

database. Registering an imagebase by scanning the images from disk is the

easiest way of creating an imagebase. 

All file names must be unique no matter where they are located. In

other words, you cannot register images from two different folders

with the same file structure and file names even if the images are

different. In order to create an imagebase from this scenario, you

must create a .log file and use unique aliases to distinguish

between images with similar file names.

If the image represents the first image in a set of images, the exact

value, 00001, must be the value in the image key field for your

Concordance database for Concordance Image to find the image

path and name in an imagebase.  To eliminate any confusion, an
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alias is also matched with information that is used to synchronize

Concordance and Concordance Image. Run the Create Alias from

Filename CPL. The images link automatically based on the Image

field. Key and image fields are defined on the New or Modify dialog

box. 

To Scan Images

1. In Concordance Image, on the Tools menu, click Imagebase Management.

2. Navigate to and Open the database's .dir file.

3. The Imagebase Management dialog displays.

4. Click the Register - Scan tab.



Concordance Classic154

© 2022 CloudNine™. All rights reserved.

5. Click Browse, navigate to the folder containing the files you want to scan, and

click Open.

6. The Image mask field defaults to *.TIF. Only the image files matching the file

type entered in the Image mask field will be registered in the imagebase. 

Update Image mask to include the files you want to scan.  You can use *.* to

include all image files from the folder.

7. If desired, in the Document mask field, type the applicable document mask. 

Any image matching the Document mask will be marked as a document

break.

8. To use a folder mask, in the Folder mask field, type the applicable folder

mask.  Any image matching the Folder mask will be marked as a folder break.

If you are using a Document mask or Folder mask, make sure

that the image also qualifies as an image based on the Image

mask.
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9. Select Scan subdirectories if you want to include files in folders underneath

the one selected in Scan path.

10. Selecting Create aliases will automatically generate aliases for images in your

imagebase during the scan based on the field designated as the image field.

11. Click Scan to initiate the register scan.  When complete, the dialog displays the

total number of files registered for each scanned subdirectory.

You may find that you receive image files containing records that do not have

preset document breaks or breaks that are not placed correctly or need to be

changed. If so, you can set or change them in Concordance Image.

Concordance Image assumes that data is stored at a document level in each

database, and marks the image specified in the image field as the document break.

If the image field information is incorrect, you need to reset the document breaks.

The Imagebase Management dialog allows you to set document breaks in the

imagebase based on the current Concordance query.

The Document Breaks tab in the Imagebase Management dialog

will not be active if you do not have an active Concordance

database link to the imagebase.

Setting Document Breaks

1. In Concordance Image, on the Tools menu, click Imagebase Management.

2. Navigate to and Open the database's .dir file.

3. The Imagebase Management dialog displays.
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4. Click the Document Breaks tab.
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5. To reset all all document breaks before creating new document breaks, select

Reset all document breaks before proceeding.  Any image marked as a

document prior to processing is no longer flagged as a document break.

6. To clear all page counts before creating new document breaks, select Clear all

page counts before proceeding. Any image having a page count prior to

processing will no longer have one. The page count value will be reset to 0.

7. Click Set to reset all document breaks.

Splitting Document Images in Concordance Image

1. In Concordance, run a query to isolate the records that need to be adjusted.

2. On the Dynamic toolbar, click View image (camera) to open the

corresponding images in Concordance Image.

3. In Concordance Image, on the Tools menu, click Imagebase Management.

4. Navigate to and Open the database's .dir file.
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5. The Imagebase Management dialog displays.

6. Click the Document Breaks tab.

7. To reset all all document breaks for the documents in the current query, select

Reset all document breaks before proceeding.  Concordance Image

checks to see if the image alias values match the values of the Concordance

field in the Image field. If the image alias and Concordance fields values match,

Concordance Image sets the document break at the image alias value. If the

values do not match, Concordance Image will not create a document break at

the image alias value.

8. To reset all page counts for the documents in the current query, select Clear

all page counts before proceeding.  Concordance Image clears the existing

page counts and resets the page counts based on the new document breaks.

9. Click Set to adjust document breaks for documents in the current query.

10. Click OK to close the Imagebase Management dialog.

11. Close and reopen Concordance Image to view the adjusted document breaks.

Document breaks in Concordance Image can be changed manually

for each individual image on the Edit tab in the Imagebase

Management dialog.

Administrators can review a database's .vol imagebase file that is used with

Concordance Image.

To View a Database's .Vol File

1. In Concordance, on the Tools menu, click Manage List Files.  The List File

Management dialog displays.

2. On the Lists tab, click the Open button.

3. Navigate to and open the database .vol file you want to review.
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4. Click the Edit tab to view the contents of the .vol file.

5. When you finish reviewing the .vol file, click Done to close the List File

Management dialog. 

The imagebase may need to be deleted for various reasons. If you need to reimport

all of your image information, you will need to delete the existing imagebase first. 

If you need to remove unwanted entries from the imagebase, export the imagebase

to a log file, remove the unwanted entries from the log file, delete the imagebase's

.dir and .vol files, and then reimport the updated log file into Concordance Image.

To Delete an Imagebase

1. Close Concordance and Concordance Image.

2. Locate the imagebase's .dir  and .vol files.

3. Rename or delete the imagebase's .dir and .vol files.  Renaming the .dir and

.vol files creates a backup of the imagebase, in case you need to restore the

imagebase later.

4. Create a new imagebase for the database:

a. In Concordance, on the Dynamic toolbar click View image (camera).

b. Clicking View image generates the imagebase for the database. Creating

an imagebase creates the database's .dir, .vol, and redlines .dcb file.

5. The first time you click View image, Concordance Image launches with an

error message displayed - "Couldn't find xxx in the imagebase".  Click OK to

close the message.

6. Re-scan and register the images associated with the database. For more

information about scanning and registering images, see Scanning Images .152
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Concordance Image enables you to export the entire imagebase to an image log

file. The image .log file is a text file that contains the contents of the imagebase at

the time of the export. If you export and imagebase multiple times, you have the

option to overwrite the existing log file, create a new .log file, or add the imagebase

contents from the latest export to the end of the existing .log file. 

Export an Imagebase to an Image Log File

1. In Concordance Image, open the imagebase you want to export.  You can open

an imagebase in Concordance Image by clicking the View image (camera)

button in Concordance if the database associated with the imagebase is

currently open in Concordance, or in Concordance Image, on the File menu

click Open image, click OK to close the message, navigate to and open the

imagebase's .dir file. 

2. On the Tools menu, click Export imagebase to log file.  The Export

Imagebase dialog displays.  The Imagebase field defaults to the directory and

imagebase name of the current imagebase.

3. To export a different imagebase, click the Browse button to open the Select

Imagebase dialog box, locate and open the imagebase .dir file.  The Log file

field defaults to the same directory and has the file name for the new image

log file.

4. To store the image log file in a different directory, click the Browse button to

open the Select log file dialog box, navigate to where you want to store the

.log file, type the file name in the File name field, and click Save.  The first

time your export an imagebase the drop-down list in the Log file field is

unavailable. Once an image .log file has been created, if you export the

imagebase again, the drop-down list is available. You have the option of

selecting one of the following options:

· Overwrite/create new file: Click Overwrite/create new file to overwrite the

existing log file or if you modified the log file name in the Log file field and

want to create a new log file. 

· Append to file: Click Append to file to add the exported contents of the

imagebase to the end of the existing log file. 
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5. Click the Export button to create the image .log file.  The log file is created in

the directory displayed in the Log file field.

6. Click the Done button to close the Export Imagebase dialog box.

After registering your images, if you receive an error message stating that

Concordance is unable to open an image, you need to edit the directory path. The

directory path listed in the message box is where Concordance Image is looking for

your image files so it can open and launch the image. You need to change the path

to the directory location where your images actually reside.

You can fix the imagebase directory path in three ways:

· Modify the directory in the image load file

· Modify the directory in Concordance Image

· Map images on drives

Modify the Directory in the Image Load File

1. Navigate to and open the database's image load .log file in any text editor

program. 

2. Find the portion of the file path that needs to be modified.
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3. Use the text editor's search and replace feature to update the file path(s) to the

correct location.

4. Save the edited load file with a new filename.  This will retain the original

image load file in case you need it. 

Modify the Directory in Concordance Image

If you moved your database files, you need to reset the directory path where your

images are now stored. To do so, you need to update the directory path on the

Directory tab in the Imagebase Management dialog.

Use caution when resetting directory paths as there is no undo

function and changes are permanent. We recommend backing up

the .dir and .vol files before performing this process or other

imagebase management tasks.

1. In Concordance Image, on the Tools menu, select Imagebase Management.

2. Navigate to and Open the database's .dir file.  The Imagebase Management

dialog displays.

3. Click the Directory tab.
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i. The current image directory paths are listed at the top of the Directory

tab. The Edit section of the tab is used to edit individual image directory

paths, and the Search and replace section is used to globally search and

replace directory path information throughout the imagebase.

4. To edit an individual directory path, select the applicable directory in the

directory list and then edit the Volume and/or Directory fields.  Click Save.

5. To run a global Search and replace, in the Target field type the directory text

you want to search for and in the Replacement field type the new directory

text.  Click Replace.

When using Search and replace

If you use Search and replace be careful how to specify the paths.

 If you want to only replace the drive letter you need to include the

proper punctuation.  For example, type "C:\" instead of just "C" in
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the Target field.  Otherwise you would replace every instance of

the letter C with the Replacement text.

6. When you are finished making the applicable directory path changes, click OK

to close the Imagebase Management dialog.

Map Images on Drives

If want you register your images without specifying a drive letter or UNC prefix,

you can do so on the Path tab in the Imagebase Management dialog. You can

specify a prefix to all image paths for the current imagebase. Settings and

specifications entered on the Path tab globally affect the imagebase, and

Concordance assumes that all images are stored in the same location.

1. In Concordance Image, on the Tools menu, select Imagebase Management.

2. Navigate to and Open the database's .dir file.  The Imagebase Management

dialog displays.

3. Click the Path tab.
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4. In Apply settings to, select which user you want to apply the image path

settings. You can apply the settings to all the database users by selecting <All

users>, or you can apply the settings to an individual user by selecting their

user ID in the Apply settings to field. 

5. In Specify a prefix for all image paths in the current imagebase, type the

drive letter you want to use for all image paths in the imagebase.

· You can register an imagebase in Concordance Image without specifying a

drive letter or UNC prefix. This gives you the flexibility to access the images

from different workstations with different drive mappings. For example,

you can register the following image on a CD:  \IMAGES\CASE01\01\01.TIF

· Let’s say user1 maps his CD-ROM drive to D: and user2 maps his CD-ROM

drive to E:. User1 can set his prefix as D: and user2 can set his prefix to E:.

There is no need to register one imagebase for each user. The same can

apply to users on a network that have different drive mappings to servers.

In fact, one user can map to the images using a UNC mapping while

another can map to the images using a drive letter.
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6. To register images on a CD jukebox, select Insert volume name label before

path.

· If you do not want to register images on a CD jukebox, clear the Insert

volume name label before path check box.

· Adding a drive letter and selecting the Insert volume name label before

path check box along with a path prefix, allows you to register images on a

CD jukebox. Multiple users with different drive mappings (or UNC

mappings) to the jukebox can use the same imagebase. With most CD

jukeboxes, the CD volume name is placed in front of the root level

directory of the CD. For example, you can register the following image on a

CD with volume label, CD001:  \IMAGES\CASE01\01\01.TIF

· Let’s say a user maps the jukebox to drive J:. Selecting the Insert volume

name label before path option maps the image to the following path:  J:

\CD001\IMAGES\CASE01\01\01.TIF

7. Click OK to save your changes and close the Imagebase Management

dialog.

Redlines databases are functional databases that track the coordinates for every

redline applied to an image in the imagebase, and store the color and marking

codes in a field also noting when it was created. You can view and modify redlines

globally to change redaction text, highlight colors, and notes.

It’s also a good idea to add an AUDITTRAIL field to the redlines database to track

who created or modified redlines, and when. Add this field prior to reviewers

annotating or redacting images, and be sure to validate this field in the Data Entry

Attributes dialog box.  See Data Fields for more information about database fields.

As an administrator, you may need to locate and remove a white highlight from a

document or globally replace redaction text. Finding a white highlight in

Concordance Image can be difficult. Using the Redlines database allows you to

search on specific markings and change them directly in the database, which are

then reflected on the image. Use the Redlines Highlight Color table below to locate

the highlights in your image file. 

You can also change the color of other redlines in the redlines database. To locate

the color code for a redline, apply a redline in a specific color to a record in
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Concordance Image and search the [database name]-Redlines.dcb for the record

that contains that color marking. The number associated with the color is displayed

in the Color field in the redlines database.

Redlines Highlight Color
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0 Covering text

Image Key Trick – Image keys are merely Bates numbers for

documents that appear in text. Highlight a Bates number in the

Browse view in Concordance, right-click the highlighted Bates

number, and click View Image to launch the document in

Concordance Image.

Edit an Individual Record in a Redlines Database

1. In Concordance, open the redlines database you want to edit.  Redlines

databases use the following file naming convention: <database>-Redlines.dcb.

2. To edit the redlines for an individual record in the database, navigate to the

record you want to edit.

3. On the Standard toolbar, click Edit to open the Edit view and activate edit

mode for the record.
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4. Locate the fields you want to edit.  Some fields may be gray because you don’t

have permission to edit these fields.

5. Make your redline edits.  Concordance automatically saves your edits as soon

as you navigate to another record or change your view in Concordance.

6. Changes are immediately viewable. However, in order to run full-text searches

on the edits in the record, the database needs to be reindexed. Once this action

is performed all reviewers can search the updates.  To reindex the database, on

the File menu, click Reindex.

7. If Concordance Image is open while you are editing a record in the redlines

database, to refresh the image you are viewing to include the edits you made

to the record in the redlines database, in Concordance Image, navigate to the

next record then return to the original record to view the redline edits.

Make a Global Edit in a Redlines Database

Global edits are immediately saved and committed to a database.

There is no undo option. You should back up the database before

making any global replacements.

1. Back up your database before running the global replacement.  See Backup

and Archive  for more information.

2. In Concordance, open the redlines database you want to edit.  Redlines

databases use the following file naming convention: <database>-Redlines.dcb.

3. Run a search query to locate the records that need a global edit.

4. On the Edit menu, click Global Replace.  The Global Replace dialog displays.

62
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5. In the Field list, select the fields containing the text you want to replace.

During a global replacement, Concordance only searches the fields currently

selected in the Field list.

6. In Target, type the text you want to replace.

7. In Replacement, type the text you want to add to the field.  If you are

modifying a redlines color throughout the database, type the number

associated with the redlines color in the Target and/or Replacements field to

modify the color.

8. In First, type the first document in the current query to search for the global

replacement.

9. In Last, type the last document in the current query to search for the global

replacement.
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10. To ignore upper and lower case lettering during global replacements, select

Ignore case.

11. To request confirmation before replacing text, select Confirm before replace.

12. Click OK to make the global replacements.  If Confirm before replace is

selected, each time Concordance locates the text in the Target field during the

global replacement, Concordance displays the found text in the Text Found

dialog and requests confirmation before completing the replacement.

13. Once the global replacement process finishes, in the Status section,

Documents displays the number of documents searched, and Replacements

displays the number of replacements made. The field below the Field list and

Status section, displays the replaced text.

14. Click Done button to close the Global Replace dialog.

15. Changes are immediately viewable. However, in order to run full-text searches

for the edits in the records, the database needs to be reindexed. Once this

action is performed all reviewers can search the updates.   To reindex the

database, on the File menu, click Reindex.

16. If Concordance Image is open while you are running a global replacement in

the redlines database, to refresh the image you are viewing to include any

edits made to the record in the redlines database, in Concordance Image,

navigate to the next record then return to the original record to view the

redline edits.

If you receive TIFF images without a load file, you have some options on how to

prepare the images for review.

If the images relate to an existing Concordance database, they can be loaded into

the database's imagebase in Concordance Image on the Register - Scan tab in the

Imagebase Management dialog.  For more information about adding images to

an imagebase, see Scanning images .

When you receive TIFF images without a load file and there is no database

associated with the images, the most efficient solution is to contact the delivering

party and ask them to send a load file for the images. If this is not possible, you can

create a simple load file and simple Concordance database to link to the images.
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The process described below is designed for use with single-page

TIFF files with unique names and a .TIF extension.

Create a Text File Containing the Image File Names

There are several good software utility programs that can be used to create a text

file containing file names in a specific folder. Consider TreeSize and CopyPath.

Refer to the software documentation or help system for instructions.

On a Microsoft Windows operating system, DOS commands can be used. This is

often described as porting a file list.

1. Copy the images from the delivery media, such as a CD or thumb drive, to a

folder on the computer network.  

2. On the Start menu, click Run to open the Run dialog box.

3. In the Open field, type cmd and click OK.  A command prompt window

displays.

4. In the command prompt window, type the drive letter where the .tif images

are currently stored followed by a colon and press Enter.

5. Type cd [directory path to the folder containing the .TIF images] and

press Enter.  The command prompt directory now reflects the folder where

your images reside.
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6. Type dir *.TIF/s>[image text file name].txt and press Enter.  After pressing

Enter, the .txt file is created in the same directory as the .tif images you

entered. The .txt file contains a list of the TIFF file names from the directory you

entered. You need to repeat this procedure for each image volume you have.

7. When you are done creating the text files, type exit and press Enter to close

the command prompt.

Create a Data Load File for the Images

After creating the text files for your image files, you need to create a data load file

for the images.

1. In Windows Explorer, browse to the .txt file you created for the images.
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2. Open the .txt file using a text editor program.

3. Highlight only the image file names in the .txt file and copy all the file names. 

Do not include the .tif file extension when you are copying the image file

names. If you are using TextPad or UltraEdit, the easiest way to copy only the

file names is to use the block selection feature in the editor. For example, in

TextPad, on the Configure menu, click Block Select Mode to turn on the

block selection feature.

4. Open a new file in the text editor and save the new file as a .dat file.  The .dat

file will be the data load file for the images.

5. In the .dat file, paste the image file names.

6. If you have more than one image volume and created multiple .txt files for the

images, open the other .txt files, copy  the image file names, and paste these

image file names into the .dat file as well. 

7. Add a carriage return at the end of the last record in the image list.  

Concordance will not load the last record if the carriage return at the end of

the record is missing.

8. Save the .dat file.

Create a Database

After creating a data load file for the images, you need to create a simple database.

The instructions for creating a database in this topic only include the steps

necessary for creating a very simple database that can be used for importing a data

load file created for images. For detailed information about creating a Concordance

database, see Creating a Database.

1. In Concordance, on the File menu, click New.  The General tab in the Create

database from template dialog displays.
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2. Select the Blank template and click OK.

3. Navigate to the directory for the database, type the File name of the database,

and click Open.  The New dialog displays.

4. Click the New button to add an image field to the database.
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5. In the Name field, type the name of the image field.

6. In the Type field, select Text.

7. In the Length field, type a field length number long enough to include all the

characters in your image file names.

8. Select the Image check box. 

· An image field is used to link Concordance with an image viewer, such as

Concordance Image or Opticon. The Image check box only needs to be

selected for one of the database's fields. It is best practice to select the

Image check box for the BEGNO field or it's equivalent. 

· If you are using Concordance Image as your image viewer, all you have to

do to launch Concordance Image and link your imagebase files with your

database records is open the database in Concordance and click  View

image (camera) in Concordance. 

· If you are using an image viewer that is not Concordance Image or

Opticon, you will need to configure the image view for Concordance on

the Viewer tab in Preferences dialog box. See Viewer Preferences for more

information. 

· Regardless of the image viewer you use, when you view a document

associated with an image in Concordance, the corresponding image is

displayed in the selected viewer. 

9. Create any additional field you want to add to the database.  For more

information, see Data Fields.

10. Click OK to save your database.

If you accidentally click the OK button or press Enter while entering

fields in the New dialog box, you will close the dialog box. To

reopen it, on the File menu, click Modify. Click the New button to

add a new field to your database.



Concordance 177

© 2022 CloudNine™. All rights reserved.

Clicking OK saves the data entered in the dialog box and saves the

database. When you reopen the New dialog box in the database,

the dialog box name is changed to the Modify dialog box. 

Import the Data Load File Into the Database

Now that you have created the data load file and database for the images, you are

ready to import the data load file into the database.

1. With the database you created open in Concordance, on the Documents

menu, select Import, and click Delimited Text.  The Import dialog displays.

2. Select Update current database and Import dialog box, then click OK.  The

Import Delimited Text dialog displays.

3. The image field you created is displayed in the Selected fields list.  Comma,

Quote, and Newline default to the default delimiters for Concordance.  The

Date format defaults to yyyymmdd, and by default, Ignore first line is not

selected.

4. Click the Go button to open the Load delimited file dialog.

5. Navigate to and open the .dat file you created for the images.

6. The .dat file is imported into the database.  When the .dat file is imported, the

number of documents that successfully loaded is displayed in the Documents

loaded field. Verify that the number of documents matches the number of

image file names in the .dat file. The Status field also displays the number of

documents loaded into the database.

6. Click the Done button to close the Import Delimited Text dialog box.

Scan the Images Into the Imagebase
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After the data load file is imported into the database, you need to create the

imagebase and scan the images into the imagebase.   See Scanning Images  for

more information.

1. In Concordance, click View image (camera) on the Dynamic toolbar.

2. Clicking the View image button generates the imagebase for the database.

Creating an imagebase creates the database's dir, .vol, and redlines .dcb file. 

The first time you click the View image button, Concordance Image launches

with an error message displayed.

3. Click OK to close the message.

4. See Scanning Images  for details on how to scan the images using the

Register - Scan tab on the Imagebase Management dialog.

Managing Tags

Typically a Concordance Administrator or Litigation Support Manager works with a

lead attorney to build a set of tags for case review that include standard naming

conventions that adhere to internal guidelines for a case review. These tags are

often organized into folder structures that indicate phases of review, case topics, or

are designated by reviewer. Once tagging conventions are determined, the

administrator will likely set up these tags and folders after the database is built so

the review team can be begin searching and tagging immediately.

Both reviewers and administrators are able to create and apply tags to documents,

but administrators have the ability to do this in multiple ways so they can track and

manage tagging activity for the database.

If you are working with a team of administrators, we recommend

that only one or two people be in charge of tag management,

especially when making new ones and deleting unnecessary tags.

This prevents duplication of efforts and helps tag trees remain

uncluttered for all reviewers working in the database.

Managing tags includes the following activities:
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· Creating and applying tags to documents and queries

· Removing, renaming, and deleting tags and folders

· Importing and Exporting tags

· Querying tags and folders

· Tracking tag activity in the Tags task pane and .TRK file

· Backing up the tag file

Here are a few important things to remember about Tags:

· Tags and tag folders do not support Unicode characters.  Only ASCII (values

032-126) characters are allowed. If a tag name or tag folder name contain an

invalid character, you are prompted to rename the tag or tag folder.

· For a tag folder to exist in Concordance, it must have at least one tag created

in it. If you move all the tags out of a folder, the folder will be deleted.

· There is no known maximum limit on the number of tags you can create and

apply in Concordance.

· To create a folder for administrative tags, prefix the name so that it displays at

the end of the tag/folder tree and does not distract reviewers (ex. zAdmin).

· When creating tags and folders, the combined folder and tag string cannot

exceed 199 characters. 

Tag and Issue Management

Using the Tag and Issue Management dialog box, you can add/remove, reorganize,

and rename tags and tag folders in the current database.  Concordance verifies that

only one named tag or folder is present within the same hierarchy.  If tag or folder

with the same name already exists, Concordance prompts you to rename the tag or

folder.  Concordance then automatically updates all records with the new tag name.
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Administrators usually create and manage the tags available to all users in the

database on the Add/Delete tab in the Tag and Issue Management dialog box. 

Before renaming a tag or tag folder, it is best practice to run the

TagHistoryandStoreIt_<version>.cpl to capture a current query of

all tag history before transferring documents to a new tag.

The Manage Tags/Issues dialog box does not allow non-ASCII

characters for tag or tag folder names.  You can add non-ASCII

character tag and tag folder names using CPLs or INI files.

Create Tags and/or Tag Folders
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1. On the Tools menu, click Manage Tags/Issues.  The Tag and Issue

Management dialog displays, on the Add/Delete/Rename tab.

2. To create a tag folder, click the arrow next to the Add button and select

Folder.  Enter the new folder name next to the new folder.

3. To create a tag, click the arrow next to the Add button and select Tag.  Enter

the new tag name next to the new tag.

4. To create a tag inside a folder, select the folder, then click the arrow next to the

Add button and select Tag.  Enter the new tag name next to the new tag.

5. Once you are done creating tags and/or folders, click Done to close the Tag

and Issue Management dialog.  The new tags and/or folders will display in

the Tags Panel of the Navigation Pane.

Delete Tags and/or Tag Folders

Selected tags and issues can be deleted from the database. This permanently

removes them from the database and cannot be undone. Folders are automatically

deleted after all of the tags and issues in the folder are deleted. You cannot

manually delete a folder.

Tags added to the database using the .ini file need to be removed

from the .ini file first, and then deleted from the Add/Delete tab.

Tags not removed from the .ini file remain in the database even

after deleting them from the Add/Delete tab.

1. On the Tools menu, click Manage Tags/Issues.  The Tag and Issue

Management dialog displays, on the Add/Delete/Rename tab.

2. Select the tag you want to delete, then click Delete.

3. A confirmation dialog displays.  Click Yes to confirm deletion.

4. When finished, click Done to close the Tag and Issue Management dialog. 

The deleted tags are removed from the database.
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Rename Tags and Tag Folders

It is recommended to run the TagHistoryandStoreIt_<version>.cpl to capture the

current tag history before renaming tags.  See Tag CPLs  for more information.

1. On the Tools menu, click Manage Tags/Issues.  The Tag and Issue

Management dialog displays, on the Add/Delete/Rename tab.

2. Select the tag you want to rename, then click Rename.

3. Enter the updated tag name.

4. When finished, click Done to close the Tag and Issue Management dialog. 

The applicable records are updated with the renamed tag name.

Reorganizing Tags and Tag Folders

1. On the Tools menu, click Manage Tags/Issues.  The Tag and Issue

Management dialog displays, on the Add/Delete/Rename tab.

2. Do any of the following:

· To move a single tag from one folder to another folder, select the tag and drag

to the new folder.

· To move multiple tags, hold CTRL while selecting the tags to move, and then

drag the tags to the new folder.

· To move a folder and all the tags in the folder, click the folder and drag to the

new location.

· To move multiple folders, hold CTRL while selecting multiple folders to move,

and then drag the folders to the new location.
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As an administrator, you may find that searching for a batch of documents first and

then applying a tag to the query is more efficient than tagging individual records

one at a time. This tactic may be useful if you are pre-categorizing tagged

documents into folders for the review team or gathering documents for witness

kits.

Apply Tags to Queried Documents

1. Run a search for the documents you want to locate and tag.

2. On the Tools menu, click Manage Tags/Issues.  The Tag and Issue

Management dialog displays, on the Add/Delete/Rename tab.

3. Click the Tag Query tab.

4. Select the tag you want to apply to the documents in the query you ran in step

1.  Hold CTRL when selecting multiple tags.
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5. Click Apply to Query.  The number of tags applied displays in the bottom

right corner of the dialog.

6. Click Done to close the Tag and Issue Management dialog.

The Field To Tag feature copies the unique values from a selected field and uses

those values to create tags in the Tags pane.

Creating Tags From Data Within a Specified Field

1. On the Tools menu, click Manage Tags/Issues.  The Tag and Issue

Management dialog displays, on the Add/Delete/Rename tab.

2. Click the Field To Tag tab.
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3. In the Select Field list, select the field whose values you want to convert to

tags.

When selecting a field to create a tag from, ensure that you select a

field that is listed before your OCR numbered fields. 

4. From the Select Delimiter list, select the delimiter to use to separate the tags

in the field.  Choose a separator that does not appear within the selected field

data.

5. Optionally you can click the Prescan button to scan the data in the specified

field for unsupported characters, tag name size (limited to 199 characters), and

delimiter issues.  Any resulting errors are displayed in the Prescan dialog. 

Close the Prescan dialog after verifying any errors.

6. Click the Start button.  The field values are processed and a new tag added for

each field value.  The Start button updates to Complete.

7. Click Done to exit the Tag and Issue Management dialog.  The Tags Panel of

the Navigation pane displays and shows you the newly added tags.
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The Tag To Field feature writes applied tag names to a specified field in the

database, separated by a specified delimiter.

Creating a Field with Tag Names

1. On the Tools menu, click Manage Tags/Issues.  The Tag and Issue

Management dialog displays, on the Add/Delete/Rename tab.

2. Click the Tag To Field tab.

3. In the Select Field list, select the field to use for saving the tag names.

4. From the Select Delimiter list, select the delimiter to use to separate the tags

in the field.

5. Click the Start button.  The tags are processed and any records with tags

applied are updated to add the applied tag names to the specified field.
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6. Click Done to exit the Tag and Issue Management dialog.  If a record has

one or more tags applied, the tag(s) will now be written to the field you

specified.

You can Import Tags from a text file, or Export Tags to a text file, allowing you to

quickly copy tag structures between databases without having to create them

manually.  

Tags and tag folders do not support Unicode characters or high-

end ASCII characters.  Only ASCII (values 032-126) characters are

allowed. If a tag name or tag folder name contains an invalid

character, you are prompted to make corrections.

When creating a tag file for importing, each line represents a tag, with an

associated folder if applicable.  Separate tags from their associated folder with >>.
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To Import Tags From a Text File

1. Create a text file containing the tags and/or folders to import.

2. On the Tools menu, click Manage Tags/Issues.  The Tag and Issue

Management dialog displays, on the Add/Delete/Rename tab.

3. Click the Import Tags tab.

4. Click  Browse, navigate to and select your text file containing the tags to

import, then click Open.

5. Optionally you can click Prescan to validate your input file.  Click Done on the

Tag Import Prescan dialog after validating any errors.

8. Click Import.  The tags are imported.

9. Click Done.  The newly imported tags now appear in the Tags Panel of the

Navigation Pane. 
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Issue tags cannot be exported unless the tag is applied to a

Concordance record.

To Export Tags to a Text File

1. On the Tools menu, click Manage Tags/Issues.  The Tag and Issue

Management dialog displays, on the Add/Delete/Rename tab.

2. Click the Export Tags tab.

3. Click Browse, navigate to and specify a file name for the tags text file, then

click Save.

4. Click Export.
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5. Click Done.  The specified file now contains all current tag names, with folders.

 Only public folders and tags are exported, no personal folders and tags.

TRK File

Concordance stores tag and tag history information in the .trk file.  You can review

the .trk file at a given time to review all tags currently set in the database.   The .trk

file includes three sections:

· Index Section - These records begin with a hash mark (#).  These records

show how many tags a document has applied to it. For example, if there are 10

documents in a database with three tags applied to each document, then there

would be 30 records in this section.

· Tag List - These records begin with a dollar sign ($).  One record exists for

each unique tag name in the database.  If there were three tags in the

database, there would be three records in the tag list.

· Tag History - These records begin with a plus or minus sign (+ or -).  These

records identify added and deleted tags.

In the .TRK file, personal folders and the tags in the folder are

preceded by the » character and the user's Windows login or

security user ID. 

To Review the .Trk File
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1. On the Tools menu, click Manage List Files.  The List File Management

dialog displays.

2. Click Open, navigate to and select the database's .trk file.  Click Open.

3. Browse to and click the database's .trk file, and click Open.

4. Select the Edit tab.  The .trk file information is displayed.records in the

database's .trk file are listed on the Edit tab.

5. Review the displayed information.

6. Click Done to close the List File Management dialog.

Add a Tag to a .trk File

In addition to creating tags in the Tags task pane or using the Tag and Issue

Management dialog, you can write tags directly into the .trk file. This is useful if you

want to transfer many tags from one database to another.
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1. On the Tools menu, click Manage List Files.  The List File Management

dialog displays.

2. Click Open, navigate to and select the database's .trk file.  Click Open.

3. Browse to and click the database's .trk file, and click Open.

4. Select the Edit tab.

5. In the Edit section on the right:

· Enter in a new tag name beginning with the dollar sign ($) in the Key field.

 You can include a folder name by preceding tag name with the folder

name and >>.

· For new keys, type a zero for Data value.

6.  Click Add.  The new tag is added to the .trk file.

7. Click Done to close the List File Management dialog.

8. If the Tags Panel was already open in the Navigation Pane, you will need to

close and reopen it to re-read the .trk file.  Your newly added tag displays.
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Export Tags From a .trk File

1. On the Tools menu, click Manage List Files.  The List File Management

dialog displays.

2. Click Open, navigate to and select the database's .trk file.  Click Open.

3. Browse to and click the database's .trk file, and click Open.

4. Select the Import/Export tab.

5. Select Export.

6. If you want to include data values with the key values, select Include data

values.  You must also specify a delimiter to separate the key value from the

data value.  Data is exported with the key first, followed by a delimiter, and

then the numeric data value.  Be careful exporting data values if you are

planning on importing this data into another database.
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7. In the Range section select which .trk entries you want to export - either All

entries or Range.

8. Click Export.

9. Browse to a file location and specify the file name for the exported tag data. 

Click Save.

10. Click Done to close the List File Management dialog.

11. Using a text editor, open the tag data file you just created.  All tag entries are in

the .txt file beginning with a dollar sign ($).  If you want to use the file for

importing in another database, edit the file and remove all records that don't

begin with a dollar sign ($).

Import Tags From Another Database

1. On the Tools menu, click Manage List Files.  The List File Management

dialog displays.

2. Click Open, navigate to and select the database's .trk file.  Click Open.

3. Browse to and click the database's .trk file, and click Open.

4. Select the Import/Export tab.

5. Select Import.
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6. If your import file includes data values with the key values, select Include

data values.  You must also specify a delimiter to separate the key value from

the data value.  Data is imported with the key first, followed by a delimiter, and

then the numeric data value.  Be careful importing data values.

7. Click Import.

8. Navigate to and select the text file with tag data that you want to import.  Click

Open.

9. Click Done to close the List File Management dialog.

10. If the Tags Panel was already open in the Navigation Pane, you will need to

close and reopen it to re-read the .trk file.  Your newly added tag displays.

In Concordance, database administrators can either scan or scan and repair the .trk

file. The TRK Maintenance Tool scans all tags in the currently open database and

can also be used to clean up SQLite table entries in the .trk file (e.g., broken links or

orphaned entries). 
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Each time the TRK Maintenance Tool runs the scan only or repair/scan option, it

generates a .csv file report that is saved in the database directory. The TRK

Maintenance Tool report includes the following information:

· Full path and name of the .trk file

· Number of errors found

· Number of orphaned tags

· The name of each orphan tag in the file and the number of documents

containing each tag

· Number of missing tag links

· Total number of tags

· The name of each tag in the file and the number of documents containing each

tag

· Total number of documents tagged

The TRK Maintenance Tool, like indexing, is an exclusive Concordance process that

requires all users, except the database administrator, to be logged out of the

database when the process runs.

The TRK Maintenance Tool is designed to run on individual

Concordance databases. The tool does not run on concatenated

database sets.

Scan the .TRK File

1. On the File menu, select Administration, and click TRK Maintenance Tool. 

If prompted, enter your Administrator user name and password.  The TRK

Maintenance Tool dialog displays.
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2. Click the Scan button.  The .trk file is scanned and a scan complete dialog

displays.  Click Done to close the message.

3. The TRK Maintenance Tool dialog updates to show the TRK Report file that

was generated and also displays the date and time for the last scan, along with

the number of errors found.

4. Click View Report to open the scan report in Excel.

5. Click Done to close the TRK Maintenance Tool dialog.

The TRK Maintenance Tool scan report is stored in the database directory with the

following naming convention: <database name>_<scan date>_<scan time>.csv.

Repair the TRK File

1. Follow the process above To Scan the .TRK File.

2. Click the Repair/Scan button.  

3. You are required to create a backup of the .trk file before repairing it.  The

Save TRK Backup dialog displays and shows a default .trk backup file name. 

You can update the name if necessary.  Click Save to create the .trk file backup.

4. The repair runs and a scan complete message displays.  Click Done to close

the message.

5. Click Done to close the TRK Maintenance Tool dialog.
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It is recommended that you make regular backup files of your tags. An exported

copy of a database does not retain tag history. Utilizing Windows Services, the

Backup and Restore Tag Utility backs up a single database or directory of databases

and provides tools to restore any damaged or lost files to an earlier point in time. 

The Backup and Restore Tag Utility searches the specified directory and when

changes are made to a database's .trk file, the utility backs up the file at the

scheduled backup interval, and saves it to the specified directory.  Email notification

can be set up to alert you when a .trk file is identified as damaged or the storage

capacity of the backup file location has been reached. The backup files are located

in the same location as the associated database. 

Multiple backup services can be configured for different directories where

Concordance databases are stored.  A log file is created for each directory with the

backup information, including when a backup was skipped because the previous

backup took too long.  The log file is stored in the Concordance 10 Logs folder in

the Program data path.

Keep the following in mind when scheduling the .trk backup:

· Schedule the Backup and Restore Tag Utility to run when all databases are

closed to ensure the process is not interrupted.

· The utility does not create a backup for the Notes.trk or the Redlines.trk.

· A backup will not be created if the directory path, including the .trk filename,

exceeds 251 characters.

Make sure that you have administrator-level permissions for the

computer you want to run the Backup and Restore Tag Utility.  For

more information, see Windows Help and Support.

When scheduling the backup of large .trk files that may require

more than an hour to run, make sure you allow enough time

between backups to ensure one process completes before the next

one begins.
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To Setup a Tag Backup Schedule

1. From the Tools menu, select Backup and Restore Tag Utility.

2. To setup a backup folder:

· Click the Add button.

· In the Configure Backup Root Directory dialog, click Browse.

· In the Select Folder dialog box, navigate to the directory or folder that

contains the database(s) you want to backup tags, and then click OK.

· The path for the directory or folder is displayed as the Backup Root

Directory.  The path for the directory or folder should not exceed 251

characters in length.

· From the Frequency list, select how ofter to run the backup utility.
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· In the Start Time box, specify the start time for the backup utility.

· In the Maximum # of backup files per DB field, type the maximum

number of backup files to store in the folder for the database. 

· When the backup folder reaches the maximum limit, the oldest backup file

is replaced with the latest version.

· When finished, click Apply.

3. To setup email notifications:

· In the Notification section, select Send Notification when TRK file

stops responding to receive an email for non-functioning .trk files.

· Select Send backup summary email after each run to receive an email

outlining the latest backup processes.

· Click the Configure button.

· In SMTP Server, type the e-mail server to send e-mail notifications.

· In SMTP Server Port, type the port number to use for outgoing mail

transport.

· In Username, type the name you want to appear as the author of the e-

mail.

· In Email Address, type the email address for the author.

· In Recipient, type the email address for the individual who will receive the

email notification.

· To verify the email address is valid, click the Test button.  If the email is

valid, a message displays stating the test was successful and the recipient

will receive a test email.

· When finished, click Apply.

4. When finished, click Enable Tag Backups.
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5. In the Backup Service Login dialog either select Local Service Account to

run the service locally, or select This Account to specify a Username and

Password to use for the backup service.  Click OK.

6. Click OK to close the Backup and Restore Tag Utility.

View the Backup Summary Report

1. From the Tools menu, click Backup and Restore Tag Utility.

2. Click Last Backup Summary.  The Backup Summary Report dialog displays.

 You can Print the report if needed.

3. Click OK to close the Last Backup Summary.

4. Click OK to close the Backup and Restore Tag Utility.

Change a Tag Backup Schedule

1. From the Tools menu, click Backup and Restore Tag Utility.

2. In the Backup Root Directory section, select the folder path you want to

modify.

3. Click the Modify button.

4. In the Configure Backup Folder dialog, make any necessary changes, and

then click Apply.

5. To make changes to the email notification, click the Configure button, make

any necessary changes, and then click Apply.

6. When finished, click Enable Tag Backup.

7. When finished, click OK to exit the utility.

Delete a Scheduled Backup Folder

1. From the Tools menu, click Backup and Restore Tag Utility.
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2. In the Backup Root Directory section, select the folder path you want to

remove.

3. Click the Delete button.

4. When prompted, click Yes to confirm the deletion.

5. When finished, click OK to exit the utility.

Restore a Damaged .trk File

1. From the Tools menu, click Backup and Restore Tag Utility.

2. Click the Restore tab.

3. In the Damaged TRK file(s) section, select the .trk file to restore.

4. From the Restore Tags From list, select the date and time to use for restoring

the .trk file.

5. Click the Restore button.

Tag CPLs

Running the TagHistoryAndStoreIt CPL

The TagHistoryAndStoreIt_<version>.cpl allows you to take the information from

the Tag history panel in the Tags task pane and place it into a field for the purpose

of searching, backups or storing historical information.

Storing a database's tag history can help you track tagging issues, such as a user

accidentally bulk un-tagging a group of documents. The information captured by

the TagHistoryAndStoreIt_<version>.cpl allows you to run relational searches on

specific tags, users, and the date that an event occurred.

Tag history will also need to be stored when using the Export as a Concordance

Database feature because the export includes a database's current tagging

information,  but does not include the tag history.
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By default, the CPL places all of the tag history for a query of documents into the

TAGINFO field. If you want to store the tag history in different field in your

database, you need to replace the TAGINFO field name with the other field name in

the TagHistoryAndStoreIt_<version>.cpl file before running the CPL.

If your database has an existing field named TAGINFO, then you do not need to

modify the CPL before running the CPL.

To Change the Tag History Field in the CPL

1. Open the TagHistoryAndStoreIt_<version>.cpl using a text editor.

2. Search and replace all references to the TAGINFO field with the name of the

field you want to use to store your tag history. If you have an existing field

named TAGINFO, then you will not need to modify the cpl.

3. Save your changes and close the TagHistoryAndStoreIt_<version>.cpl file.
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To Store Tag History

1. In Concordance, on the Standard toolbar, click the All button to query all

records in your database.

2. On the File menu, click Begin program.

3. Navigate to the CPL directory installed with Concordance, and click the

TagHistoryAndStoreIt_<version>.cpl file.  The default directory CPLs

installed with Concordance is C:\ProgramData\CloudNine\Concordance

10\CPL.

4. Click Open.  The CPL automatically extracts your tag history from each

database record and adds the tag history to the TAGINFO field, or its

equivalent, for each record. 

5. Open the Browse view and locate the field where you placed the tag history.

The field  now lists the tags that were added to and removed from the record,

when the tags were added or removed, and by whom. 

Running the TagSaver CPL

You can create a backup file of your tags or restore the backed up tags into another

database using the TagSaver_<version>.cpl. We recommend running this CPL

script once or twice daily, depending on how much active reviewing is occurring.
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The tag back-up is stored in a database's .gat file and the tag data is retrievable,

when needed.

TagSaver CPL benefits:

· You can move tag application information to different databases

· You can restore backup files (.gat) to other databases to move tag structure

When restoring tags from a .gat file, the maximum number of

characters allowed in a tag name is 199.

To Back Up Tags in a Database

1. In Concordance, click the All button on the Standard toolbar to query all

records in your database.

2. On the File menu, click Begin program.

3. Navigate to the CPL directory installed with Concordance, and click the

TagSaver_<version>.cpl file.  The default directory for CPLs installed with

Concordance is C:ProgramData\CloudNine\Concordance 10\CPL.

4. Click Open to open the Tag Saver Options list.

5. Click Save tags or press Enter.  Clicking Save tags or pressing Enter opens the

field list. Use the arrow keys on your keyboard to scroll through the field list.

6. Click or press Enter on the field you want to associate with the tags.  You need

a common field with a unique value, such as the Begno (Bates number) field.

Do not use the Access ID field when exporting tag history.
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7. After you select the field, the CPL creates the <database name>.gat file in the

same directory as the database's .dcb file.  This is your tag backup.

8. The Tag Saver Options list displays.  Click Quit to return to Concordance.

The database's .gat file is not automatically updated when you add or modify tags

in the database. It is best practice to run the TagSaver_<version>.cpl periodically to

ensure your tag backup is current.

To Restore Tags From a .GAT File to a Database

1. Copy the .GAT file containing the tags you want to add to your database, and

paste the file into the database directory for the database you want to add the

tags.

2. Rename the .GAT file you copied to the database directory using the same

name as the database's .dcb file.  For example if the database's .dcb file is

Cowco.dcb, the .gat file needs to be named Cowco.gat.

3. In Concordance, open the database you want to add the tags.

4. On the Standard toolbar, click the All button to query all records in your

database.

5. On the File menu, click Begin program.
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6. Navigate to the CPL directory installed with Concordance, and click the

TagSaver_<version>.cpl file.  The default directory for CPLs installed with

Concordance is C:ProgramData\CloudNine\Concordance 10\CPL.

7. Click Open to open the Tag Saver Options list.

8. Click Retrieve tags.  The CPL adds the tags for all the records that were

tagged in the .gat file to the database.

9. The Tag Saver Options list displays.  Click Quit to return to Concordance.

10. Open the Tags task pane to verify the tags were added and applied correctly

to the database.

Writing Tags in the INI File

One method of creating a permanent tag structure is to write tags directly into an

.ini file.  A database's .ini file stores various database configuration settings. Tags

created in this file cannot be deleted in the Tag and Issue Management box.

When tags are created in Concordance or in the .trk file, the tags are not

automatically written to the .ini file. To add tags to the .ini file, you need to manually

write them into the file. Once tags are written in the .ini file they are available in the

Tags Panel in the Navigation Pane.  Once a tag is applied, the tags are automatically

written to the .trk file.

Once you have written tags to an .ini file, you can save time creating tags for

another database by copying and pasting the entries from one database .ini file to

another.

If you are renaming tag or tag folder names in the .ini file, the Tags

Panel in the Navigation Pane displays both the original and

renamed tags.  Renaming tags does not affect *.ini file tags.

Write Tags in the .ini File

1. Navigate to the database's .ini file.  The .ini file is stored in the same directory

as the database .dcb file.
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2. Open the .ini file in any text editor program.

3. In the .ini file, the different database configuration settings are designated by

the [] symbols around the configuration category. For example, field groups

are listed under [FieldGroups], and added menu items are listed under

[AddedMenuItems].  Tags are added after the [Tags] category, and each tag

has a separate line in the .ini file. 

3. If the .ini files does not have a tags list, type [Tags] in a new line to create the

tags list.

4. Add the tags below the [Tags] line using the following format:

· To add a tag outside of a folder, type: Tag<#>=Tag_Name

· To add a tag within a folder, type: Tag<#>=Folder_Name»Tag_Name

· To add a personal folder and tag, type:

Tag<#>=»UserID»Personal_Folder_Name»Tag_Name

· Use underscore characters to indicate spaces in a tag or folder name.  

5. Save and close the modified .ini file.

6. Open the database in Concordance.

7. Open the Tags Panel in the Navigation Pane to verify that the tags and folders

you added are displayed. 

Productions

Once a document collection review is completed, documents typically need to be

produced to opposing parties, this is known as a production. Database

administrators prepare the electronic production, based on queries or tagged sets

of documents that are identified for production during the review phase. 

Concordance provides two production options:

· Standard Production - produces a set of TIF or PDF files, .opt and a .dat load

file.
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· Native File Production - copies original native files out to a production

destination directory and the files can be renamed with the production

numbers. No redactions or other production type operations happen, simply a

copy and rename.

It is recommended that a production run, executed from

Concordance, be performed on a machine that is not currently

running any other applications.  This is due to the integration of a

3rd-party tool with Concordance that currently switches the input

focus while the production process is running.

Before running a production, make sure that all users are logged

out of the database.

Managing Rolling Productions

Due to the ever-increasing size of electronic productions, litigation support staff are

often faced with the task of handling and tracking large volumes of data that are

incoming and outgoing during the life cycle of an e-discovery project. As a best

practice, we recommend establishing an organized tracking method to ensure that

all data is properly handled and nothing is missed.

Here are some examples of data that can be handled during a large e-discovery: 

· Data coming from clients that needs to be processed. This could include paper

documents, electronic files, e-mail files, images, metadata load files,

transcripts, graphics, and audio/video files.

· Data being produced from opposing parties to be loaded into a review tool,

such as Concordance, for review by attorneys, paralegals, experts or

investigators.

· Data going out to vendors for processing, scanning, coding, or printing.

· Data to be processed in-house using an e-discovery processing software, such

as CloudNine™ LAW.
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· Data such as exhibits, graphics, and presentations being prepared for trial to

be loaded into trial presentation software.

· Transcripts and audio/video files from court reporters to be loaded into a

transcript database for review and analysis.

· Data being copied or produced to other parties for review such as co-counsel

and experts.

· Data being produced to opposing parties.

· Data that is to be archived from the network to disk or hard drive storage.

· Data that requires special handling, such as compliance with destruction or

preservation orders.

When handling forensically collected data, be sure to follow

appropriate legal procedures for preservation, handling, and chain

of custody to avoid spoliation issues.

Tracking Data

There are many ways that data can be tracked using database software tools

specifically designed to help facilitate data tracking for e-discovery, such as

Concordance, Microsoft Access, or Microsoft Excel.

Sources of data such as external hard drives are typically labeled using some sort

of uniform numbering system so that it is possible to track all incoming and

outgoing volumes. Production volumes are also usually numbered in a series for

record-keeping purposes. It is also important to keep track of production Bates

number series to avoid accidental production of documents with overlapping Bates

numbers.

Archiving Data

Establishing a uniform system for archiving data that must be preserved, but is no

longer being actively used is also important. Maintaining a uniform archival
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tracking system makes it easier to locate data in the event that it must be recovered

from storage and uploaded to the network at a later date.

We also recommend that you become familiar with your organization's backup,

retrieval, and data retention policies so that you are prepared in the event that you

need to recover data on short notice.

Production Elements

Numbering Documents

As part of the production process, a new set of files are generated for documents

that need to be produced. A Bates number series is then applied to all pages of all

documents included in the production, with the option of burning or fusing the

numbers to the image during the process. This number series usually differs from

the internal document collection. You can then track what has actually been

produced and your Bates number series for the production is sequential with no

gaps in numbering.

Fusing Annotations

Redactions or other markups or redlines can be burned or fused to the images

during production so that they cannot be altered. Confidentiality headers or footers

can also be fused to the images during production. Production numbers are usually

cross-referenced to those in the original review collection.

If the Concordance administrator included fields for production numbers in your

database, these numbers are then written to the production number fields during

the production process. Later when you look at your internal document collection,

you are able to see the production number for any documents that were produced.

For multiple or rolling productions, tags or sequentially numbered production

fields are tracked for which production series a document was produced under. For

example, fields named PRODBEG1/PRODEND1, PRODBEG2, PRODEND2, etc.
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Production Output

The output generated by a production run in Concordance is a set of TIF images or

PDF files and a load file. The output generated by an electronic production in

Concordance Image is a set of images and an image load file. Both the production

set and the load file are typically burned onto removable media (or for very large

collections, an external hard drive). Output volumes are labeled to track the

production series.

Native Files

For native productions, the set of documents to be produced is typically converted

to image or PDF files prior to production. Organizations need to adhere to proper

forensic procedures for handling native files. 

Non-Production Documents

Non-production documents and images from Concordance may also need to be

shared with outside counsel, experts, clients, or other parties. Concordance Image’s

production tool is used to generate a non-production set of images and load files

for this distribution.  

For shared document reviews, you can use Concordance FYI and FYI Reviewer from

CloudNine.

Generating Load Files and Images

The output from a production is a set of images and an image load file. The output

generated depends on production requirements agreed upon with opposing

counsel. A best practice is to know in advance what the recipient needs for output

format. The database administrator can collaborate with someone from opposing

counsel’s technology department to determine their exact needs.

Production load files enable recipients to import images into their own viewer

software. Images and load files are generated for either single or multi-page TIFF

format. Load files for data are generated during the export process.
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Administrators can also export specific fields of data and OCR from Concordance to

include with the production. OCR text files are generated using a Concordance CPL

(script).

Concordance export processes work well with most of the review tools on the

market, or Concordance data can be converted to something that will work. Native

review productions are usually handled a bit differently than non-native

productions, since native productions do not have image files for the documents.

Productions and Concatenated Databases

· When running productions on a set of concatenated databases, all the

databases in concatenated set must have identical database structures and

have matching Media (Image) key field names across the concatenated set.

· Native file productions will only be performed on the primary database when

differing database structures (any one of the field names is different between

the primary and secondary databases or any additional fields exist in any one

of the databases) are included a concatenated set.

· Productions for differing database structures should be run separately for

each database.

· Productions should be run on a stand-alone machine without any other

applications running.

Production Training

Anyone tasked with preparing productions should receive Concordance

Administration training before attempting to produce documents from a live

database. The litigation industry guidelines regarding how discovery documents

are handled, processed, and shared between parties is a sensitive matter.

If you or anyone on your IT or Litigation Support Team are interested in learning

more about productions, Concordance certification courses or register for the

Concordance Administration Fundamentals and the Certified Concordance

Software Administrator courses, please contact our Client Training Administrator

for additional information at training@cloudnine.com.

mailto:training@cloudnine.com
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Preparing Productions

Concordance provides the tools you need to permanently fuse headers, footers,

and annotations onto the new .tif or .pdf files. This ensures that your files are

branded properly and that opposing counsel and any internal review staff do not

receive original copies or view privileged content.

There are several steps involved in the overall Production process:

1. Generate new production numbers and cross-reference them back to the

Concordance database.

2. Create new files.

3. Burn in redactions and other selected annotations.

4. Create CD/DVD productions.

5. Create subsets of imagebases.

6. Create load files.

Each time you produce a batch of records, a new set of production files are created.

This ensures that original records are never changed, and that there is always a

backup copy of document changes.

When creating productions, close any other database tabs so

Concordance does not synchronize with a different database

incorrectly. We recommend having no more than three tabs or

databases open during this process.

When exporting a concatenated set for productions, you can only

export fields from one selected database structure.

Production Checklist

Refer to this checklist to ensure all steps are completed before running a

production.
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File

Numbering

Have you

determined a file

numbering and

naming

convention for

your images?

Have you

created fields in

your database to

store your new

production

numbers?

Delivery 

Media

Do you have the

proper

production

request file

formats and

media delivery

types from

opposing

counsel or other

third parties?
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File

Numbering

Tagging

Have you

reviewed

documents

categorized for

production for

possible tagging

inconsistencies

by reviewers?

Did you run the

Tag To Field

command on

production

documents to

capture tag

activity at the

time of

production? Tag

names can be

placed into a

field called

PRODTAGS1.

Back-ups

and File



Concordance 217

© 2022 CloudNine™. All rights reserved.

File

Numbering

Storage

Did you save a

backup copy of

your media files

before

production?

Did you back up

your imagebase

files?

Did you a create

subdirectory

folder for your

new files?

Final

Review

Have you

reviewed the

[database

name]-

Redlines.dcb
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File

Numbering

database for all

markings and

make global

edits on

redaction text

and highlight

colors, as

needed?

(Concordance

Image only)

Standard Production

A standard Production run involves these main steps:

1. Locate the documents to produce.  

· Open the database containing the documents you want to produce.  

· Run a search query to locate the documents you want to produce.

· Create a tag specific to this production (i.e. PROD1), and apply the tag to

the documents to be produced.

2. Mark up documents for production

· Verify that proper annotations have been applied to the records you want

to include in the production.  This includes:

o Redactions to indicate and/or cover confidential or privileged

information.

o White redaction to hide internal control numbers, vendor branding,

and other information not needed in the production.
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3. Capture tag activity

· Run the Tag To Field  Command to capture the tags that were applied to

each record before creating the production.

4. Run the production.  The process for running the production is determined by

the viewer associated with your database:

· Run a production for Concordance Viewer

· Run a production for Concordance Native Viewer

· Run a production for Concordance Image

5. Verify the production output

6. Create a production database

Do not open the Admin Console while running a Production.

186

220

230

239

257

258
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Production is the generation of a subset of document TIFF or PDF files, some of

which have been redacted.  Concordance Viewer production settings can be saved
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and used each time you create a production.  See Production Parameter Settings

for more information.

Before starting a production run, you need to run a query to locate all the

documents for the production.

Production Numbers

During a production with Concordance Viewer, you may choose to create

production numbers and write the numbers back to the database.  If Create

production numbers is selected, Concordance saves the new production numbers

to the new or appended .cib file and writes the beginning and ending production

numbers for each document back to the Concordance database in the fields you

specify.  The additional parameters in the Numbering section of the Concordance

Production dialog determine the generated production numbers.

Take an example of a production with three documents (A - 1 page, B - 4 pages, C -

2 pages).  If you set Prefix to ABC, Starting number to 0001, and select Add a

numeric suffix then the production numbers will be generated in this way:

· Document A:  Beginning Production Number = ABC0001.0001, Ending

Production Number = ABC0001.0001

· Document B:  Beginning Production Number = ABC0002.0001, Ending

Production Number = ABC0002.0004

227
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· Document C:  Beginning Production Number = ABC0003.0001, Ending

Production Number = ABC0003.0002

Using the same example details above, but unselecting Add a numeric suffix

would result in these production numbers:

· Document A:  Beginning Production Number = ABC0001, Ending Production

Number = ABC0001

· Document B:  Beginning Production Number = ABC0002, Ending Production

Number = ABC0005

· Document C:  Beginning Production Number = ABC0006, Ending Production

Number = ABC0007

Running a Production

1. If you have not done so already, run a search query to locate the documents

you want to produce.

2. In Concordance, from the Tools menu, select Production, then click

Production.  The Concordance Production dialog displays.

3. Select Create production numbers and edit the production number settings:

· Select New to create new production numbers.  Then:

o In Prefix, type the value you want to precede each production number.

 The Prefix can be any combination of letters, numbers, or punctuation

characters that are valid for file or folder names.  The Prefix can be a

maximum of 57 characters.

o In Starting Number, type the number you want to use to start

numbering the production files.  Zero fill your Starting Number to

define the desired number width.  This can hold a maximum of 10

digits.

o Select Add a numeric suffix if you want to add an incremental

numeric value to a production number for each page in a document. 

The pages within a document will be produced beginning with a suffix



Concordance 223

© 2022 CloudNine™. All rights reserved.

of .0001 and incremented accordingly.  If more than 9999 pages exist

in the document, the suffix values will roll over to .10000 and so on. 

This numbering may cause sorting issues for other applications used to

view documents/images.

o For Begin production number field, select the field you want to use

to store the beginning production number.

o For End production number field, select the field you want to use to

store the ending production number.

o Select Append for Copy production numbers to field if you want

the production numbers appended to any data that exists in the

production number fields, or select Overwrite to overwrite any

existing data in the production number fields.

If the production number appends to an existing field, the

numbers may truncate if the content exceeds the field

length.  

· Select From existing field to select a Concordance database field to use

for production numbers.  Then:

o In Production Number Field, select the existing field that should be

used for production numbers.

o Set Begin production number field, End production number field,

and Copy production numbers to field as specified above.

4. In the Output Settings section:

· Select Use production numbers for media keys to use the new production

numbers as media (image) keys in the produced .opt file.  This option is

only available if Create production numbers is selected.

· Select Use production numbers for file names to replace the current file

name with the generated production number when naming the produced

files.  This option is only available if Create production numbers is

selected.
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· Select Create place holders for unsupported/missing files if you want

an Image not available placeholder image to appear for unsupported or

missing files.

· Select Volume folders to create volume folders for the production files. 

Then specify the following:

o Prefix specifies what should precede the volume number.  The Prefix

can be any combination of letters, numbers or punctuation characters

that are valid for folder and file names.

o Starting Number specifies the initial number for the volume folders.

o Maximum Volume Size specifies the maximum size for a volume

folder.  This value should be specified as MB, GB, or TB with no space

between the number and unit specified (i.e. 10MB, 20GB, or 5TB).

The contents of the volume directories can be copied to

external media for distribution.  Make sure you know the

capacity of that external media before setting the

Maximum Volume Size.  This ensures that the entire

contents of the volume can be copied without running out

of space. 

After a volume fills to the maximum size, a new volume

folder is created and this process will continue sequentially.

 An individual produced file will not be split across volumes.

· Select File folders to organize the production files within the volume

folders.  Then specify the following:

o Prefix specifies what should precede the file folder.  The Prefix can be

any combination of letters, numbers, or punctuation.

o Starting Number specifies the initial number for the file folders.  Zero

fill the Starting Number to determine the desired number width.

o Maximum Record Count specifies the maximum number of records

to include in each folder.
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· Click Browse next to Production path.  Navigate to and select a folder

location where the output files should be stored.  The Production path

should not exceed 250 characters.

· Select Create OPT to generate an .opt file for the production files.  Click

Browse next to OPT path and file name to navigate to and specify an

output .opt file name.

It is recommended to select the Add a numeric suffix

option under Numbering when you select the Create OPT

option.  This will ensure the produced documents/images can

be loaded properly in a viewer application.

· Select Create scrub redacted text files if you want to remove redacted

text from your produced text files.  Additional parameters for scrub text

include:

o Click Browse to navigate to a folder to use as the Output path for

text files.

o If desired, select OCR all production documents.

o If you want to write the extracted text back to a field in the database,

select the field in the Extracted text field dropdown.

o If you want to write the path to the extracted text file to a field in the

database, select Copy exported text path to field and select the field

in the drop down underneath.
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5. In the Image Settings section:

· In File Type, select Tiff or Pdf for the image output type.

· In Page settings, select either Multi-page or Single-page.

· In Color settings you can choose to produce files with Black and white

CCITTFSX4 compression or Color LZW compression.

All redactions are produced as black when Black and white

is selected for Color settings.  Color redactions will appear

as they were defined when Color is selected for Color

settings.

Color LZW compression cannot be used with Concordance

Image.

· Select Fit image inside header/footer to reduce the size of the produced

document or image to accommodate the specified headers and footers.

6. In the Markups section select one or more markups to include in the

produced output.  You can choose Select All to turn on all markups.

Be sure to include Redaction in your produced output if

reviewers used redaction markups to hide protected or

privileged information.

7. Select Include headers and footers to define header, footer, and watermark

settings.  A header or footer is a string of text assigned to a specific location

within a document.  The text can be static text or updated values such as date,

time, and page number.  Headers and footers can appear at the top and

bottom of the document and can also be placed in the right and left margins.

 A watermark is a semi-transparent string of text that appears behind the

existing document content.   A watermark appears across each produced file

from bottom left to top right and has a transparency setting of 20%.  To set

header, footer, and watermark parameters:
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· For each item in the Headers and Footers, Margins, and Watermark

sections, you can type a string of text or select a field from the drop down

to be produced in that location within the output documents.

· Click Font to edit the font properties for all the Header/Footer and

Watermark text.

8. Click Preview to see what the current document will look like once it is

produced with the settings you have chosen.

9. After you have completed defining your production settings, click Start

production.  A progress dialog displays while production is running.  Once

production is complete, an information screen displays.  click OK to close this

dialog.

In order to save time for production runs that are similar in nature, you can save

your production parameters for future use.  The Naming section at the top of the
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Concordance Production allows you to manage your production parameter

settings.

Save Default Parameter Settings

1. In the Concordance Production dialog, specify all production parameters

you want to save.

2. When finished, click Save As default.

Save Parameter Settings

1. In the Concordance Production dialog, specify all production parameters

you want to save.

2. Enter saved setting name in the Settings drop down.

3. Click Save.

Load Saved Parameter Settings

1. In the Concordance Production dialog box, select a previously saved

settings in the Settings drop down.

Delete Saved Parameter Settings

1. In the Concordance Production dialog box, select a previously saved

settings in the Settings drop down.
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2. Click Remove.
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Production is the generation of a subset of document TIFF or PDF files, some of

which have been redacted.  Concordance Native Viewer production parameter

settings can be saved and used each time you create a production.  See Production

Parameter Sets  for more information.

Before starting a production run, you need to run a query to locate all the

documents for the production.

Production Numbers

During a production, you may choose to create production numbers and write the

numbers back to the database.  If Create Production Numbers is set to Yes,

Concordance saves the new production numbers to the new or appended .cib file

and writes the beginning and ending production numbers for each document back

to the Concordance database in the fields you specify.  The additional parameters

underneath Create Production Numbers determine the generated production

numbers.

Take an example of a production with three documents (A - 1 page, B - 4 pages, C -

2 pages).  If you set Prefix to ABC, Starting Number to 0001, and Add a

Numeric Suffix to Yes results in this output:

· Document A:  Beginning Production Number = ABC0001.0001, Ending

Production Number = ABC0001.0001

· Document B:  Beginning Production Number = ABC0002.0001, Ending

Production Number = ABC0002.0004

· Document C:  Beginning Production Number = ABC0003.0001, Ending

Production Number = ABC0003.0002

Using the same example details above, but setting Add a Numeric Suffix to No,

would result in this output:

· Document A:  Beginning Production Number = ABC0001, Ending Production

Number = ABC0001

238
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· Document B:  Beginning Production Number = ABC0002, Ending Production

Number = ABC0005

· Document C:  Beginning Production Number = ABC0006, Ending Production

Number = ABC0007

Running a Production

1. If you have not done so already, run a search query to locate the documents

you want to produce.

2. Create a directory folder to store the production files.

3. In Concordance, from the Tools menu, select Production, then click

Production.  The Concordance Production dialog displays.

4. In the Production Run Parameters section:

· Document Range should be set to All to include all the documents in the

current query, or Range to specify the Selected Range of documents

from the current query to include.

· Select Yes for Create Production Numbers.

o For Prefix, type the prefix you want to precede the production number.

 The Prefix can be any combination of letters, numbers, or punctuation

characters that are valid for folder or file names.

o The Starting Number should be set to the number you want to use to

start numbering the production files.  Zero fill your Starting Number

to define the desired number width.  This can hold a maximum of 10

digits.

o Select Yes for Add a Numeric Suffix if you want to add an

incremental numeric value to a production number for each page in a

document.  The pages within a document will be produced beginning

with a suffix of .0001 and incremented accordingly.  If more than 9999

pages exist in the document, the suffix values will roll over to .10000

and so on.  This numbering may cause sorting issues for other

applications used to view documents/images.
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o Set Use Production Numbers for File Names to Yes if you want to

replace the current file name with the generated production number.

o Set Use Production Numbers for New Media Keys to Yes if you

want to replace the current media key with the generated production

number in the CIB File you specify.

When producing single-page .tiff formatted files, the Use

Production Numbers for File Names and Use

Production Numbers for New Media Keys options must

be set to Yes.

o Copy Production Numbers to Production Fields should be set to

either Append Production Numbers to Field Data or Overwrite

Field Data with Production Numbers.

o For Beginning Production Number Field, select the field you want

to use to store the beginning production number.

o For Ending Production Number Field, select the field you want to

use to store the ending production number.

As a best practice, when you write the production

beginning and ending numbers back to Concordance, select

an empty field to ensure that the numbers do not append a

field with existing data.  If the production number appends

to an existing field, the numbers may truncate if the content

exceeds the field length.  

· Set Create Placeholders for unsupported/missing files to Yes if you

want an Image not available placeholder image to appear for unsupported

or missing files.  The placeholder can be customized with an image of your

choosing by replacing the default file in the installation Program Data

folder.

5. In the Output Location Run Parameters section:
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· For CIB Database Output Mode, select Append to add the documents to

an existing CIB database or Create to create a new CIB database.

· Click in the CIB File field, then click the ellipses.  Navigate to and select the

existing CIB file (for Append), or enter a new File name (for Create) and

click Open.

· Click in the Root Destination Folder, then click the ellipses.  Navigate to

and select the root folder to use for the output production files and click

OK.  The Root Destination Folder should not exceed 250 characters.

· Select Yes for Create Volume Folders if you want volume folders for the

production files.  Then set the following options:

o Prefix specifies what should precede the volume number.  The Prefix

can be any combination of letters, numbers or punctuation characters

that are valid for folder and file names.

o Starting Number specifies the initial number for the volume folders.

o Maximum Volume Size specifies the maximum size for a volume

folder.

The contents of the volume directories can be copied to

external media for distribution.  Make sure you know the

capacity of that external media before setting the

Maximum Volume Size.  This ensures that the entire

contents of the volume can be copied without running out

of space. 

After a volume fills to the maximum size, a new volume

folder is created and this process will continue sequentially.

 An individual produced file will not be split across volumes.

· Create File Folders allows you to specify details for organizing the

production files with volume folders.  If desired, select Yes and then set the

following options:

o Prefix specifies what should precede the file folder.  The Prefix can be

any combination of letters, numbers, or punctuation.
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o Starting Number specifies the initial number for the file folders.  Zero

fill the Starting Number to determine the desired number width.

o Maximum Record Count specifies the maximum number of records

to include in each folder.

o Select Yes for Use first file name in folder as folder name.

· Select the Production Output Type that is appropriate for your needs. 

This specifies the output type and image compression for your produced

files.

LZW compression produces a small file size image, which

cannot be used with Concordance Image.

· Color Settings can be set to Color to produce files with original colors or

Grayscale.

· Set Fit Image Inside Headers/Footers to Yes to reduce the size of the

produced document or image to accommodate the space needed for the

specified headers and footers.

· Select Yes for Create OPT File to generate an .opt file for the production

files.  In Output path for OPT File, click the ellipses, then navigate to and

enter a name for the .opt file.

It is recommended that you select Yes for Create OPT File if

you selected Yes for Add a Numeric Suffix.  This will ensure

the produced documents/images can be loaded properly into

viewer applications.

· Create Scrub Redacted Text Files

6. In the Markup Types section:

· Select one or more markups to include individually by setting their value

to Yes.

· Turn on all markups by setting Select All to Yes.
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Due to how markups are rendered during production, please

note that crossout, strikeout, highlight and underline markups

are treated as one markup together.  For example, if a crossout

and highlight markup are both applied to a document, if you

select Yes for Crossout in the production parameters, both the

crossout and the highlight markup are produced.

7. Define any header, footer, or watermark settings you need.  A header or footer

is a string of text assigned to a specific location within a document.  The text

can be static text or updated values such as date, time, and page number. 

Headers and footers can appear at the top or bottom of a document and also

can be placed in the right and left margins.  Each header/footer location may

contain 10 lines of text.  A watermark is a semi-transparent string of text that

appears behind the existing document content.   A watermark appears across

each produced file from bottom left to top right and has a transparency setting

of 20%.  To set header, footer, and watermark parameters:

· Select the Include Hdr/Ftr Spec. check box to include a header, footer, or

watermark in the output files.

· Click Edit Headers and Footers.  The Edit Headers and Footers dialog

displays.  

· Open an individual Header/Footer or Watermark folder by expanding the

item in the list.

· In the expanded list select a <blank> field.  Enter the text you want

displayed in that area.  To include a macro, type the percent sign (%) and

the available macro list displays allowing you to select one.  See Macros

for the list of available macros.

· Click Font to edit the font properties for all the Header/Footer and

Watermark text.

· Click OK to save your changes and close the Edit Headers and Footers

dialog.
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If you selected Yes for Create Production Numbers, you

need to add the BatesPgNo() macro to at least one header or

footer.

Printing and Production headers/footers and watermark

settings are separate.  Parameters defined for Production are

only used for Production.

8. When you are ready to run your Production, click Start.  The Production

Control dialog displays.

9. The dialog updates to show progress information at the bottom while the

production is running.  Production Control displays progress as files are

converted, distributed to the production volumes and file folders, creation of

the CIB and OPT files, and production information written back to the specified

fields in Concordance.
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10. When the job is complete you can select Export to Log File to save the

production job information or click Close to exit the Production Control

dialog.

In order to save time for production runs that are similar in nature, you can save

your production parameters for future use.  The Parameter Set Selection section

at the top of the Concordance Production dialog are several button allowing you

to manage your production parameter sets.
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Save a Default Parameter Set

1. In the Concordance Production dialog, specify all production parameters

you want to save.

2. When finished, click Save As Default Parameter Set.

Save a Parameter Set

1. In the Concordance Production dialog, specify all production parameters

you want to save.

2. Enter a parameter set name in Parameter Set Selected.

3. Click Save User Parameter Set.

Load a Saved Parameter Set

1. In the Concordance Production dialog box, select a previously saved

parameter set in the Parameter Set Selected list.

2. Click Load User Parameter Set.

Delete a Saved Parameter Set

1. In the Concordance Production dialog box, select a previously saved

parameter set in the Parameter Set Selected list.

2. Click Remove Current Parameter Set.

Images are produced using the Production Wizard in Concordance Image.  You can

produce images following the steps in the Production Wizard, or you can run the

production using a previously saved production settings .psf file.  See Production

Settings  for more information.256
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Running the Concordance Image Production

Wizard

1. Create a directory folder to store the production files.

2. Determine your production page count.  See Determining your Page Count .

3. In Concordance Image, from the Tools menu, select Produce.  The

Production dialog displays.

4. If you do not have previous production settings saved, click Select this

option to start the Production Wizard.  The Range dialog displays.

255
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5. Enter the record number for the First and Last document in the range you

want to produce.  

6. Click Next.  The Images dialog displays.
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7. Select one of the following options:

· Create new images (default) - creates new images based on the original

images. It allows you to burn headers and footers as well as redlines onto

the images. You can also convert from single to multi-page TIFFs and vice-

versa.

· Link to existing images - creates a production set that links to the

existing set of images. Most of the time you will also create an imagebase

or log file that links to the subset of images you are producing. This option

does not allow you to burn headers, footers, or redlines onto the images.

· Copy images directly - copies the image directly from the source

directory to the destination directory, but you cannot burn headers,

footers, or redlines onto the images. Typically, this option is not used for

productions, but is used for large print jobs. 
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8. Click Next.  If you selected Create new images (default) or Copy images

directly, the Directory dialog displays and you can continue to step 8. 

Otherwise if you selected Link to existing images, the Imagebase dialog

displays and you can skip to step 11.

9. The Directory specifies the top-level folder where production images should

be saved.  Click Browse to navigate to and open the folder to use for saved

images.

10. Click Next.  The Subdirectory dialog displays.
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11. If you create both image and volume subdirectories, volume directories are

created below the top-level directory and image subdirectories are created

below each volume directory. You can copy the contents of the volume

directories directly to removable storage media for distribution.

· Select Create subdirectories for images if you want to create image

subdirectories.  Then specify:

o Subdirectory prefix is the string that will be used as a prefix for

image subdirectory folder names.

o Start no./width defines the starting number to use in the image

subdirectory folder names.  Zero fill your starting number to define the

desired number width.
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o Max files determines the maximum number of image files allowed in

each image subdirectory folder.

· Select Create volume folders if you want volume folders.  Then specify:

o Volume prefix is the string that will be used as a prefix for volume

folder names.

o Start no./width defines the starting number to use in the volume

folder names.  Zero fill the starting number to define the desired

number width.

o Max size determines the maximum file size allowed in each volume

folder.  When a volume fills to the maximum size, a new volume folder

is created and the image subdirectories start renumbering from the

beginning.  Documents will not be split across volumes.

12. Click Next.  The Imagebase dialog displays.

13. Select Create new/append imagebase if you want to create an imagebase

that contains references to the images you are producing.  If you are

referencing these images from a Concordance database you need to select this

option.  Click Browse to navigate to a directory and specify a File name for

the new imagebase or select an existing imagebase .dir file.  Click Save.  For

new files, clicking Save displays a message confirming this is a new file.  Select

Yes.

14. Select Create Concordance Image log file (cross reference file) if you

want the wizard to generate a log file.  The log contains the image alias, path

and file name for each of the images in the imagebase. The log file is a

delimited ASCII file, and it can be used later to create an imagebase.  Click

Browse to navigate to a location and specify a File name for a new log or

select an existing log to append to.  Click Save.  For new files, clicking Save

displays a message confirming this is a new file.  Select Yes.

15. Click Advanced if you want to create custom image paths for each image in

the imagebase.  The Advanced dialog displays.
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· Select Use a custom image path for each image allows you to

customize the image paths in the imagebase.

· In Base directory, select the top-level directory where your images will be

stored.  If you do not know the final destination for the images, select

<none> in the Base directory field. Later, when you know the image

path, you can add the image path to the imagebase using the Imagebase

Management dialog.

· In Volume directory, select <volume> to organize images in volume

directories or <none> if you do not want image volumes included.

· In Images directory, select <images> to organize images in image

subdirectories or <none> if you do not want image subdirectories

included.

· Selecting Copy base directory settings to the <imagebase>.INI file

will save the path for future use.

· Click OK to close the Advanced dialog.

16. On the Imagebase dialog click Next.  The Numbering dialog displays.
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17. The Numbering dialog allows you to define production number details for

the images in a production set.  Select Create production numbers and then:

· Prefix specifies the production number prefix.  This can be any

combination of letters, numbers, or punctuation.

· Starting number/width defines the first production number to use.  Zero

fill the starting number to determine the number width.  You must be

careful to use an appropriate width that will accommodate the total

number of pages that will be produced (determined in step 2). 

· Select Use production numbers as file names to have Concordance

Image replace image file names with production numbers.  For example, if

you had an image file named IMG0001.tif and your production number is

P1CF0001, the new image file will be named P1CF0001.tif.
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· Select Use production numbers as new image keys to store the

production number image keys in the imagebase for accessing the image

from Concordance.

· Selecting Copy production numbers to Concordance will store the

beginning and ending production number for each document in the

Concordance record.  You must also specify:

o In Beginning field, select the field you want to use to store the

beginning production number.

o In Ending field, select the field you want to use to store the ending

production number.

o Select either APPEND data to fields to append the production numbers

to any existing data in the fields or OVERWRITE data in fields to replace

existing data with the production numbers.

18. Click Next.  The Header & Footer dialog displays.
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19. The Header & Footer dialog allows you to permanently place or information

on any or all of the four corners of the production images.  Images will be

scaled to accommodate space for the headers and footers you specify on the

production image.

Concordance only supports headers and footers in TIFF image files

for a production.

20. In each of the Left header, Right header, Left footer, and Right footer drop

downs you can:

· Manually type any text string that you want to appear in that position.

· Select a macro (denoted by angle brackets) that defines the text to be

produced.  The Macros include:
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o <Date & Time> – The date and time the image was produced

o <Date> – The date the image was produced

o <Document number> - The document number of the current image

(i.e. Document 4 of 10)

o <Image key> - The image key as it appears in Concordance

o <Page number> – The current page number (i.e. Page 1 of 4)

o <Production number> – The current production number

o <Time> – The time the image was produced

· Select a Concordance field.  Text from the associated field will be included

up to the first line or first 60 characters.

21. For each header or footer you can also select Auto increment.  If this is

selected, Concordance Image will automatically increment the header or footer

by 1.  For example, if you manually type PM-0001 for the Left header text and

select Auto increment, Concordance Image will print PM-0001 for the left

header on the first image, PM-0002 on the second image, and so on.

22. If desired, click Font for each header or footer to display the Font dialog and

modify the font to use in that area.

23. Click Next.  The Options dialog displays.
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24. Select the Image type and Compression type you want for your produced

image files.  See Image File Types for Production  for more information.

25. Select Preserve file extensions to keep the image file extensions.

26. For Image type and Compression type selections that support color, select

the Number of colors.

27. Select either Convert all multi-page TIFFs to single page TIFFs or  Convert

all single page TIFFs to multi-page TIFFs.  Then select Keep same image

key for all pages in multi-page TIFFs if desired.

In order to properly convert multi-page TIFF files to single-page

TIFF files, your image files should have a numeric suffix. For

example, PM0001.tif and not PM0001a.tif.

265
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28. If you selected TIFF or CALS as your Image type, you can select Create scrub

redacted text files if you want to produce scrubbed text files for images that

have been redacted.  You also need to specify:

· Extracted text field is the Concordance field containing text for image

files that do not have redactions and do not need to be OCRed.

· Click Browse to navigate to a location and select a folder to specify for the

Output path for text files.  This is where the text files will be produced.  If

an image file contains redactions, the output text file will be scrubbed.  For

non-redacted files the output text file will contain the data from the

Extracted text field.

· If you want the path to the text file saved in a Concordance field, select

Write text path back to a database field and then select the field in the

Exported text path field drop down.

29. Select Suppress errors and write errors to file if you want any error

messages during the production to be suppressed and written to an error log

file.  Click Browse to navigate to a location and specify a File name for the

log.

30. Click Next.  The Redlines dialog displays.
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31. In the Redlines drop down, select an option:

·  No redlines - this will ignore all redlines on the images being produced.

· Copy redlines to redlines database - this option copies the redlines

from the produced images to a redlines database that tracks redlines for

each image in the imagebase.  Whenever you add or move redlines on an

image, the redlines database is updated.  If you select this option, redlines

for produced images can be moved, deleted, and altered.

· Burn redlines onto image - this image will permanently place or burn

redlines onto the produced images.  The redlines cannot be moved,

deleted, or altered in any way.
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32. If you selected Copy redlines to redlines database or Burn redlines onto

image, then you should select any specific redline types that you want to be

copied or burned.  Click Select all to select all redline types at one time.

33. Click Next.  The Produce dialog displays.  The Start document and End

document numbers for the production are displayed at the top.

34. You can select Click this button to save your settings to file for later use. 

Navigate to a location, specify a File name for the production settings, and

click Save.

35. Click Finish to produce the images.  A continue message is displayed.
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36. Click Continue.  The Produce dialog displays a progress bar at the bottom

while the production is running.  If errors occur you will see a message

allowing you to view the log file.

37. Click Done to exit the Production Wizard.

After completing the image production, it is best practice to export the production

numbers and other necessary field data from Concordance to a delimited text file.

This information may be needed later for opposing counsel or an internal

production review.  See Exporting Delimited Text Files  for more information.

Determining your Page Count

Prior to running the Production Wizard in Concordance Image, you should

determine the number of pages you will be producing.  This page count will help

you define the appropriate production numbers using the Wizard.

1.  In Concordance Image, on the File menu, select Print.  The Print dialog

displays.

119
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2. On the Print tab, select Documents in the Print range section.

3. Click Page count.  The dialog updates to display the current page count. 

Make a note of this page count.

4. Click Done to close the Print dialog.

Using Saved Production Wizard Settings

If you have previously run a Concordance Image production and saved your

production settings to a file, you can reuse those settings again to generate another

production.

1. On the Tools menu, click Produce.  The Production dialog displays.



Concordance 257

© 2022 CloudNine™. All rights reserved.

2. Click Select this option to open an existing Production settings file.

3. Browse to the location and select the production settings file (.psf) you want to

use.  Click Open.   The Produce dialog is displayed.

4. Click Finish to start the production.

After running a production, it is best practice to verify the data that was produced.

Verify Production Data

1. In Windows Explorer, navigate to where you created the folder to store the

production files.

2. Review the folder structure.

3. Review the produced images and corresponding files.

4. If the image load file is being produced to opposing counsel, you will want to

modify the directory path information before handing it over.

5. In Concordance, return to your document set and navigate to the next record

to refresh the database.  You may also want to reindex.

6. Scroll to the bottom of the produced records to view the production number

fields and any tags that were applied during production.
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Creating a Production Database

After running a production and verifying the produced images, it is best practice to

create a database for the production.  See Exporting Database Records  for more

details on the Export Wizard.

Create a Production Database

1. In Concordance, make sure that the production query you used is still active in

the database or rerun the production query in the database.

2. On the Documents menu, select Export, and click As a Concordance

database.  The Export Wizard - Database dialog displays.

3. Click Browse.  Navigate to the directory where the production was created,

type a production database File name, and click Open.

4. Click Next.  the Export Wizard - Fields dialog displays.

5. The database list defaults to the currently open database and all the database's

fields are displayed in the list.  You can update the list of fields if you do not

want all fields included in the production database.

6. Click Next.  The Append/Replace dialog displays.

7. Choose the Append all records option since you are creating a new

production database.

8. Click Next.  The Export Wizard - Export dialog displays.  The First and Last

record numbers in the new production database to create are displayed.

9. Click Export.  You will see a confirmation dialog.  Click Yes to create the new

database.

10. The Export Wizard automatically closes when the export is complete.

11. On the File menu, select Open.  Navigate to the location where you created

the new production database, select the .dcb file that was created, and click

Open.

12. On the File menu, select Modify.  The Modify dialog displays.
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13. Identifying the production number as the image alias for this production

database will allow Concordance and the viewers to synchronize the produced

images with their corresponding records in the database.  Modify the

database's image alias:

· Find the current database field that is marked with the Image check box. 

Clear the Image check box for that field.

· Find the field you used to store your production numbers (i.e. BEGPROD)

and update the field to select the Image check box.  

· Click OK to save your changes.

14. On the File menu, select Reindex.

15. Close Concordance and any viewer that may be open.

16. Reopen the production database in Concordance.

17. On the Dynamic toolbar, click the View image (camera) button to open the

viewer and the produced images linked to the production database you

created.

Native File Production

A native file production produces copies of the original native files in a specified

production destination. The native file production does not include any markups or

other production settings, Concordance simply copies the existing native files and

renames them according to the parameters you specify.  

The Native File Production operation cannot be used with

Concordance Image imagebase files.  You must convert the

Concordance Image imagebase to a Concordance Native Viewer

compatible imagebase (creating a CIB file) before using the Native

File Production tools.
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Make sure that the original native file name does not contain any

Unicode characters as this may result in the production of a blank

text file.

Run a Native File Production

1. If you have not done so already, run a search query to locate the documents

you want to produce.

2. On the Tools menu, select Production then Native File Production.  The

Native File Production dialog displays.
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3. Click Browse, navigate to the folder location where you want to store the

produced files and click Select Folder.

The production folder must be empty.
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4. In the File Naming Scheme section, select one of the following:

· Native File Name - this option will keep the original native file name

· Image Key - this option will name the files based on the corresponding

image key

· Field - this option names the files based on the contents of the field you

specify in the corresponding drop down.

· Custom - this field names the files based on the information provided:

o Type a prefix to use for the produced files in the first field and the

starting number to use in the second field.  The starting number will be

incremented for each file produced.  The maximum number of digits

allowed for the starting number field is nine.

o Select Write Production number to the database field to save the

production numbers to the field you specify in the accompanying drop

down.  Then select either Overwrite or Append to determine how the

production numbers are saved to the field.

5. For Source Type, select one of the following:

· CIB (Imagebase) - to produce files as they are currently linked in

Concordance Viewer or Concordance Native Viewer

· Field - select a field in the drop down to produce files from a data field

The full path and filename to the source file must exist in the

selected Field.  If the file is not found at the path and filename

specified, the file will not be produced and an error will be

recorded in the log.

6. If you selected CIB (Imagebase) for Source Type, you can also define specific

file extensions to exclude from the production, replacing with a placeholder

page.  Click Exclusion List to display the Exclude Extension List dialog.  In

the top right field type the file extension and click Add.  Click OK to close the

Exclude Extension List dialog.
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7. Select Write production path back to the database field and select a field

in the dropdown if you want to update a database field with the produced path

and filename information.

8. To run the native file production, click Start.  The Native File Production

dialog updates to show a status bar at the bottom.  When the job is complete,

click Close to exit the Native File Production dialog.

Native File Production for Tagged Documents

Instead of running a Native File Production from a search query, you can also run a

Native File Production from tagged documents.

1. Create a tag specific to this production and apply the tag to the applicable

documents.  See Tagging Records for more information.

2. In the Tags Panel of the Navigation Pane, right click the tag you created and

select Native File Production.  The Native File Production dialog displays.

3. Continue following the steps outlined above to complete the Native File

Production.
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Production Attachment Range

Attachment ranges that express the family relationships of produced documents

can be populated from production numbers.

Generate Production Attachment Ranges

1.  From the Tools menu, select Production, and then Production Attachment

Range. The Production Attachment Range dialog displays:

2. In the Existing Attach Range Fields section:

· Select the Attach Range option if a field in the database contains an

attachment range, and then select the field that contains the attachment

range data in the drop down.

· Select the Fields option if there are individual beginning attachment

number and ending attachment number fields in the database.  Then select

the appropriate fields in the Beg Attach and End Attach drop downs.
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3. In the Existing Production Number Fields section, ProdBeg should be set

to the field that contains the beginning production number and ProdEnd

should be set to the field that contains the ending production number value in

the database.

4. Select the Production Attach Range Field you want to use to store the

production attachment range.

5. Click Start.

Image File Types for Production

Reference this table when making adjustments as needed to match the images you

are producing for image type, compression, and number of colors.
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Reporting

Concordance provides several tools for printing document records and transcripts,

and can be used to create and print a variety of customized reports based on

search results, field content, tagged document sets, and transcript annotations.

Printing options are available in Concordance from either the Browse or Table view,

and the output looks similar to the onscreen display, depending on which view you

choose to print from. Document images can also be printed from Concordance

Image, based on search results in Concordance.

While Concordance offers the basic options for printing, such as page numbers and

dates, Concordance also offers selections for printing highlighted annotations,

underlined hits, field labels, and more. This is especially useful for printing sets of

records for full-text review or printing annotations from transcripts.

You can also print a spreadsheet report of queries displayed in Table view, with

field text in the sort order selected. This option is useful when a summary listing is

appropriate.

The Report Writer can be used to create custom reports from Table view, based on

a sort query.  You can also use the Report Writer in conjunction with a CPL script to

create custom exploded sort reports.  See Report Writer  for more information.

The Annotation Report Writer Wizard can be used to create custom reports from

your transcript files.  The custom reports can include transcript notes, highlights,

and attachments.  See the Annotation Report Writer Wizard for more information.

Report Writer

With the Report Writer, you can create simple reports, exploded sort reports,

complex reports from concatenated databases, or reports where you need to print

tens of thousands of records. The reports are based on a sort query. 

You can select the fields to use, column widths, and page and individual column

formats and alignment. The report columns can contain stacked fields, truncated

fields, calculated data, and combined data and quoted text with tab alignment. The

Report Writer supports date and math calculations, and advanced if-then-else logic.

While many of these features are powerful, the report writer was designed to be

easy and flexible.

297
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In Concordance, the Report Writer is only available in the Table view, but you can

also use the Report Writer in conjunction with CPL (Concordance Programming

Language) scripts. 

Report Writer UI

Editable Areas

The Report Writer screen is divided into four horizontal edit areas:

· Page Header - The top edit box is the page header. It is printed at the top of

every page. Any text can be typed into the page header. The header can be

pulled down to give you more room for a large header or font. There is no

limit to the number of lines in the header. If you do not want a page header,

just pull it up until it disappears.

· Column Headers - The next row of the report contains the column headers.

These are printed at the top of every page, above the data columns. As with
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the page header, the column headers are resized by grabbing the window

borders and pulling them up or down. There is no limitation on the number of

lines of text they can hold. Make them as large or small as you need. Resizing

one column header will resize all column headers, they are always uniform in

height.

· Data Columns - The next row contains the data columns. These contain the

actual data printed in your reports. The data columns are interpreted; if you

place a field's name--it must be in upper case--in the column, then that field's

data ends up in the report. If you place something like, "Data: " + SUMMARY

into the column, then the word "Data: " precedes the text from the field named

SUMMARY. Any text or function or mathematic operator defined in the

programming language can be used in a data column. This allows you to do

things like convert data to upper or lower case, print only the first 100

characters, or calculate dates and other values in your reports.

· Page Footer - The bottom edit box is the page footer. The page footer is

printed at the bottom of every page. Any text can be typed into the footer. The

footer can be pulled up or down to give you more or less room for text or type

size. Make the footer's window smaller if too much room appears between the

footer and the page numbers or dates.

Report Writer Toolbar

Button or Field Description

Opens the Open

dialog box. Click

the Open button

to open an

existing .arp

report file in the

Report Writer.

Saves your latest

report changes
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Report Writer Toolbar

to the .arp file

currently

opened.

Opens the Save

As dialog box.

Inserts a column

to the left of a

selected column.

Click a column in

the report and

click the Insert

button to open

the  Report

Columns dialog

box. Type the

number of

columns to insert

and click OK to

insert the new

columns.

Deletes a

selected column.

 Click a column

in the report and

click the Delete

button to open

the Report

Columns dialog

box. Type the

number of
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Report Writer Toolbar

columns to

delete and click

OK to delete the

selected column,

and if you

entered more

than one column,

the remaining

number of

columns you

entered to the

right of the

selected column.

Deletes a

selected column.

 Click a column

in the report and

click the Delete

button to open

the Report

Columns dialog

box. Type the

number of

columns to

delete and click

OK to delete the

selected column,

and if you

entered more

than one column,

the remaining

number of

columns you



Concordance Classic302

© 2022 CloudNine™. All rights reserved.

Report Writer Toolbar

entered to the

right of the

selected column.

Opens the Page

Setup dialog box.

In the Page

Setup dialog box,

you can edit the

report's page

setup

settings,includin

g the paper size,

source,

orientation, the

page margins,

and printer.

Opens the Justify

dialog box. Select

the check box

that applies to

the text you want

to format, click

OK to open the

Text Alignment

dialog box, click

the alignment

option you want

to use, and click

OK.
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Report Writer Toolbar

Opens the Font

dialog box. Select

the check box

that applies to

the text you want

to format, click

OK, modify the

font, and click OK

again. 

Opens the report

in the print

preview screen.

The print

preview screen

allows you to

browse through

up to 100 pages

of your report

before printing

the report.

Opens the Print

dialog box. Select

you printer

settings and click

OK to print the

report.

Closes the

Report Writer in

Concordance.

You will be
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Report Writer Toolbar

prompted to

save the report if

any changes

were made.

Contains a list of

the database

fields you can

add to the report.

Contains a list of

available CPL

functions and

operators you

can add to the

report.

Adding Field Titles and Data

There are two drop-down lists on the Report Writer toolbar.  The first list contains a

list of every field in the database. The second list contains a list of useful CPL

functions and operators. When adding fields to a report, you should always select

fields from the list box.  It will automatically include necessary conversions for you,

such as converting dates to text so that they can be printed.  For instance, selecting

the date field DATE will actually place dtoc(DATE) into the report column.  This uses

the date-to-character function to convert a numeric date into text.  To add a field,

function, or operator to a report, click on the report where you want to add a field,

function, or operator and make a selection from the field or function list. 

If you need to type field names manually, make sure that you use

upper case letters. The report writer will not recognize field names
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unless they are in upper case.

Stacked Fields and Other Useful Tricks

The Report Writer is very powerful and flexible. It can use any of the CPL

(Concordance Programming Language) operators and functions. With the Report

Writer, you can create some wonderful and complex reports. There are however,

just a handful of functions and operators, like the plus sign, which you will use

most of the time. This section describes the most useful functions and how to use

them.

The first thing you may want to do is to combine some text with a field or two. The

following example does just that. It stacks two fields in one column with titles for

data:

"Date  "+dtoc(DATE)+newline()+

"Customer "+CUSTOMER

Enclose any static text in quotes. Combine quoted text and other data with the plus

sign. The newline() function forces anything that follows it onto the next available

line. Also included in the example, but not shown, are tabs. The quoted text includes

a tab character to align the two data fields--there are no spaces in the line.

Always remember to use plus signs to combine everything with everything else.

Leaving one out, or putting two plus signs in a row, are the two most common

report errors.

Sometimes you may have a very large field which would use a lot of paper if it

were printed. The next example uses the substr() function to print the first 200

characters of the summary field, it sub-strings it.

substr(DIGEST,1,200)

The example about uses the substr() function to grab 200 characters, starting with

the first character. For this scenario, it would be really useful if we could check first

to see if the brief field was actually more than 200 characters long. Then we could
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append ellipses (…) to show that we truncated the entry, if we need to truncate it at

all.

(len(DIGEST)>200?substr(DIGEST,1,200)+"…": DIGEST)

This example uses two new features: the len() function and the conditional

operator. The len() function determines the length of the text in any field. The

conditional operator allows us to embed if-then-else logic into a report column.

The conditional operator has the following format: (statement?true-response:false-

response). The Report Writer tests the statement. If it is true, the true-response is

the result, otherwise the false-response is the result. In our example the Report

Writer determines if the length of the digest field is greater than 200 characters. If it

is, the true-response returns the first 200 characters of the field with ellipses

appended to show that it was truncated. If the statement is false, the entire field is

printed. The parentheses around the conditional operator are required.

Use if-then-else syntax is (:?) and put literal text within quotes

If a date = 00/00/0000, then you can place quotes around “no date available”

Stack fields with newline()

“Beg Bates : ”+BEGNO+newline()+“End Bates : ”+ENDNO

1. Run a search query to locate the documents you want to include in the report.

2. In Table view, use a table layout to organize the columns and column order

you want to include in the report.

3. Click the arrow to the right of the Report button on the Standard toolbar and

select Report writer.  The Report Writer dialog displays.
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4. Select Report Writer and click OK.  The Report Options dialog displays on the

Report tab.

5. If desired, modify the range of records to be printed by editing the First and

Last numbers in the Documents section.

6. Select the options you want:

· New page will print each record on a separate page.

· Blank lines allows blank lines between each record on the report.
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· Horizontal Lines will add a line between each record on the report, only if

Blank lines is enabled.

· Vertical Lines adds a vertical line between each report column.

· Summary report will print only the first line from each field in the report.

7. Update the number of columns for the report and maximum characters

in each column if needed.

8. Click the Printer tab. 

9. If desired, modify the Top, Bottom, Left, and Right margins for the report.

10. You can adjust the spacing between columns in your report using the

Intercolumnar field, which is represented in tenths of an inch.

11. The Widows field controls the minimum number of lines Concordance will

allow to remain at the bottom of a page.  If the number of lines to print at the

bottom of the page is less than the value in the Widows field, then the

document is moved to the top of the next page.

12. The Orphans field controls the minimum number of lines Concordance prints

at the top of a page when splitting a document between pages.  If the lines left
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to print are less than the value in the Orphans field, then lines are borrowed

from the previous page until the orphan minimum is met. This may cause the

preceding page to go below the Widows threshold, causing the entire column

to print at the top of the next page.

13. To adjust paper size, page orientation or other printer options, click Printer

setup and adjust the settings on the Page Setup dialog that displays.

14. Click the Footer tab.

15. Adjust the footer settings based on your needs:

· Select Print dates to print the current date in the lower-left corner of the

report.

· Select Print time to print the current time in the lower-left corner of the

report.

· Select Page numbers to print page numbers in the lower-right corner of

the report.

· Click Font to adjust the font settings for footer text.  The default is Arial

9pt.
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16. Click the Exploded sort tab.

17. An exploded sort is a report where each entry in a multiple entry field is sorted

in alphabetical order and given its own line in the report as if it were a

separate record. Concordance determines each sub-entry in a field by

grabbing the data between delimiters such as a comma. Any punctuation

character can be used as the delimiter as long as it is used consistently.  If you

select Explode, you must also Select the field to perform an exploded

sort on and Select the delimiter to use for the exploded sort.

18. Click the Options tab.
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19. Select a column number in the Column drop down, and adjust any specific

options you want for that column:

· Total will print a grand total of the field data in that column.  If selected,

provide values for Width (number of characters for the Total), Decimals

(number of characters after the decimal point for the Total), and Style

(how the total should be represented)

· Subtotal will print a total of the field data when broken into groups

defined by Break column.  If selected, provide the Column number from

the list on the left in the Break column field.

· Selecting Suppress repetitive entries will only print the first instance of

duplicate entries on the report.

· Selecting New page on new entry will print each record on a separate

page whenever the column's contents change between one record and the

next.

20. Click Ok to create the report template.

21. The template is displayed within the Concordance Report Writer and the

Report Writer toolbar is displayed at the top.
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22. You can further customize the report, including adjusting the column widths,

adding and removing columns, and adjusting text properties.

23. After finishing any remaining adjustments, click Print Preview on the Report

Writer toolbar to preview the report.

24. If you are ready to print the report, click Print from the report preview.

25. To close Report Writer, click Exit on the Report Writer toolbar.

1. In Table view, click the arrow to the right of the Report button on the Standard

toolbar and select Report writer.  The Report Writer dialog displays.
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2. Select Open existing report and click OK.  

3. Browse to and select a report .arp file you want to use.  Click Open.

4. The report displays in the Concordance Report Writer.

5. Make any desired edits to the report.

6. Click Print Preview on the Report Writer toolbar to preview the report.

7. Click Print in the preview to send the report to a printer.

8. You can click Save or Save As on the Report Writer toolbar to update this

report or save as a different report file.

9. To close Report Writer, click Exit on the Report Writer toolbar.

Using the Report Writer Wizard

1. Run a search query to locate the documents you want to include in the report.

2. In Table view, use a table layout to organize the columns and column order

you want to include in the report.

3. Click the arrow to the right of the Report button on the Standard toolbar and

select Report writer.  The Report Writer dialog displays.
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4. Select Report Writer Wizard and click OK.  The Report Wizard -

Documents dialog displays.

5. The First and Last fields are set to the first and last record numbers for the

current Concordance query.  You can modify these values to whatever records

you want to use with the report writer.

6. Click Next.  The Report Wizard - Page numbering and dates dialog displays.
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7. Select Yes or No for the three options displayed for page numbers, dates, and

time.  Click Font to display the Font Dialog and modify the font used to print

page numbers, date, and time.

8. Click Next.  The Report Wizard - Header/Footer dialog displays.
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9. If desired, fill in Enter the report header and Enter the report footer with

text to be used for your report.

10. Click Next.  The Report Wizard - Options dialog displays.

11. Select Yes or No for the five options displayed for report record break,

column border, and summary.

12. Click Next.  The Report Wizard - Margins dialog displays.
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13. If desired, edit any of the print margins.  Margin sizes are represented in

inches.  You can also update the spacing between columns in your report by

adjusting the Intercolumnar value (represented in tenths of an inch).

14. Click Next.  The Report Wizard - Printer dialog displays.
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15. Click Printer to see the Page Setup dialog and adjust the paper, orientation,

and margin settings.  Click OK to return to the Report Wizard - Printer

dialog.

16. The Widows field controls the minimum number of lines Concordance will

allow to remain at the bottom of a page.  If the number of lines to print at the

bottom of the page is less than the value in the Widows field, then the

document is moved to the top of the next page.

17. The Orphans field controls the minimum number of lines Concordance prints

at the top of a page when splitting a document between pages.  If the lines left

to print are less than the value in the Orphans field, then lines are borrowed

from the previous page until the orphan minimum is met. This may cause the

preceding page to go below the Widows threshold, causing the entire column

to print at the top of the next page.

18. Click Next.  The Report Wizard - Exploded sort dialog displays.

19. Select Yes for an exploded report.  An exploded sort is a report where each

entry in a multiple entry field is sorted in alphabetical order and given its own

line in the report as if it were a separate record. Concordance determines each

sub-entry in a field by grabbing the data between delimiters such as a comma.

Any punctuation character can be used as the delimiter as long as it is used
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consistently.  If you select Yes, you must also Select the field you want to

explode sort and define a delimiter to use.

20. Click Next.  The Report Wizard - Fields dialog displays.

21. The wizard automatically sets the number of columns in the report to equal

the number of fields selected in the Column list.  The order the fields are listed

in the Column list is the order the fields will be displayed in the report.  Select

a Field on the left and use the arrow and move buttons in the middle to fill the

Column list in the appropriate order.

22. Click Next.  The Report Wizard - Field Options dialog displays.
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23. Each field can now have additional report details specified.  Select a field on

the left and then set the options you want on the right:

· Total will print a grand total of the field data in that column.  If selected,

provide values for Width (number of characters for the Total), Decimals

(number of characters after the decimal point for the Total), and Style

(how the total should be represented)

· Subtotal will print a total of the field data when broken into groups

defined by Break column.  If selected, provide the Column number from

the list on the left in the Break column field, and Style (how the subtotal

should be represented).

· Selecting New page on new entry will print each record on a separate

page whenever the column's contents change between one record and the

next.

· Selecting Suppress repetitive entries will only print the first instance of

duplicate entries on the report.

· Selecting Underline hits will show all search hits in the selected field

underlined in the report.

24. Click Next.  The Report Wizard - Finish dialog displays.
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25. Click Finish to create the report template.

26. The template is displayed within the Concordance Report Writer and the

Report Writer toolbar is displayed at the top.
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27. You can further customize the report, including adjusting the column widths,

adding and removing columns, and adjusting text properties.

28. After finishing any remaining adjustments, click Print Preview on the Report

Writer toolbar to preview the report.

29. If you are ready to print the report, click Print from the report preview.

30. To close Report Writer, click Exit on the Report Writer toolbar.

Security

Concordance features a two-key system for accessing the security console's

Security dialog box. Depending on the role of each reviewer, users may need

different levels of access to each part of the system. Some staff may even warrant

having administrator-level access while others only need minimal access to

Concordance to review records. Security access to the database requires some

forethought and preliminary planning based on user roles, which should be

outlined before you administer rights to the system.

Enabling security is optional. Once security is enabled, you also have the option to

require a logon. Concordance can restrict security for fields and menu items. For

increased security, you should require a database logon.

Based on the security profile setup, you can prevent most reviewers from seeing

any administrator-level menu options or features. These items do not display at all

or are unavailable for selection. Users can be assigned full read/write access, read-

only access, write-only access, and no access on a field-by-field basis. Users without

read access are unable to view or search on restricted fields. Their searches are

post-processed to remove any references to these fields, so their searches may run

slightly slower and hit counts may not provide the same results as users with full

privileges.

Enabling security requires temporary exclusive control of the database. Only one

administrator user ID and password is allowed per database. The administrator

user ID and password is set when the Security dialog box is first accessed. This

information should be shared with a supervisor or one other administrator, with a

copy of all security settings stored on your network in a secure location.
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Security Overview

· Administrator and user passwords are encrypted with the SHA-1 standard in

the .dcb and .sec files.

· Best practice is to create an account for the Concordance administrator with

full rights to everything upon first setup at the Supervisor permissions level.

· If you enable security and do not require logons, Concordance captures a

user’s network login and compares it to the user list in the database’s Security

dialog box. If a match is found, then the user receives corresponding rights. If a

match is not found, the user receives the default user rights.

· Security is distinct to each database; you must create and modify user

permissions for each database. You can import a .csv file from another

database to speed up the process.

· New users select their passwords when first logging on to Concordance.

Logons and Passwords

Passwords for each user are set when the user first logs on to Concordance. The

first word entered as a password is then confirmed in a security dialog box. Users

can change their passwords at any time.

User ID and Password Rules:

· User IDs – 24-character maximum, not case sensitive, spaces allowed.  It is best

to match these to a user's Windows or network ID.

· Passwords – 24-character maximum, case sensitive, created on first access,

slash characters are not allowed in passwords

· Blank user names are not allowed in Concordance

Concordance only allows one administrator user ID and password

per database. The database's administrator ID and password

should be shared with a supervisor or one other administrator,
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with a copy of all security settings stored on your network in a

secure location. Once the administrator user ID and password is

created it is encrypted and is not visible or accessible anywhere in

Concordance.

Understanding the Default User

When first accessing the Security dialog box, you will see that a default user already

exists. If you enable security, but don’t check the Login required check box,

Concordance first checks to see if there is a Windows or network ID matching the

user name in the security console. If a match is found, then you’ll be logged into

that database with those security settings applied. If there is not a match, you will

receive the security settings that were applied to the default user.

For a minimal level of database security, you can create users that match the

Windows or network IDs for all administrators and give them full rights. Then,

apply a lower level of security to the default user and apply that security setting to

everyone else. Another option is to delete the default user completely.

Setting Up Security

We recommend that you set up security for all users and enable logons. To help

make this task easier, we suggest you create user templates based on review team

roles like attorney and paralegal. This allows you to quickly apply security for new

users because role templates already contain pre-defined settings. Once a user is

added to the Security dialog box based off a role template, you can further

customize any access rights for each user.

When you set up security, Concordance automatically saves

passwords and security setting to a .sec file. You should also export

a copy of your Security dialog box security settings to a .csv file and

store the file in a secure location to reference in an emergency.

Share this file with your supervisor or one other administrator.
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If you are setting up security and adding users to a new database,

and want to import the security settings, including users, from

another database, be sure to import the security settings before

manually defining any security settings or users in the database. 

When you import a security settings .csv file, the file overwrites all

existing security settings defined in the Security dialog box. 

There are three files that hold security information:

· The .trk file stores all users’ field and menu access rights

· The .sec file stores all user IDs and passwords

· The .dcb file stores the security console administrator’s user ID and password

If you create new users from a role template, the settings are only

duplicated from one tab in the Security dialog. We recommend

duplicating settings from the Field rights tab, and then selecting the

user’s menu rights.

Whenever you add or rename a field in the database, it is added to

the database without field access rights. In the Security dialog, the

No rights check box is automatically selected for the field. You will

need to set the field privileges for the new or renamed field for

users already entered in the Security dialog box. 

When you make changes to security settings in Concordance, some

security setting changes will not be applied until the database is

closed and reopened. 

Before you can manage the Concordance database, you must set up the

Concordance administrator user ID and password. Concordance requires the
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administrator user ID and password to access some of the administration menu

commands.

Administrator-Only Menu Commands

On the File menu, there are several administrator-only commands:

· Security

· Pack > Database

· Pack > Dictionary

· Zap

· Convert Single Database

· Bulk Convert Databases to Current Version

· Remove Kashida Characters

Optional Field and Menu Restrictions

There are two options you can implement to prevent users from accessing fields

and menus.

Restricting Field Access

Even if security is not applied to a database, you can apply read-only rights to fields

in Data Entry Attributes dialog box . Any field marked as read-only in this box

applies to all database users and also overrides field rights applied in the security

console.

For more information about the Data Entry Attributes dialog, see Data Validation.
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Hiding Menu Items

If security is not applied to a database, you can restrict menu items from users for

all Concordance databases by listing them in the Concordance_<version>.ini file.

Any menu items listed in a corresponding .ini file are hidden from specified users.

Example: Entries in the .ini file are formatted as follows:

[DeletedMenuItems]

smithja=zap,modify

This example prevents user John Smith from being able to see or access the Zap

and Modify menu items in any database that he accesses through the Concordance

executable sharing the same folder as the .ini file. Concordance recognizes the

user’s Windows or network user ID to apply the restriction of menu items.

This feature is only available when Concordance security is not enabled on the Field

rights tab in the Security dialog, and it does not allow you to hide custom menu

items.

Users can potentially find the .ini file on your organization’s

network and then modify it. We recommend hiding menu items in

the security console as the highest level of security.

Security Guidelines for Concatenated Databases

Setting up security for concatenated databases includes the following guidelines:

· Security settings need to be set up in each database. Setting security in a

concatenated database set only affects the primary database.

· The user name and password must be the same for all databases in the

concatenated set when security is enabled.
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· When the user name and password in the primary database does not exist in a

secondary database, and security is enabled, the concatenated database will

not open. The user will receive a message that they do not have access rights

to the specific database.

· When a secondary database has security enabled and the primary database

does not have security enabled, the user is prompted for the user name and

password when using the secondary database. The user name and password

entered becomes the user name and password for the concatenated database

set.

Setup the Concordance Administrator Account

1. Open the database in Concordance.

2. On the File menu, point to Administration, and click Security.  The first time

you click Security in the database, the Administration dialog displays. The

User field defaults to the your Windows user ID.

The first time you attempt to login to the security console, you may

notice a slight delay due to improvements to Concordance security

encryption and logging features.

3. In the User field, type the administrator user ID.  Blank user names are not

allowed in Concordance. 

4. In the Password field, type the administrator password.
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If you do not want to set the password to open the Security dialog

box, leave the password empty and click OK. However, this allows

anyone else to enter their own user name (or yours) and a

password, locking you out of the administration functions or the

database.

5. Click OK.  The Confirm New User/Password dialog displays.

6. In the User field, type the administrator user ID again.

7. In the Password field, type the administrator password again.

Concordance only allows one administrator user ID and password

per database. The database's administrator ID and password

should be shared with a supervisor or one other administrator,

with a copy of all security settings stored on your network in a

secure location. Once the administrator user ID and password is

created it is encrypted and is not visible or accessible anywhere in

Concordance.

8. Click OK to open the Security dialog.
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9. You will see the administrator user ID and the default user ID in the user list on

the left of the Field rights tab.  By default, new users, including the

administrator user ID, will have no rights on the Field rights tab and full menu

access rights on the Menu access tab.

10. On the Field rights tab, make sure that the administrator user ID is selected in

the user list.

11. Click the Select all button to select all the database fields, and select the Full

access check box.

· Clicking the Select all button and selecting the Full access check box gives

the Concordance administrator full read/write access to all fields. 

· Enabling security is optional, but it is best practice to enable security for

Concordance databases. 

12. To enable security for all users, select the Enable security check box.  Once

the Enable security check box is selected, Concordance enforces the field

privileges for the users in the users list on the Field rights tab. This generally

works on networks without requiring manual user IDs and passwords for each

database.
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13. To require all users to log on to Concordance each time they access

Concordance, select the Logon required check box.

Selecting Logon required affects database access in FYI Reviewer. If

selected, the user needs to log on with a non-blank password to

access this database in FYI Reviewer. Be sure to inform FYI

Reviewer users when setting the database security to Logon

required.

· Enabling security requires momentary exclusive control of the database.

Concordance attempts to gain exclusive control of the database when you

save the Enable security and/or Logon required setting. An error message

is displayed if users are logged on to Concordance and Concordance could

not make the change. The check boxes will remain selected after you click

OK or the Apply button if the change was successful.

· If you do not want to enable security for the database, leave the Enable

security and Logon required check boxes empty.

14. With the administrator user ID still selected in the user list, click the Menu

access tab. 

15. Click the Supervisor button to ensure the administrator user ID has full rights

to everything in Concordance.

16. Click the Apply button to save the administrator user and its security settings.

Modify a User, Including the Default User

When first accessing the Security dialog box, you will see that a default user already

exists. If you enable security, but don’t check the Login required check box,

Concordance first checks to see if there is a Windows or network ID matching the

user name in the security console. If a match is found, then you’ll be logged into

that database with those security settings applied. If there is not a match, you will

receive the security settings that were applied to the default user.
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For minimal level of database security, you can create users that match the

Windows or network IDs for all administrators and give them full rights. Then,

apply a lower level of security to the default user and apply that security setting to

everyone else. Another option is to delete the default user completely.

1. On the File menu, point to Administration, and click Security.  The

Administration dialog displays.

2. In the User field, type the administrator user ID.

3. In the Password field, type the administrator password. 

4. Click OK to open the Security dialog.

5. On the Field rights tab, click user name in the user list.

· If you are modifying the default user, click default in the user list.

· By default, the No rights check box is selected for all fields.

6. In the Field list, select the fields you want to apply field rights.  To select

multiple fields, use CTRL+click or SHIFT+click. 

7. In the Field rights section, select one of the following:

· Full access - gives users read/write access to a field. This level of access for all

fields is required for anyone who will be performing maintenance functions

such as indexing, packing, or a database modify. If the user does not have full

access to the fields, Concordance does not either.

· Read only - gives users the ability to search, browse, and print the field. They

may not edit or otherwise modify read-only fields. Commands such as Global

edit and Load will not display fields which have read-only access. These fields

are displayed in Edit view, but only for reference or to copy text to the

clipboard.

· Write only - gives users limited access. Users with write-only field access can

load data into these fields using Load, and assign values to them through the

programming language, but they will not be able to view or search these

fields. The Edit view will not display write-only fields and therefore they cannot

be edited. The searches will be post-processed to remove any references to

hits in these fields. The searches may also run slower.
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· No rights - denies all access to the field. Users will not be able search for data

in these fields. Searches will be post-processed to remove any references to

hits in these fields. The searches may run slower and the results may not

contain the same count as a search with read-only field access.

Field privileges do not take effect until the database is closed and

reopened.

8. Click the Menu access tab.

· By default, new users have full access to all menus and menu commands

on the Menu access tab. You can manually select the menu access

permissions for each menu, select one of the menu access presets, or

select a preset and then manually customize the menu permissions for the

individual user.  

· Menu access presets:

o Supervisor - access to all menus and menu commands. 

o Administrator - access to all menus and menu commands except the

Modify, Security, and Zap menu commands. 

o Editor - no access to the menu commands restricted in the

Administrator preset and does not have access to the following menu

commands: New, Reindex, Index, Pack, Begin program, Edit program, or

the menu commands for data validation . Editors can, of course, search

and edit, global edit, load and unload data, and run reports.

o Researcher - no access to the menu commands restricted in the

Administrator and Editor presets, and cannot edit or append, load,

overlay, or import data, perform global edits, or unload a copy of the

database's structure.

o No access - no access to any menus or menu commands. User can

only open and exit the database.

· After selecting one of the menu preset buttons, you can explore the menu

tree on the Menu access tab to view the default menu settings provided by

Concordance for the selected preset. You can further customize the menu
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settings for each user depending on the user's role and skill level, as

needed.

· When a menu or menu command check box is selected, the user has

access to this menu or menu command.

· When a menu check box is selected but the check box is gray, the user has

access to the menu, but does not have access to some of the menu

commands on the menu.

· When a menu or menu command check box is not selected (blank), the

user does not have access and cannot view the menu or menu command

in Concordance. 

9. In the Presets section, click one of the menu access preset buttons, and/or

manually define the menu and menu command access for the user in the

menu tree.

10. Click the Apply button to save your changes to the user settings.

Create Role Templates

Role templates allow you to use pre-defined field rights or menu access settings

when you create a new user to help speed up the user creation process. For

example, you can create a role template for your most commonly used roles, such

as attorney, paralegal, and reviewer, and use the templates each time your create a

user ID for one of your attorneys, paralegals, or reviewers. 

The steps for creating a role template are the same as the steps for creating a new

user. The only difference is that you will be using this role template user to create

individual users in Concordance.

1. In the Security dialog box, click the Field rights tab.

2. In the field above the user list, select all the text of the user name currently

selected in the user list, and type the role template name.

3. Click the Add user button.
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4. On the Field rights tab, define the field rights for the role template.

5. Click the Menu assess tab and define the menu access rights for the role

template.  See the next section for specific steps for defining field and menu

access rights.

6. Click the Apply button to save your settings.

Create a User

1. On the File menu, point to Administration, and click Security.  Clicking

Security opens the Administration dialog.

2. In the User field, type the administrator user ID.

3. In the Password field, type the administrator password. 

4. Click OK to open the Field rights tab in the Security dialog.

5. When you are creating a user from an existing role template, you can only use

the field rights settings or menu access settings from the role template to

create a new user. You cannot use both the field rights and menu access

settings from a role template to create a new user. We recommend duplicating

settings from the Field rights tab, and then selecting the user’s menu rights on

the Menu access tab.

6. To use the field rights settings from a role template, on the Fields rights tab,

in the field above the user list, select all the text of the user name currently

selected in the user list, and type the new user name.

7. To use the menu access settings from a role template, click the Menu access

tab, in the field above the user list, select all the text of the user name currently

selected in the user list, and type the new user name.

The FYI Server and FYI Reviewer do not support user names,

passwords, or database names containing characters in Unicode,

such as Chinese or Japanese characters. Currently, FYI Server and
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FYI Reviewer only support user names, passwords, or database

names containing single-byte characters, such as English

characters. 

If your organization uses FYI Server and FYI Reviewer, be sure to

only use single-byte characters when creating user names,

passwords, and database names in Concordance.

8. Click the Add user button.

9. To modify the field rights settings, click the Field rights tab.

10. By default, the No rights check box is selected for all fields, unless you created

the new user from a role template on the Field rights tab, in which case, the

new user with have the same field rights as the role template.

11. In the Field list, select the fields you want to apply or remove field rights.  To

select multiple fields, use CTRL+click or SHIFT+click. 

12. In the Field rights section, select one of the following:

· Full access: gives users both read/write access to a field. This level of access

for all fields is required for anyone who will be performing maintenance

functions such as indexing, packing, or a database modify. If the user does not

have full access to the fields, Concordance does not either.

· Read only: gives users the ability to search, browse, and print the field. They

may not edit or otherwise modify read-only fields. Commands such as Global

edit and Load will not display fields which have read-only access. These fields

are displayed in Edit view, but only for reference or to copy text to the

clipboard.

The read-only setting for fields in the Data Entry Attributes dialog

box takes precedence over the read-only setting for fields on the

Field rights tab in the Security dialog box. 

For example, if the Read only check box is selected for the OCR1

field in the Data Entry Attributes dialog box, and the Full access
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check box is selected for the OCR1 field on the Field rights tab in

the Security dialog box, the OCR1 field will be read-only for the

user in the Edit view.

For more information about the Data Entry Attributes dialog box,

see Data Validation.

· Write only: gives very limited access. Users with write-only field access can

load data into these fields using Load, and assign values to them through the

programming language, but they will not be able to view or search these

fields. The Edit view will not display write-only fields and therefore they cannot

be edited. The searches will be post-processed to remove any references to

hits in these fields. The searches may also run slower.

· No rights: denies all access to the field. Users will not be able search for data

in these fields. Searches will be post-processed to remove any references to

hits in these fields. The searches may run slower and the results may not

contain the same count as a search with read-only field access.

13. Click the Menu access tab.  By default, new users have full access to all menus

and menu commands on the Menu access tab, unless you created the new

user from a role template on the Menu access tab in which case, the new user

with have the same menu access settings as the role template. 

· You can manually select the menu access permissions for each menu,

select one of the menu access presets, or select a preset and then manually

customize the menu permissions for the individual user.  

· Menu access presets:

o Supervisor: user has complete access to all menus and menu

commands. 

o Administrator: user has access to all menus and menu commands

except the Modify, Security, and Zap menu commands. 

o Editor: user does not have access to the menu commands restricted in

the Administrator preset and does not have access to the following

menu commands: New, Reindex, Index, Pack, Begin program, Edit

program, or the menu commands for data validation . Editors can, of
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course, search and edit, global edit, load and unload data, and run

reports.

o Researcher: user does not have access to the menu commands

restricted in the Administrator and Editor presets, and cannot edit or

append, load, overlay, or import data, perform global edits, or unload a

copy of the database's structure.

o No access: user does not have access to any menus or menu

commands. User can only open and exit the database.

· After selecting one of the menu preset buttons, you can explore the menu

tree on the Menu access tab to view the default menu settings provided by

Concordance for the selected preset. You can further customize the menu

settings for each user depending on the user's role and skill level, as

needed.

· When a menu or menu command check box is selected, the user has

access to this menu or menu command.

· When a menu check box is selected but the check box is gray, they user

has access to the menu, but does not have access to some of the menu

commands on the menu.

· When a menu or menu command check box is not selected (blank), the

user does not have access and cannot view the menu or menu command

in Concordance. 

14. In the Presets section, click one of the menu access preset buttons, and/or

manually define the menu and menu command access for the user in the

menu tree.

15. Click the Apply button to save your new user settings.

Field rights and menu access settings do not take effect until the

database is closed and reopened.
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Delete a User

1. On the File menu, point to Administration, and click Security.  Clicking

Security opens the Administration dialog.

2. In the User field, type the administrator user ID.

3. In the Password field, type the administrator password. 

4. Click OK to open the Field rights tab in the Security dialog box.

5. Click the user name in the user list and click the Delete user button.

6. Click OK to close the Security dialog box.

Exporting Security Settings

You can export the security settings from a Concordance database and import

them into another Concordance database. When you export Concordance security

settings, you are exporting all of the security settings, including users, that are

defined for the database in the Security dialog box. The exported settings can be

used to set up a database template with your security specifications.

It is best practice to always export a copy of your security settings

each time you update them so you have a current backup copy to

reference. Be sure your supervisor or secondary database

administrator has access to this file in case of an emergency.

1. On the File menu, point to Administration, and click Security.  Clicking

Security opens the Administration dialog.

2. In the User field, type the administrator user ID.

3. In the Password field, type the administrator password. 

4. Click OK to open the Field rights tab in the Security dialog box.
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5. Click the Export button.

6. Navigate to where you want to save the exported security settings file, type the

name of the file in the File name field, make sure that Comma separated

file (*.csv) is selected in the Save as type field, and click Save.  It is best

practice to store this file in a separate, secure folder on your network.

7. Click OK to close the Security dialog box.

Here is an example of exported security settings file in a spreadsheet:

Importing Security Settings

You can import the security settings from one Concordance database into another

Concordance database. When you import Concordance security settings, you are

importing all of the security settings, including users, that were defined  for the

database in the Security dialog box.

The import requires at least one commonly named field between the .csv file and

the database to which the file is being imported. Before importing a .csv file

exported from another Concordance database, make sure that there is at least one

commonly named field. For example, the security settings for the DOCTITLE field

are exported to the security settings .csv file, and the .csv file is being imported into

a database also containing a field named DOCTITLE.
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If you are setting up security and adding users to a new database,

and want to import the security settings, including users, from

another database, be sure to import the security settings before

manually defining any security settings or users in the database. 

When you import a security settings CSV file, the file overwrites all

existing security settings defined in the Security dialog box. 

1. On the File menu, point to Administration, and click Security.  Clicking

Security opens the Administration dialog.

2. In the User field, type the administrator user ID.

3. In the Password field, type the administrator password. 

4. Click OK to open the Field rights tab in the Security dialog box.

5. Click the Import button.

6. Browse to and click the .csv file containing the security settings you want to

import and click the Open button. 

7. The security settings from the file are imported into the database. If there were

any existing security settings defined in the Security dialog box, they are

overwritten by the security settings defined the .csv file during the import. 

7. Click OK to close the Security dialog box.

Modifying Security Settings

Once a database's security and users are set up, you may need to modify the

security settings, add additional users, or delete existing users. 

When you make changes to security settings in Concordance, some

security setting changes will not be applied until the database is

closed and reopened. 
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Resetting Lost Passwords

To reset security accounts, you must know the Concordance user ID and password.

Otherwise your options are limited based on your needs and access.

If a user has forgotten a password, simply delete the account and make a new one.

This is another good reason to set up user role templates in the Security dialog for

faster user set up. The user creates a new password upon first log on.

Resetting All Users

If you need to reset all user passwords or have forgotten your user ID but still have

the security console administrator’s user ID and password, you can do so by

deleting or renaming the .sec file. This file is located in the same directory as your

database and stores all user IDs and passwords.

By deleting or renaming the file, you are able to open the database with the

security console administrator’s user ID and password. Once you login, you won’t

see any data because security is still enabled, but you can access Security to reset

all users to the database by importing a backup copy of your security settings.

You must know the database's administrator user ID and password for this process.

1. Navigate to the directory containing the database .sec file containing the

database users you want to reset.  A database's .sec file is stored in the same

directory as the database .dcb file. 

2. Rename or delete the .sec file.

3. In Concordance, open the database that needs security updated.

4. The logon dialog box opens the first time you log on.

5. Click Cancel.  Clicking Cancel opens the Administration logon dialog. 

6. In the User field, type the administrator's user ID.

7. In the Password field, type the administrator's password.
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8. Click OK.  After clicking OK, the database opens, but no data is visible.

9. On the File menu, point to Administration, and click Security.

10. Click the Import button.

11. Browse to and click the .csv file containing the users and security settings you

want to import and click the Open button. 

12. The security settings from the file are imported into the database. If there were

any existing security settings defined in the Security dialog, they are

overwritten by the security settings in the .csv file during the import. 

13. Click OK to close the Security dialog.

Enabling or Disabling Security

Enabling security is optional, but it is best practice to enable security for

Concordance databases. Security is enabled on the Field rights tab in the Security

dialog.

1. On the File menu, point to Administration, and click Security.  The

Administration dialog displays.

2. In the User field, type the administrator user ID.

3. In the Password field, type the administrator password. 

4. Click OK to open the Field rights tab in the Security dialog.

5. To enable security for all users, select Enable security.  To disable security,

unselect Enable security.  If Enable security is selected, Concordance

enforces the field privileges for the users in the users list on the Field rights

tab. This generally works on networks without requiring manual user IDs and

passwords for each database.

6. To require all users to log on to Concordance each time they access

Concordance, select Logon required.
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Selecting Logon required affects database access in FYI Reviewer.

If selected, the user needs to log on with a non-blank password to

access this database in FYI Reviewer. Be sure to inform FYI

Reviewer users when setting the database security to Logon

required.

7. Enabling security requires momentary exclusive control of the database.

Concordance attempts to gain exclusive control of the database when you

save the Enable security and/or Logon required setting. An error message

is displayed if users are logged on to Concordance and Concordance could not

make the change. The check boxes remain selected after you click OK or

Apply if the change was successful.

7. Click Apply to save your changes.

Accessing Locked Databases

If your organization finds itself unable to access a database, you have two options

available:

1. Export the Database - When exporting a Concordance database, security is not

included in the export. If you have a user who has access to the Export menu, the

user can export the database, create a new security administrator ID and

password, and then apply security for all users. When exporting a database, the

user is only able to export the fields that the user has access to under the

existing security settings. You can also import the backup copy of the original

database's security settings into the exported database.  For more information

see Exporting Data .

2. Contact Concordance Technical Support  - Concordance Technical Support

analysts can reset your security console and restore all user IDs and passwords.

This is not quickly done, and has the following requirements:

· You must first supply a technical support analyst with a notarized affidavit

from the owner of the database verifying your security files. This is most often

from your corporate entity and requires a legal document on corporate

letterhead with the appropriate stakeholders signature.

113

405
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· A fee will be assessed before a technical support representative has

permission to overwrite your security.

If you do not know this information ahead of time, there will be a delay in getting

approval for the support override. Please ensure that you always have a current

backup copy of your security profiles and settings, and that a supervisor or

secondary administrator has access to this information in case of an emergency.

Exporting Security Logs

Security logging generates an audit trail of all changes to the security settings of a

Concordance database. The log includes changes to user logins and permissions,

importing or exporting security settings, and the start and end of security sessions.

Security logging is database-centered. Each Concordance database has its own

security log, so only the actions affecting the security for the specific database are

recorded in that database's security log.

Security logging occurs for a database when:

· An administrator in Concordance opens the Security dialog and makes

changes to the security settings.

· An administrator in the Concordance FYI Admin Console opens the

Management tab and adds or deletes a user from a database, or changes the

password for a user belonging to a database.  

You can view a database's security log by exporting the log and viewing the log file

in Microsoft Excel. Exporting a Concordance database's security log generates the

<database>_SecurityLog_Dump.csv file. The .csv file's text format is in the Unicode

Standard. Fields are tab-delimited. Exporting a security log copies the information

to a file, but does not delete the information from the log.

Enabling and Disabling Security Logging
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Security logging is enabled by default for new databases. If you have an existing

Concordance database you want to generate security logs, you need to enable

security logging for the database. The DumpSLog.exe utility can enable or disable

security logging for a database using the /enable or /disable parameter.  When you

disable security logging for a database, the utility deletes all existing security log

information for the database.

The DumpSLog.exe file must be downloaded onto your computer before you can

export security logs or enable or disable security logging using the DumpSLog

utility.  Contact Concordance Technical Support  to download the utility.

Enable Security Logging for a Database

1. On the Start menu, click Run to open the Run dialog box.

2. Type cmd in the Open field and click OK to open a Windows command

prompt.

3. Navigate to the folder containing the DumpSLog.exe file.

4. At the command prompt type DumpSLog "[database path and

name]" /enable and then press Enter.  Be sure to type quotation marks

around the database directory in the command. For example, DumpSLog "C:

\Program Files\CloudNine\Concordance 10\Database\COWCO" /enable

Disable Security Logging for a Database

1. On the Start menu, click Run to open the Run dialog box.

2. Type cmd in the Open field and click OK to open a Windows command

prompt.

3. Navigate to the folder containing the DumpSLog.exe file.

4. At the command prompt type DumpSLog "[database path and

name]" /disable and then press Enter.  Be sure to type quotation marks

around the database directory in the command. For example, DumpSLog "C:

\Program Files\CloudNine\Concordance 10\Database\COWCO" /disable

405
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When security logging is disabled in a database, on the Security log tab in the

Security dialog box in Concordance, the Export security log button is disabled the

and following message is displayed at the bottom of the Security log tab: Security

logging is not enabled for this database.

Exporting Security Logs

There are two ways to export the security log. You can export the file from:

· Concordance on the Security log tab of the Security dialog

· A Microsoft Windows command line using the DumpSLog utility. This option

can be used if you want to dump security log information using a script,

unattended, or in a batch process.  The DumpSLog.exe file must be

downloaded onto your computer before you can export security logs or

enable or disable security logging using the DumpSLog utility.    Contact

Concordance Technical Support  to download the utility.

Export a Database's Security Log Using Concordance

1. Open the database in Concordance.

2. On the File menu, point to Administration, and click Security.  The

Administration dialog displays.

3. In the User field, type the administrator user ID.

4. In the Password field, type the administrator password. 

5. Click OK to open the Security dialog box.

6. Click the Security log tab.  The Destination file displays where the

<database>_SecurityLog_Dump.csv log file will be created. The Destination

file defaults to the directory where the database files are stored. You can edit

the log file destination and file name.

7. Click Export security log to generate the <database>_SecurityLog_Dump.csv

log file.  

405
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8. When the export finishes, the number of rows exported is displayed below the

Export security log button.

To Export a Database's Security Log Using the DumpSLog

Utility

1. On the Start menu, click Run to open the Run dialog box.

2. Type cmd in the Open field and click OK to open a Windows command

prompt.

3. Navigate to the folder containing the DumpSLog.exe file.

4. At the command prompt type DumpSLog.exe and then press Enter.

5. The DumpSLog Help dialog opens and displays the DumpSLog utility's

command syntax and examples. The DumpSLog utility allows dumping

security log information using a script, unattended, or in a batch process.

Determine what options you want to use to generate the security log.

5. Click OK to return to the command prompt.

6. Type the security log command you want to use and press Enter.  Be sure to

type quotation marks around the database directory in the command. For

example, DumpSLog "C:\Program Files\CloudNine\Concordance

10\Database\COWCO"

7. The <database name>_SecurityLog_Dump.csv log file is created in the same

directory as the database.

Purging Security Logs

Security logs should be purged on a regular basis for optimal database

performance. Security logging information is stored in a table within the .trk file,

and if the security log becomes too large, it can slow down the overall performance

of the database. The DumpSLog.exe utility can delete database security logs using
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the /purge parameter.  When you purge a databases security log, the utility deletes

all existing security log information for the database.

To Purge a Database's Security Log

1. On the Start menu, click Run to open the Run dialog box.

2. Type cmd in the Open field and click OK to open the Windows command

prompt.

3. Navigate to the folder containing the DumpSLog.exe file.

4. At the command prompt type DumpSLog "[database path and

name]" /purge and then press Enter.  Be sure to type quotation marks

around the database directory in the command. For example, DumpSLog "C:

\Program Files\CloudNine\Concordance 10\Database\COWCO" /purge

Security Log Format

The security log contains the following fields:

· RowID 

· UniversalTime 

· UserID 

· UserDomainLogin 

· UserComputerName

· UserIDAffected 

· EventName 

· EventDetail 
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Security Log Event Types:

EventNa

me

EventDetail

(with sample

data)

FieldRights STARTPAGE:RW,ENDP

AGE:R-.

MenuAcces

s

Disabled:  FILE

UserDelete

d

SmithJH,

Legal/SmithJH

UserAdded SmithJH,

Legal/SmithJH

RightsExpo

rt

To: <file path>

RightsImp

ort

Begin import from:

<file path>

RightsImp

ort

End import from: <file

path>
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EventNa

me

EventDetail

(with sample

data)

SessionStar

ted

Settings:

SecurityEnabled=0

LogonRequired=0

SessionEnd

ed 

Settings:

SecurityEnabled=0

LogonRequired=0

Customizations

Adding custom menus and custom menu commands to Concordance can make

your administration job much easier. Having CPL scripts and databases accessible

as a shortcut in a menu provides instant access to the tools you need to use

frequently. You can apply these menus and menu commands to the current

database or all databases. You can add custom menu commands to existing or

custom Concordance menus. By default, all users will be able to use and access the

custom menu and menu command. To restrict custom menus and menu

commands to a specific user, you need to add the user and the custom menu

command for the user in the Added Menu Items dialog. 

If you are familiar with programming and have attended a Concordance CPL class,

you can add your own CPL scripts to a custom menu, which  launches these

programs without having to navigate to their directory folder.

Custom menu commands are not listed in the Security dialog for

enabling and disabling menu access. If you need to restrict access
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to custom menus and menu commands, be sure to add the custom

menu command to specific users in the Added Menu Items

dialog.

The following file types can be opened from Concordance custom menus:

· Database file (.dcb, .fyi)

· CPL file (.cpt, .cpt)

· Report file (.arp)

· Print file (.fmt)

· Concatenation file (.cat)

· Snapshot file (.snp)

· Query file (.qry)

· PDF file (.pdf)
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Adding a Custom Menu and Menu Command

1. In Concordance, open the database you want to add a custom menu and

custom menu command.

2. On the File menu, select Administration, and then Added menu items.  The

Added Menu Items dialog displays.

3. The User list comes with a pre-defined Default user ID.  The Default user ID

works on databases that do not have security enabled or and databases with a

default user ID defined in the Security dialog.  Creating a custom menu

and/or menu command for the Default user ID allows all users to view and

access the menu and menu command.

· To restrict access to the custom menu and/or menu command, you need to

add each of the users you want to have access to the menu and/or menu

command to the User list, and create the custom menu and/or menu

command for each of the users you created. The users you create must
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already be added to the database, and the user IDs you create in the User list

must match the users' database user IDs in the Security dialog. 

When a user is added as a database user and then added to the

User list in the Added Menu Items dialog, the custom menu

commands assigned to the Default user in the Added Menu

Items dialog will not be available to the added user. You will have

to assign the same custom menu commands to the added user in

order for the user to access these menu commands.

3. To add a user to the User list, click in the box above the User list, type in the

new user name, and click the Add button.

Adding a user to the User field in the Added Menu Items dialog

box does not add the user to the database. To add a user to the

database, see Setting Up Security .

4. To add a custom menu and/or menu command for a user in the User list,

select the user ID in the list.

5. Specify the database for the custom menu and/or custom menu command by

selecting in the Database drop down.  Selecting All databases will add the

custom menu and/or custom menu command to all databases.

6. In the Menu item section, click New to create the custom menu and/or menu

command.

7. Click File button and browse to and select the file you want to launch from the

custom menu command.  Click Open.  You can open the following file types:

· Database file (.dcb, .fyi)

· CPL file (.cpl, .cpt)

· Report file (.arp)

· Print file (.fmt)

· Concatenation file (.cat)
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· Snapshot file (.snp)

· Query file (.qry)

· PDF file (.pdf)

The Added Menu Items feature only works with specific IPRO CPL

scripts. Be certain to verify the supported IPRO scripts before

loading them into a database.

8. To add the custom menu command to an existing Concordance menu, in the

Menu drop down, select the menu you want to add the custom menu

command.  To add a new custom menu, type the name of the new menu in the

Menu drop down.

9. For custom menus, Position determines where the menu is displayed on the

Menu bar.  For custom menus in an existing Concordance menu, Position

determines where the custom menu is displayed within the menu.  In the

Position field, type the position number you want the custom menu and/or

custom menu command to be displayed. 

· When you are creating a custom menu, zero is the first position on the left

on the Menu bar. For example, if you typed 0 in the Position field, the

custom menu will be displayed to the left of the File menu. Positive

position numbers will move the custom menu the number of places to the

right. For example, if you type +3 in the Position field, the custom menu

will be displayed 3 places to the right. Typing -1 places the custom menu

to the right of the Help menu.

· Negative position values start at the right and work their way left on the

Menu bar. Positive position values start at the left and work  their way

right on the Menu bar.

· When you are creating a custom menu command, zero is the first position

at the top of the menu. Positive position numbers will move the custom

menu command the number of places down from the top of the menu. For

example if you add a custom menu command to the File menu and type 3

in the Position field, the custom menu command will be displayed between

the Snapshot and Close commands on the File menu. Typing -1 places the

custom menu command at the bottom of the menu. 
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· Negative position values start at the bottom and work their way up the

menu. Positive position values start at the top and work their way down

the menu.

10. In Display name, type the custom menu command name as you want it to

appear in the menu.

Ampersand and parenthesis characters will not display correctly in

a menu and should not be used for a Display name.

11. If the custom menu command opens a CPL program file, you can have

Concordance run a specific function along with the required parameters. This

should be a complete and valid CPL function call, such as myfunction( "Hello",

1, 2, 3).  For custom menu commands like this, enter the full function call

syntax in the Function field.

12. As you add new custom menu items, the details are displayed in the Added

menu items list. If you are creating multiple custom menus and/or custom

menu commands, you can organize the display order of the custom menus,

and the custom menu commands within the same menu by clicking Move up

and/or Move down.  When determining the display position of custom

menus and/or custom menu commands in relation to each other, sometimes it

is easier to leave the Position field set to -1 for each menu and menu

commands, and just use the Move up and Move down buttons to position

them.

13. Click OK to save your custom menu and/or custom menu command.  You may

need to close out of concordance and log back in to activate the new menu

customizations.

The Added menu items list has a right mouse menu to make

menu customization easier.  The menu allows you to Cut, Copy,

Paste, and Select all custom menu items.  Simply right click in the

list.  You can create a set of menu items, copy them, and paste

them into other user’s profiles or other database profiles. This is

the easiest way to replicate menus in the Added Menu Items

dialog.
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Troubleshooting

Reference this section to review troubleshooting information and common issues

that you can resolve/  Once you've gone through this checklist, you'll most likely

discover where the issue lies and can determine the course of action needed to

resolve an issue. If you find you still have difficulties after reviewing items on this

checklist, you can contact Concordance Technical Support  for assistance.

Isolating Issues Checklist:

1. Is your problem happening to one person or all users?

a. If it’s one person, there’s potentially something wrong with the

computer itself, such as the user’s network privileges or another

setting. Please check to ensure that the user is granted full privileges.

2. Is the problem only with this computer?

a. If so, you may need to rebuild the system profile.

b. Test whether the user can log into a Concordance database from

another computer. If so, the problem is most likely the computer and

not the application.

3. Is the issue occurring only in one database or all databases?

a. Determining this helps isolate whether it’s a database or system issue.

b. Depending on the setup, try moving a database to a location other than

its current placement.

c. Desktop to server or server to desktop.

Most Frequent Issues

Full Network Rights Given to Users
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Many of our technical support calls can be resolved with this easy fix.  If you find

there are users having issues with accessing aspects of Concordance or there are

other problems occurring, you'll want to verify that all users have full read/write

privileges in the directory where each database resides.

File Path Problems

Whether you are trying to view images in Concordance Image or trying to launch a

hyperlink to a native document or email attachment, there are times where you

may run into the following issues:

Image Path Issues

1. "Couldn't find xxxx in the imagebase" - Receiving this message means you

didn’t register any image information to the .dir file, whether it was by

registering an image load file or by scanning the image directories.

2. "Unable to open the following image (xxx): <path to image file>" - Notice that

this message lists a path. Concordance Image is looking in that provided path

to find the image file.  You can copy the path in this dialog box by selecting

CTRL + C. Next, on the Start menu, click Run and type in the listed path and

click OK. If Microsoft Windows cannot find the file, then the path is incorrect.

You will need to fix the directory path stored in the imagebase.

No Message: Nothing Happens

1. If this occurs while trying to view a file, your viewer setting in Preferences may

be incorrect. 

2. The image attribute is not enabled for the beginning Bates number field in the

Modify dialog.

3. There may be something wrong with the image file itself. First, navigate to that

specific image file on your server and try to launch it using the default

Microsoft Windows program selected. If Windows can’t open it, you'll need to

take steps to get a corrected image from your vendor or producing party, if

possible. This scenario usually produces either of these messages couldn’t find

or unable to open.
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Native Files and Attachments

When clicking on a native document or attachment hyperlink and nothing happens,

on the Start menu, click Run and type the listed path and click OK.

Windows may open a dialog box saying it can’t open the file. It will ask you what

program to use to launch the file. This occurs when Windows doesn’t recognize the

file extension. For example, if you just downloaded Adobe® Reader®, Windows

may not recognize the .PDF extension and which program to use to launch it.

Once you select the program from a list in the dialog box, ensure that the Always

use the selected program to open this kind of file is checked. In the future, the

document hyperlink in Concordance will correctly launch the native document.

If Microsoft Windows can’t find the file, then there is a problem with the path listed

in Concordance.

Image File Problems

If a user finds an image file that won't open, the TIFF image file may be corrupt. 

Follow these steps to resolve the issue:

1. In Concordance Image, on the File menu, click Open Image and navigate to

the physical .tif image file that has problems. If the image opens properly, then

the problem is either an incorrect file path name stored in the imagebase or

the TIFF file name doesn't match the image alias information to link it properly

to the Concordance document record. Sometimes, the physical image file

name has too many or not enough zeros, even though it was referenced

correctly in the load file. To resolve the problem, navigate to the image file on

your network and manually rename it to match it with the image alias that is

stored in the imagebase.

2. If the image file does not open in Concordance Image as listed above, try

launching the image file directly from the network directory. The image should

open in the default Microsoft viewer. If it opens successfully, then the image

may not be in a format that is acceptable by Concordance Image. Recreate the

TIFF or print the image to a hard copy and rescan it to TIFF. Once you have a
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new image, replace the .tif file in the proper directory and it should open in

Concordance Image.

3. If the image file does not open by the default Microsoft viewer, an error

message typically displays. In this case, you'll need to contact your source and

ask for a new copy of the .tif file.

Overflow Message During Import

When importing data, you may receive various "overflow" messages in the Data

Overflow or Status box.

If your message looks like this, then Concordance ran into an error on line 100

within the delimited text file you selected to import.  You'll want to open up the

delimited text file, navigate to line 100 and verify that the delimiters are correct and

in place with the file containing a hard carriage return at the end.

This message is listed with the first selected field (BEGNO) followed by an overflow

in every document. Most likely the problem is an incorrect import dialog selection

for the delimiters.  Verify what is used in the delimited text file and that your

selection in the Import Wizard or dialog box in Concordance matches. You will also

want to verify your other delimiter selections as well.
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For this type of error message, there are many possible reasons that an error

occurred. You will want to verify your delimiters, check your Modify dialog to

ensure that the field type matches the type of data that is being imported in, and

also verify that the field order in the import selections matches the delimited text

file.  Once you have modified your selections, be sure to save a new copy of your

delimited text file prior to import. Next delete any records loaded incorrectly or on

the File menu, point to Administration, and click Zap if it is your first import in

the database.  Because mistakes can occur during an import, it is best practice to

always import additional delimited text files into a duplicate empty structure of

your main database to ensure that everything loads properly. Once everything

looks correct, use the matching import process to bring in the new records.

View Image (Camera) Button is Not Highlighted

If the View Image (camera) button is unavailable and grayed out when you are

ready to manage your imagebase, you most likely forgot to select a field in the

database as the Image key.  You will need to open the Modify dialog and select the

Image check box for a unique field, typically your beginning Bates number. Once

you have made your changes, be sure to run a full index. After indexing the

database, close Concordance and re-launch your database. The View Image button

should now be available.

Indexing Takes Too Long

If your indexing speeds take too long, you'll want to check the following:

· Indexing Cache Preferences and Recommendations - refer to the System

Requirements.  For maximum speed, we recommend allocating 2 GB to your

machine.

· How many database indexes are you running on your machine?  Having

indexes for each database run on individual machines greatly improves speed
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since you’re able to allocate more memory to processing one database, rather

than having to share it across multiple databases at the same time.

· What is the size of your database?  Record sizes vary based on how many

metadata fields there are and how large your OCR text fields may be. The

smaller the database: the faster your index processing.  If your databases are

too large, one option is to separate them into smaller databases and

concatenate them for review.  See Concatenated Databases .

Offset Hit Highlighting

If you search for terms using full-text search strings and the hit highlighting is not

working, here are steps to resolving the issue:

1. First, export one record that had hit highlighting issues to another

Concordance database. This way, you can test the issue without impacting

your reviewers.

2. In the exported database, view this record in Edit View. Right-click the field

where offset hit highlighting occurred, and click Reset field formatting on

the shortcut menu. 

3. Reindex the database and try searching on the same search term to see if the

hit highlighting issue is resolved in the record you just formatted.

· If the problem is resolved, this was a rich text formatting issue. Sometimes,

there can be problems with HTML hexadecimal color codes and .rtf files.

Once these files have been imported into Concordance, the index may be

offset in correctly identifying your hit terms. You can reset the field

formatting on each individual record and reindex as listed above to resolve

the issue.

· If the issue has impacted a large number of records, there is a CPL script

that can reset the field formatting of all records in a query set.

4. If the problem persists, then there is an issue with the .ivt file. Take the entire

database offline and then run a full index.

Errors on Dictionary and .Ivt Files

81
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If you receive a message that your dictionary or inverted text (.ivt) files had errors

or were not found, then you'll want to rename the following files by adding OLD to

the file name, and then run a full index: .dct, .ivt, .fzy, .key.

Unable to Read and/or Write to Fields

1. If you come across a field that is read-only in Edit View that you intended to

have full access to, you may have applied security settings to the entire

database.  First, check the Field rights tab in the Security dialog box to verify

the given access to each user. Second, check the specified field in the Data

Entry Attributes dialog box as it can override a field’s settings in the Security

dialog box.

2. If you created a new field in the Modify dialog and security is enabled, you

need to ensure that the new field has read/write access in the Security dialog

for each individual user.  Be careful to check these settings prior to running

productions. You may have forgotten to create production fields in the

database creation phase to store your new beginning and ending production

numbers.  Once you create these new fields, they are listed as options in the

Production Wizard to cross-reference your new production numbers. But if

you did not adjust security field rights for read/write access prior to initiating

the production process, the numbers will not be written to the production

fields.

Issue Tags

Starting with version 10 databases, the user must now highlight the text, hold

down the Shift key and then select the tag in order to create an issue tag. If the user

attempts or accidentally highlights text and then selects the tag without holding

down the Shift key first, they will receive a message instructing them of the new

method for issue tagging. This setting can be changed back to the older method in

the Issue Coding section on the Browsing tab in the Preferences dialog.
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Additional Resources

Information for Concordance FYI can be found in the Concordance FYI Answer

Center.

Details for the Concordance Programming Language (CPL) are documented in the

Concordance CPL Answer Center.

Sample Databases

To successfully download and extract the Unicode sample databases, you will need

WinRAR by RARLAB. WinZip® by WinZip Computing  does not handle the foreign

language characters in the Unicode sample databases correctly, causing the native

file links not to work in the databases.

· Calfco Sample Database

· Cowco Sample Database (without images)

· Cowco Sample Database (with images)

· Cowco Concordance Native Viewer Sample Database (with native files)

PDF Guides

Content in the Concordance Answer Center is available for download in the Adobe

Acrobat PDF format.

· Concordance Installation Guide

· Concordance User Guide

· Concordance Administrator's Guide
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If you are planning to work offline, you can also download a compiled version of

the Concordance Answer Center (Concordance.CHM file) and save it to a folder on

your local computer.

· Concordance Answer Center Compiled Help

Preparing for Concordance

Preliminary planning for implementing any software application is important for

achieving the best setup results, the first time. We recommend that you take some

time to review this section to plan how your organization will be using

Concordance so your administrative tasks are minimized for initial setup and your

long-term maintenance of the application is streamlined into routine updates and

adjustments, rather than reworking any database design and system security later.

Discovery Document Conversion

If you are unfamiliar with the e-discovery process, we recommend that you take

some time to research this growing and rapidly changing industry and learn how it

impacts your system network and strategy by understanding how critical it is that

data load files are handled carefully during the import process. Because you are

dealing with confidential materials, file corruption of your database records is a

sensitive matter and legal implications regarding spoliation are strict and can carry

hefty fines. Once data is altered, your ability to attain another copy of case records

in some instances is minimal – especially if it’s opposing counsel’s case records –

and can affect the lawsuit for the organizations involved.

System Requirements
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Concordance’s system requirements for hardware and software are minimal and

network setup is flexible. The primary focus in ensuring that Concordance runs

properly for you and your organization is all about processing speed = RAM on

your network and individual workstations.

Please review the current system requirements for setup and suggested processor

and RAM. Keep informed of Concordance release updates and how they impact

your system.  See System Requirements for more information.

Database Design

Engineered for capacity and speed, Concordance provides stability with its

enormous database capacity and robust security features. Designed with a flat-file

architecture and a proprietary back-end, Concordance can distribute and store data

and processing over local-area networks. With Concordance’s separate load and

index processes, you can import a variety of load files and their native file

attachments, accessing them both in Concordance and Concordance Native Viewer.

Proper review of your organization’s records for a given case helps determine how

you build and design your database structure. Concordance has some

requirements for importing certain types of records, especially emails and

transcripts. Additionally, reviewing your case load files provides you with a high

level road map for how you want to move forward in planning your database

design.

Database design considerations are based on:

· Possible database size – breaking record groupings into Database 1, Database

2, Database 3

· Document Type – email, native files, and transcripts

· Confidential/Privileged Status

· Content – Predetermined Subject Groupings
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· Rolling Production Environments – adding content to primary databases by

creating secondary databases and concatenating them

· Other

See Concordance Databases and Importing Files  for more information.

Security Setup

Security levels are predominantly affected by the size of your organization and the

user roles that constitute your review team. If your organization is large and has

several geographical locations, system security for multiple ongoing cases is going

to take time and forethought in planning. If you belong to a small organization,

your system security may be minimal for internal staff because users are more

likely to perform many roles using Concordance software.

Please consider implementing security in your organization to ensure that records

are preserved in accordance with e-discovery regulations and database documents

are secured from inadvertent alteration or deletion by applying recommended user

permissions for field and menu items.

See Security  for more information.

Implementation Checklist

We understand that each organization has its own organization guidelines and

processes for supporting their review teams during case review. We also

understand that transferring to and implementing new technology may affect

current procedures and that you may need to adapt new ones given the demands

of a rapidly changing e-discovery industry. Please reference the Preliminary

Planning Checklist to guide you in preparation for implementing and maintaining

Concordance at your workplace.

24
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Preliminary Planning Checklist:

E-Discovery, Collection, and Processing

Do you have an understanding of e-discovery rules

and how they affect your specific case and the review

process?

Do you have a collection and processing plan in place

while also following forensic guidelines, as required?

Do you have vendor relationships set in place for

various stages of your case?

Do you have a quality control plan in place?

Do you know what types of files you are receiving

and whether they are recognized by Concordance?

Database Design

Do you know what your case dataset looks like?

What is the size of your case, including the # of

pages/documents and GB to be processed?

Will this case require a native review?

Do you understand what the case review workflow

will be?
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E-Discovery, Collection, and Processing

What kinds of fields are needed for tracking

administration and reviewer metrics?

What kinds of tags are needed for supporting

administration maintenance?

What fields are needed for coding additional

metadata?

Where will annotations be tracked by reviewers:

Concordance Image sticky note, text associated note

or field? If it’s a field, what fields need preparation for

annotations?

Do you have field and tag naming conventions set in

place?

Do you have a list of categories for preparing your

database tag structure?

Have you consulted key players involved with

Concordance review and administration regarding

database design?

Have you prepared a directory location with

subdirectory folders in a structure that prepares you

for optimal organization of the various files for the

case?

Did you create extra miscellaneous fields in your

database?
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E-Discovery, Collection, and Processing

System Requirements

Have you reviewed the Concordance system

requirements?

Have you given full network rights to all users in the

directory where each case resides?

Did you adjust the indexing and dictionary cache

settings for each workstation?

Do you have remote staff that will be using

Concordance offline remotely and need a mobile

license installed?

Security

Did you plan security settings for all users accessing

this case?

Did you apply security to each Concordance database

individually?

Did you store the security console user ID and

password in a safe location and share it with at least

one other supervisor or administrator?

Maintenance

How will subsequent loads of data be handled? Will

they be uploaded to the main database or will you
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E-Discovery, Collection, and Processing

use concatenation to join multiple databases?

Do you have indexing/reindexing schedules planned

based on the workflow and timeline of the review?

Is there a back-up schedule in place?

Do you have a quality control checklist for major

administration tasks like importing, exporting, and

global edits?

Do you have a disaster recovery plan in place?

Production

Do you have a production plan in place for delivering

files to opposing counsel?

Do you know what types of reports will be generated

or requested by the review team and how to print

them?

Roles and Responsibilities

Does your review team understand the database

design and know how they will specifically use

Concordance for review?

Does your review team understand timelines and

processes required for administrating and

maintaining Concordance?
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E-Discovery, Collection, and Processing

Are roles and responsibilities clearly defined among

administrators, litigation support staff, paralegals,

and attorneys?

Are there policies in place for who can and cannot

create/modify databases and other sensitive tasks?

Ongoing Maintenance

As an administrator you are busy managing multiple cases and the various

software programs and databases in various network locations. We recommend

you to take some additional time to plan a maintenance schedule for Concordance

depending on the complexity of product licensing versions and how database

structure is designed and geographically dispersed.

Typical database management for Concordance includes:

· Directory and subdirectory folder design to store multiple databases for

multiple case reviews within your organization

· Back-up schedules for each case/multiple databases/concatenated databases

· Full index updates on databases performed during off hours (weekends or

holidays) or offline if multiple databases can be updated while staff continues

work in other databases

· Reindex updates when records are added or modified

· Subsequent data and image loads

· Deleting and packing databases and dictionary files after data entry/editing

and indexing

· De-duplication
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· Replicating and synchronizing databases

· Modifying or adding database fields, which then requires a full index

· Tracking metrics

· Running productions

Keyboard Shortcuts

Concordance

Browse and Table View

Shortc

ut Key

Description

F1 Open Concordance Help.

F2 Open Search task pane.

F3 Open or close the Review View.

F4 Open the Query by Example dialog box to run a form search.

F5 Open or close the Table View in the Browse View.

F6 Open or close the Browse View in the Table View.
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Shortc

ut Key

Description

F8 Open the Sort task pane.

- Navigate to the previous document.

+ Navigate to the next document.

C Open the Copy dialog box to copy document data. (Browse

View only)

D Open the Goto dialog box to navigate to a specific document.

F Navigate to the first document.

G Open the Goto dialog box to navigate to a specific document.

L Navigate to the last document.

N Navigate to the next search hit.

O Open the Font dialog box to view or modify the font.

P Navigate to the previous search hit.
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Shortc

ut Key

Description

V Open the current document's corresponding image file in the

image viewer.

CTRL+

N

Open the New Database Creation Wizard for creating new

databases using load files, E-documents and E-mails.

CTRL+

T

Open the database templates for creating a new database

using a template.

CTRL+

D

Open the Dictionary dialog box when your cursor is in the

Advanced Search panel.

CTRL+

F

Open the Fields dialog box when your cursor is in the

Advanced Search panel.

CTRL+

S

Open the Fuzzy Search dialog box when your cursor is in the

Advanced Search panel.

Tags Task Pane
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Shortc

ut Key

Description

SPACE

BAR

Toggle selected tag.

C Open the Copy dialog box to copy document data. (Browse

View only)

D Open the Goto dialog box to navigate to a specific document.

F Navigate to the first document.

G Open the Goto dialog box to navigate to a specific document.

L Navigate to the last document.

N Navigate to the next search hit.

O Open the Font dialog box to view or modify the font.

P Navigate to the previous search hit.

other

letter

keys

Navigate to the tag starting with the same letter.
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Review View

Shortc

ut Key

Description

F2 Open Search task pane.

F3 Open the Review View if it is not already opened.

F4 Open the Query by Example dialog box to run a form search.

ENTER Execute the selected search query.

CTRL+

D

Open the Dictionary dialog box when your cursor is in the

Advanced Search panel.

CTRL+

F

Open the Fields dialog box when your cursor is in the

Advanced Search panel.

CTRL+

S

Open the Fuzzy Search dialog box when your cursor is in the

Advanced Search panel.

ESC Cancel the current search that is in progress.
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Edit View

Shortcut

Key

Description

CTRL+PA

GE UP

Navigate to the previous document.

CTRL+PA

GE DOWN

Navigate to the next document.

TAB Navigate to the next field in the document.

SHIFT+TA

B

Navigate to the previous field in the document.

CTRL+TAB Navigate to the last database or Workspace tab you

opened.

CTRL+C Copy the selected text.

CTRL+D Open the Duplicate dialog box to copy field data to

another record.

CTRL+F Open the Find dialog box to find text in the current field.

CTRL+F Open the Fields dialog box when your cursor is in the

Advanced Search panel.
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Shortcut

Key

Description

CTRL+SHI

FT+F

Find the next instance of the text entered in the Find

dialog box.

CTRL+H Open the Replace dialog box to find and replace text in

the current field.

CTRL+L Open the authority list associated with the current field. 

For fields not associated with an authority list, navigate to

and open a saved authority list. 

CTRL+S Open the Fuzzy Search dialog box when your cursor is in

the Advanced Search panel.

CTRL+V Paste the copied or cut text.

CTRL+X Cut the selected text

CTRL+Z Undo the last action

Concordance Viewer
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Shortc

ut Key

Description

PAGE

UP

Navigate to the previous page

PAGE

DOWN

Navigate to the next page

ARRO

W UP

Navigate to the previous page

ARRO

W

DOWN

Navigate to the next page

ARRO

W

LEFT

Navigate to the previous document

ARRO

W

RIGHT

Navigate to the next document

TAB Go to the next markup (if there are more markups on the

page)



References 383

© 2022 CloudNine™. All rights reserved.

Concordance Native Viewer

Shortc

ut Key

Description

CTRL

+ C

Copy the current selection

CTRL

+ X

Cut the current selection

CTRL

+ V

Paste the copied selection

CTRL

+

SHIFT

+ A

Pan tool

CTRL

+

SHIFT

+ X

Zoom tool

CTRL

+

SHIFT

+ Z

Magnifier tool
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Shortc

ut Key

Description

CTRL

+ E

Fit to Height

CTRL

+ W

Fit to Width

CTRL

+

SPACE

BAR

Rotate clockwise 90 degrees

CTRL

+

SHIFT

+

SPACE

BAR

Rotate counter-clockwise 90 degrees

PAGE

UP

Navigate to the previous page

PAGE

DOWN

Navigate to the next page

CTRL

+ P

Open Print dialog box
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Concordance Image

Shortc

ut Key

Description

CTRL+

O

Opens the Open dialog box to open an image in the viewer.

CTRL+

B

Turn on or off the Toggle Bar Code Mode function.

CTRL+

R

Toggle the display of the redlines on the image.

CTRL+

P

Open the Print dialog box to print the images.

CTRL+

C

Copy the current selection on the image.

CTRL+

X

Cut the current selection on the image.

CTRL+

V

Paste the cut or copied selection.
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Shortc

ut Key

Description

I Invert image color. (only works with black and white images)

CTRL+ Zoom in a little.

CTRL- Zoom out a little.

+ Zoom in 50%.

- Zoom out 50%.

ALT+Z Zoom on selection.

W Fit image to width.

H Fit image to height.

CTRL+

F

Display the full screen.

< Rotate left from the original orientation.

> Rotate right from the original orientation.
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Shortc

ut Key

Description

/ Flip from the original orientation.

LEFT

ARRO

W

Rotate left from the current orientation.

RIGHT

ARRO

W

Rotate right from the current orientation.

DOW

N

ARRO

W

Flip from the current orientation.

CTRL+

HOME

Navigate to the first page.

PAGE

DOW

N

Navigate to the next page.

PAGE

UP

Navigate to the previous page.
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Shortc

ut Key

Description

CTRL+

END

Navigate to the last page.

G Open the Go to page dialog box to navigate to a specific page.

CRTL+

G

Open the Go to image key dialog box to navigate to a specific

image.

CTRL+

PAGE

DOW

N

Navigate to the next document.

CTRL+

PAGE

UP

Navigate to the previous document.

Developing with Concordance

DDE stands for Dynamic Data Exchange. It allows two applications to communicate

through programmed commands in the Windows environment. It is not a simple

interface and it should only be used by experienced programmers.

Any parameters used in communicating with Concordance are referenced by name.

 Commands tell Concordance to do something, or they send or receive data.  
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The examples given here are provided for the C programming language. There are

four types of DDE commands that Concordance will recognize. The first command

establishes the link between your program and Concordance. This is referred to as

opening a DDE conversation. 

Establishing a DDE Conversation

All DDE conversations are established by connecting to the DDE server,

Concordance. Establishing the conversation requires your program to provide two

parameters: the service and the topic. The service is the name of the DDE server, in

this case Concordance. The topic is defined by the service and it varies from server

to server. Concordance supports database names as topics. The database topic

should use the full file path in either standard or UNC format. Concordance opens

the database specified as the topic for use in the DDE conversation. Use an asterisk,

*, as the topic to open the conversation using any database currently open and in

use by an end-user. You can close that database later and open another using the

DDE Execute commands.

Example

The following example is written in C. It opens a DDE conversation with a

Concordance server. The OpenConcordanceDDE() function receives two

parameters: the instance identifier and the database name. The instance identifier,

idInst, is a value returned by DdeInitialize() when your program performed the

required DDE initialization. The pszDatabase parameter is a pointer to a zero

terminated string containing the name of a database to open, or NULL to open the

DDE conversation based on the currently open database, i.e., using * as the topic.

HCONV OpenConcordanceDDE( DWORD idInst, char *pszDatabase)

{

HSZ hszService,  // Name of service to connect.

             hszTopic;  // Topic of conversation.

        HCONV  hConv;  // Handle to DDE conversation.

             // Set the handle to a NULL value.
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             hConv = NULL;

             // Use the database name if provided, otherwise

             // use * if no database is specified, this will

             // open the DDE conversation using the current

            // database being viewed by the end-user.

            if (pszDatabase == NULL)

            pszDatabase = "*";

            // Create the service’s string handle.

            hszService = DdeCreateStringHandle(idInst, "Concordance", CP_WINANSI);

             // Create the topic’s string handle.

             hszTopic = DdeCreateStringHandle(idInst, pszDatabase, CP_WINANSI);

             // Connect to the service, Concordance.

             hConv = DdeConnect( idInst, hszService, hszTopic, (PCONVCONTEXT)NULL);

             // Free the DDE string handles.

             DdeFreeStringHandle(idInst, hszService);

             DdeFreeStringHandle(idInst, hszTopic);

             // Return the handle to this DDE conversation.
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             // The handle is required for all further

             // communication with the Concordance DDE server.

             return(hConv);

}

Once a DDE conversation has been established, all further communication between

your program and Concordance takes place through the Microsoft Windows’

DdeClientTransaction() function. The DdeClientTransaction() function has eight

parameters:

       DdeClientTransaction( void *lpvData, DWORD cbData, HCONV hConv, HSZ hszItem, UINT

uFmt, UINT uType, UINT uTimeout, DWORD *lpuResult);

DDE Execute Commands

Execute commands request Concordance to perform actions. These include moving

between records, performing a search, appending and deleting records, and

opening and closing databases. These commands return success codes, but they do

not return data.  Several commands contain two parts: the command and the

command parameter. For instance, opening a database also requires the name of

the database you want to open. The command is sent as the single string open

drive:path\filename.dcb.

DdeClientTransaction() Parameters

Execute commands use two DdeClientTransaction() parameters, lpvData and

cbData. lpvData is a pointer to the command string. This may simply be the

command string in quotes. cbData is the number of bytes in the command string,

lpvData, including the terminating zero. For instance, strlen(lpvData) + 1.

Returns

The XTYP_EXECUTE commands return DDE_FACK, DDE_FBUSY, or

DDE_FNOTPROCESSED. DDE_FACK and DDE_FBUSY are returned to indicate
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success or TRUE and failure or FALSE. For instance, the lock command returns

DDE_FACK if the record was successfully locked and DDE_FBUSY if it could not be

locked, i.e., someone else already has it locked.

DDE_FNOTPROCESSED is only returned if the command is not recognized, usually

due to a misspelling, or if the database is not open. The return codes are defined in

the Windows ddeml.h include file, provided with your compiler.

EXECUTE Commands

Comm

and

Parameter Function

append Appends the current record

to the end of the database.

This is generally used with

blank, to create a new

record. For E-documents

databases created using

Concordance version 10.21

and later, this function is

disabled.  To append a

document to an E-

documents database, drag

the document onto the

database.

blank Creates a blank record. If

the current record has been

edited, it is automatically

saved before being

blanked. Use blank records

with the append command

to add records to the

database.
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EXECUTE Commands

Comm

and

Parameter Function

browse Brings up the Browse

screen.

close Closes Concordance. This

also terminates the DDE

conversation.

closeda

tabase

Closes the current

database.

closeall

databas

es

Closes all open databases.

first Retrieves the first record in

the query.

goto FIELD =

VALUE

This performs a search for

the record whose field

exactly matches the value.

The search is not limited to

the current query set, it

looks throughout the

database. Wildcards and

Boolean logic are not

allowed in the query. The

field must be a key field.

The matching record is
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EXECUTE Commands

Comm

and

Parameter Function

retrieved, but a new query

is not incremented.

Record

number

Moves to any record in the

current set of retrieved

records.

gotoref

erence

/d=database /

k=key /o=offs

et /l=length

This opens a specific

database specified by

database, goes to a key (the

replication key) specified by

key, and highlights a range

of characters specified by

the offset and length.

database is the full path to

the database.dcb file. key is

the replication key. offset is

the offset in characters to

start highlighting from.

length is the number of

characters to highlight.

isdelete

d

Checks if the record is

marked for deletion.

isedited Checks if the record has

been edited since last

indexed or reindexed.
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EXECUTE Commands

Comm

and

Parameter Function

last Moves to the last record in

the current set.

lock Locks the current record so

that you can edit it.

next Moves to the next record.

open Database

path.

Opens a database.

pgdn Moves to the next record

for Browse or Table views.

It is not necessary to send a

repaint command after a

pgdn.

pgup Moves to the previous

record for Browse or Table

views. It is not necessary to

send a repaint command

after a pgup.

prev Moves to the previous

record.

repaint Updates the Browse or

Table display. Use this if
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EXECUTE Commands

Comm

and

Parameter Function

your program changes the

contents of the displayed

record, or moves to

another record.

search Search string. Executes a search.

unlock Unlocks the record.

setfocu

s

Concordance sets focus to

itself. This is equivalent to

the Windows SetFocus()

function.

table Places Concordance into

Table view.

zap The database is zapped.

Every record in the

database is erased and

permanently deleted.

DDE Request Commands
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DDE request commands return data values. This group of Concordance DDE

commands returns information about the database, such as a list of fields or the

database’s name, as well as the field contents.

DdeClientTransaction() Parameters

hszItem is a string handle created with DdeCreateStringHandle() and it contains the

command string in CP_WINANSI format. Use the CF_TEXT format for field names

when retrieving data from the database fields. Field names must be in all upper

case. Set uFmt to either CP_WINANSI or CF_TEXT as appropriate.

Returns

XTYP_REQUEST commands return an HDDEDATA value containing the requested

information. Use DdeGetData() to both obtain the length of the data and to copy it

to local memory. Note that the data may not be terminated with a zero. Allocate

one extra byte to your buffer before you copy the returned data. Null terminate the

string yourself.

Numeric fields are returned as text strings. Date fields are returned in YYYYMMDD

format.

REQUEST Commands

Comm

and

Data Returned

Databa

se

status

This command returns information about the

database in eight lines of text, delimited with

carriage returns and line feeds. Each line

contains a number indicating:

· Records in the database

· Fields in the database

· Needs reindexing
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REQUEST Commands

Comm

and

Data Returned

· Current physical record number

· Current record number in the query

· Active query number

· Records in the query

· Total queries

Databa

se

name

The full path and file name of the database.

List of

Fields

A list of fields in the database. Each field is on a

line terminated with a carriage return and a line

feed. The field name is followed by six items

indicating:

· The field type: P, N, D, or T.

· The field’s length.

· The decimal places, applies to numeric

fields.

· A Y(es) or N(o) to indicate if it is a key field.

· A Y(es) or N(o) to indicate if it is an image

field.
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REQUEST Commands

Comm

and

Data Returned

Image

field

The contents of the image field, if an image

field has been defined, otherwise NULL is

returned.

Total

count

A string containing the count of all records in

the database, including any concatenated

databases.

Query

count

A string containing the number of records in

the current query.

FIELD The contents of the named field.

DDE Poke Commands

DDE Poke commands send data to a Concordance field. The new data replaces any

data already in the field. Data on the end-user’s screen is not updated unless you

send a repaint message.

DdeClientTransaction() Parameters

hszItem is a string handle created with DdeCreateStringHandle() and it contains the

name of the field that will receive the data. You must set uFmt to CF_TEXT and use

the CF_TEXT format to create hszItem. lpvData points to the data for the field, and

cbData is the length of the data in bytes, i.e., strlen(lpvData). The data does not need

to be a zero terminated string.
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All data is sent as text strings, including values for numeric fields. Data destined for

a date field must be in YYYYMMDD format, without slashes or any punctuation. For

instance, 19991231 is valid but 31/12/1999 is invalid.

Returns

DDE_FACK if the data was accepted. DDE_FNOTPROCESSED is returned if the

command failed because:

· the field was not found

· the data format was not CF_TEXT

· the database isn't open

· you do not have sufficient security rights to change the field’s contents

DDE_FBUSY is returned if the record is not locked and Concordance could not lock

it to complete the command.

About the Unicode Standard

The Unicode Standard provides a consistent way to digitally represent the

characters used in the written languages of the world. As an accepted universal

standard in the computer industry, the Unicode Standard assigns each character a

unique numeric value and name. This encoding standard provides a uniform basis

for processing, storing, searching, and exchanging text data in any language.

In Concordance version 10.x, the Unicode Standard is supported in Arabic, Chinese,

English, Hebrew, Japanese, Korean, Russian, and other languages.

Some Adobe PDF files with Arabic text do not display the Arabic

text in the proper right-to-left order in Concordance. These PDF

files display the text in reverse order (left-to-right) because the files

report the language incorrectly or are not in the standard format.
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When sending data to a 3rd party software program using the

Send To command, only ANSI text is sent..

Installing Language Packs

To display characters in Unicode within Concordance, the appropriate language

packs need to be installed on the computer.

Issues and Tips

Currently, the Unicode Standard is supported when importing, searching, printing,

and exporting documents in the supported languages. The following issues and tips

are important to know working with non-English documents.

Right-to-Left Documents

When importing documents with Right-To-Left (RTL) languages, such as Arabic, the

imported text may be incorrectly justified to the left side. To correct this and change

the justification to the right side, select the text and press the right [Ctrl] +right

[Shift] keys.

Microsoft Excel Files

When importing Microsoft Excel files in Right-To-Left (RTL) languages, the

spreadsheet cells may be displayed Left-To Right instead of Right-To-Left.

File Names

Files names containing Unicode characters are supported in Concordance.

Delimiters
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The delimiters available from the drop-down lists in the Import Wizard, Import

Delimited Text dialog, in the Export Wizard and Export Delimited ASCII dialog, and

the Overlay Database dialog may appear as square symbols or may not be

displayed. How the lists are displayed depends on the computer's language

environment.

Delimiters use the Tahoma font, which displays the characters regardless of the

language environment.  All of the delimiter characters  can be selected as a

delimiter, even if the symbols they represent do not appear in the drop-down lists.

Removing Kashida Characters

Kashida characters are used in Arabic text to lengthen a word by elongating

characters at certain points. The added Kashida characters change the word.

For example, the word for Term in Arabic is . When Kashida characters are

added, the word changes to .

Searching for the word Term with Kashida characters results in inaccurate search

results since it will not include the word  Term without Kashida characters.

To prevent inaccurate searches, the Concordance administrator can remove the

Kashida characters from the searchable text in the current database.  This can be

done in Concordance by going to the File menu, selecting Administration, and

then Remove Kashida characters.

Words That Sound Like the Selected Word

When doing an Advanced Search from the Search task pane, selecting Display a list

of words that sound like the selected word (also known as Fuzzy Search) only

works with English language words. Using this option with words in other

languages will display a list of words that do not sound like the selected word.

Navigating Search Results for Ideographic Languages

41



References 403

© 2022 CloudNine™. All rights reserved.

A character in an ideographic language, like Chinese, can represent a word. When

navigating search results, each character is considered a separate hit. Clicking the

Next hit and Previous hit buttons jumps to the next character in the search results.

For example, if your search term is the Chinese word for Mandarin Language

School (    ) you will need to click Next hit four times for each word.

Data Validation Options

Database fields can be assigned data validation options from the Data Entry

Attributes dialog box. However, certain validation options are only supported with

English text. These include:

· Upper case

· Lower case

· Alphabetic only

· Numeric only

Match Whole Word Only

When searching for text using the Find or Replace commands, the Match whole

word only check box does not work with ideographic languages such as Chinese.

Clear the Match whole word only check box before searching for text in these

languages.

Additional Options for Hit Highlighting

When printing documents with ideographic text, like Chinese, a character

underlined for hit highlighting can easily be confused with other characters.

To allow hit highlighting in these languages, additional options have been added to

the Formatting tab in the Print documents dialog box. Now you can use underline,

bold, italics, color formatting or a combination of these options to highlight the

search hits in your reports.
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Exporting to ANSI or ASCII Format

You can export data from Concordance version 10.x to ANSI or ASCII format. The

file can then be imported into an application that does not support the Unicode

Standard; for example, into Concordance 2007 or earlier versions.

This option is available for delimited text files in the Export Wizard dialog box and

the Export Delimited ASCII dialog box. It is also available when exporting database

transcripts.

When exporting to ANSI or ASCII format, characters that cannot be

represented as a single-byte character will be lost in the export. So

exporting documents with double-byte characters, such as Chinese,

to ANSI or ASCII format will result in data loss.

Copyright Information

© 2022 CloudNine™. All rights reserved.

No part of this work may be reproduced or transmitted in any form or by any

means, electronic or mechanical, including photocopying, recording, or by any

information storage or retrieval system, without permission.

While the information contained herein is believed to be accurate, this work is

provided "as is," without warranty of any kind. The information contained in this

work does not constitute, and is not intended as, legal advice.

Concordance is a registered trademark, PreDiscovery is a registered trademark and

FYI is a trademark of Cloud9 Discovery LLC dba CloudNine.  Other products or

services may be trademarks or registered trademarks of their respective

companies.
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* Concordance Native Viewer incorporates software created by OpenText and its

use is limited to the terms of the licensing agreement.  

Concordance®

Concordance® Native Viewer

Concordance® Image

Concordance® FYI™

Contact Information

CloudNine™ offers the broadest choice of discovery solutions, giving law firms,

corporations and government agencies the efficiency, control, and confidence they

need to litigate successfully in the face of overwhelming data volumes and rapidly

changing technology.

Technical Support

Our number one priority is our clients. Our representatives pride themselves on

resolving client issues quickly and effectively. To receive technical assistance, or to

provide feedback or suggestions, please e-mail or call us. The Technical Support

team is available from 9:00 am to 7:00 pm Eastern Time, Monday through Friday.

E-mail: concordancesupport@cloudnine.com

Phone: 713-462-6464 ext.14

Websites

CloudNine™ Solutions:

CloudNine

mailto:concordancesupport@cloudnine.com
https://cloudnine.com/
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CloudNine™ Answer Center:

CloudNine™ Answer Center

Sales

Our sales team is committed to helping you to find the right products to suit your

requirements.  Contact us to learn more about the many flexible licensing options

for Concordance® and Concordance Desktop, and to see how our related software

and service offerings for litigation support — such as CloudNine™ LAW and

CloudNine™ Explore — can help to integrate and accelerate your efforts to arrive at

winning solutions. 

E-mail: CloudNine Ediscovery Sales Team 

Client Training Program

To help you meet the increasing complexity of electronic discovery, our Client

Training Program offers classroom experiences that focus on applying the powerful

features of Concordance to solve real-world problems. To learn more about our

training offerings, please e-mail our training team.

E-mail: training@cloudnine.com

mailto:sales@cloudnine.com
mailto:training@cloudnine.com
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